




User Guide

BindView Corporation · 5151 San Felipe, Suite 2500 · Houston, TX 77056

NETinventory® v8.00

And

NETinventory-RMS®

NETinventory Console®

NETrc®





COPYRIGHT

Copyright © 1999–2004 BindView Corporation. All rights reserved. 
BindView Corporation is a business name of BindView Development 
Corporation. Information in this document is subject to change and 
revision without notice. The software described herein may only be 
used and copied as outlined in the Software License Agreement. No 
part of this manual may be reproduced by any means, electronic or 
mechanical, for any purpose other than the purchaser’s personal 
use, without prior written permission from BindView Corporation.
BINDVIEW CORPORATION PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL BINDVIEW 
CORPORATION BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS, LOSS 
OF USE OR DATA, INTERRUPTION OF BUSINESS, OR FOR DAMAGES OF ANY 
KIND, EVEN IF BINDVIEW CORPORATION HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY DEFECT OR ERROR IN THIS 
DOCUMENTATION. 
BindView Corporation may revise this publication from time to time 
without notice. Because some jurisdictions do not allow the 
exclusion or limitation of liability for consequential or incidental 
damages, the above limitations may not apply. BindView 
Corporation's liability for actual damages from any cause 
whatsoever, and regardless of the form of the action (whether in 
contract, tort (including negligence), product liability or otherwise) 
will be limited to $50.00 U.S.

TRADEMARK NOTES

BindView, the BindView logo, and the BindView product names used 
in this document are trademarks of BindView Corporation and may 
be registered in one or more jurisdictions.
Proxy is a trademark of Funk Software, Inc. The names of products 
of other companies mentioned in this document, if any, may be the 
registered or unregistered trademarks of the owners of the 
products.

July 2004
:

© 2004 BindView Corporation. All Rights Reserved



THIRD-PARTY COPYRIGHTS

This product includes software developed and copyrighted by the 
following persons or groups:
Some portions of the text are copyrighted by Funk Software, Inc. 
©2003-2004 Funk Software, Inc. 
NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Contents

Information Resources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

About BindView Corporation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Online Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Using PDF Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
User Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Release Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Typestyle Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Alert Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Contacting BindView  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Section 1: NETinventory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Setting up and Using NETinventory . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21

What is NETinventory? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

NETinventory Architecture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
NETinventory Console  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Master Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Audit Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Login Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Audit Agents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Installing and Setting Up NETinventory  . . . . . . . . . . . . . . . . . . . . . . . . 28

What Happens During an Audit?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

About NETinventory Scoping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

2 New Enterprise Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

NETinventory Server Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Master Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Audit Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Login Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Installing the New Enterprise  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Audit Agents and Windows NT Servers . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Where to Go From Here . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

3 Setting Up NETinventory Console Components  . . . . . . . . . . . . . . . . .45

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
: Contents 7

© 2004 BindView Corporation. All Rights Reserved



Console Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Opening the Console Setup Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Setting the Enterprise Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Setting the Reporting Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Live vs Rolled Up Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Setting the Default Scope  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Configuration and Default Scope Interactions . . . . . . . . . . . . . . . . . . . . 52
Selecting a Default Scope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

4 Setting Up NETinventory Auditing  . . . . . . . . . . . . . . . . . . . . . . . . . . .59

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Configuring Node Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Setting Up System Configuration Detection  . . . . . . . . . . . . . . . . . . . . . 63

Alerts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Configuring Software Detection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Configuring Tracked Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Configuring Tracked Environment Variables  . . . . . . . . . . . . . . . . . . . . . 80

Configuring Tracked Drivers and Services  . . . . . . . . . . . . . . . . . . . . . . 81

Configuring Audit Agent User Interaction . . . . . . . . . . . . . . . . . . . . . . . 83

Alert Defaults and Global Alert Settings . . . . . . . . . . . . . . . . . . . . . . . . 88

Configuring Run Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Configuring Standalone Audits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

5 Setting Up NETinventory Server Components  . . . . . . . . . . . . . . . . .101

Server Setup Panels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Master Server Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Master Server and Data Rollup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .102
Master Server and NETinventory-RMS Snap-in  . . . . . . . . . . . . . . . . . . . . .103
Master Server Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103
Master Server SQL Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
Updating the Master Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
Controlling Synchronization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .122
Master Server Performance Tuning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .124

Audit Server Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Creating a New Audit Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
Removing an Audit Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .134
Changing Audit Server Protocol Settings  . . . . . . . . . . . . . . . . . . . . . . . . .136
Setting Audit Server Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .137
Setting Audit Server Tuning Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . .138

Login Server Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Running the Audit Agent when Logging In  . . . . . . . . . . . . . . . . . . . . . . . .139
: Contents 8

© 2004 BindView Corporation. All Rights Reserved



Modifying Login Server Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .140
Creating a New Login Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .141
Audit Agents and Windows NT Servers . . . . . . . . . . . . . . . . . . . . . . . . . . .147
Audit Agents and NetWare Login Scripts  . . . . . . . . . . . . . . . . . . . . . . . . .147
Removing a Login Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .148

Site Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Audit Server Assignment Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Modifying Audit Server Assignment Rules . . . . . . . . . . . . . . . . . . . . . . . . .152

Account Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156

6 Setting Up The NETinventory Inventory Database . . . . . . . . . . . . . .159

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Year 2000 Identification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Software Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Master Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Custom Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

Unknown Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Category Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Vendor Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Manufacturer Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

Hardware Product Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

Maintenance Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

BIOS Identification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

7 Node Management  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .189

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190

Opening the Node Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190

Information Available Through the Node Manager . . . . . . . . . . . . . . . . 191

NETinventory Status Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
Moving and Deleting Nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .192
Node Comments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193

Hardware and Software Inventory Information . . . . . . . . . . . . . . . . . . 195
Software Asset Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .195
Hardware Assets Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .197

Managing Node Alerts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201

Managing Tracked Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
Viewing the Contents of a Tracked File . . . . . . . . . . . . . . . . . . . . . . . . . . .205
Using the File Download History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .209

Customizing Audits for Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Controlling the Tests the Audit Agent Performs . . . . . . . . . . . . . . . . . . . . .210
: Contents 9

© 2004 BindView Corporation. All Rights Reserved



Setting a Custom Audit Interval  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .212

Taking Control with NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Assigning a Profile to a Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .215
Removing NETrc Host Software from a Node  . . . . . . . . . . . . . . . . . . . . . .216
Using the NETinventory Node Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . .216

8 NETinventory Control Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .219

Using the NETinventory Service Manager Control Panel . . . . . . . . . . . . 220
The Master Server Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .220
The Audit Server Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222
The Database Engine Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222
TCP/IP Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .224

Section 2: NETinventory-RMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
Using NETinventory with the BindView RMS Console . . . . . . . . . . . . . . . 225

9 Configuring the NETinventory Snap-in for BindView RMS  . . . . . . . .227

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

Configuring Master Server SQL Rollup . . . . . . . . . . . . . . . . . . . . . . . . 229

Configuring NETinventory-RMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231

10 Using the NETinventory Snap-in for BindView RMS . . . . . . . . . . . .243

Understanding Queries  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244
Pre-Defined Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .244
Query Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .244

Creating a Query . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
Selecting a Data Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .245
Adding Fields  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246
Adding Filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .247
Adding Sorts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249
Adding Scopes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .250
Saving a Query Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .253
Running Queries  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .254
Rerunning Queries from the Grid Toolbar . . . . . . . . . . . . . . . . . . . . . . . . .256
Monitoring the Status of Processed Queries  . . . . . . . . . . . . . . . . . . . . . . .256

Baselining  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
Creating a Delta Dataset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .258

Exporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
Exporting Prerequisites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .261
Export File Format Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .261
Exporting to a Disk File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .262
Exporting to an Exchange Mailbox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .263
Saving Export Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .264
: Contents 10

© 2004 BindView Corporation. All Rights Reserved



Creating Task Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Running Task Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .269

Creating Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Charting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Creating a Series Chart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .276

Section 3: NETinventory Console . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Using the NETinventory Console to Create Queries  . . . . . . . . . . . . . . . . 279

11 Console and Desktop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .281

The NETinventory Console User Interface . . . . . . . . . . . . . . . . . . . . . . 282
User Interface Terms Defined . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .282

The NETinventory Console Desktop . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Item Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .283

NETinventory Console Snap-in Modules . . . . . . . . . . . . . . . . . . . . . . . 284
NETinventory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .284
NETrc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .284

12 Grid, Graph, and Schedule Item Basics  . . . . . . . . . . . . . . . . . . . . .285

Item Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286
Properties of an Item . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .286
Queries and the Query Builder  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .286

Grid Item Defined   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
Components of a Grid Item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .288

Graph Item Defined . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Components of a Graph Item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .289
Graph Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .289

Schedule Item Defined  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290
Components of a Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .291

13 Creating and Changing Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . .293

Creating a New Grid or Graph Item . . . . . . . . . . . . . . . . . . . . . . . . . . 294
Data Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .294
Field Specification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .295
Filter Specification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .296
Sort Specification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .297
Scope  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .298
Save the New Grid or Graph Item . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .298

Changing Existing Grid or Graph Items  . . . . . . . . . . . . . . . . . . . . . . . 300

Creating a New Schedule Item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301

Changing Existing Schedule Items . . . . . . . . . . . . . . . . . . . . . . . . . . . 306

Sharing Items Between Desktops  . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
Sending/Receiving References to Report Items . . . . . . . . . . . . . . . . . . . . .307
: Contents 11

© 2004 BindView Corporation. All Rights Reserved



Copying Items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310

Exporting and Importing Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310

14 Printing an Item . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .315

Customizing a Grid Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
Using the Printer/Page Settings Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . .316
Using the Spreadsheet Style Options Tab . . . . . . . . . . . . . . . . . . . . . . . . .317
Using the Form Style Options Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .319
Using the Report Header Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .320
Using the Report Footer Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .322

Customizing a Graph Item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
Using the Type Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .324
Using the Layout Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .326
Using the Data Point Tab from Graph Setup  . . . . . . . . . . . . . . . . . . . . . . .327
Print a Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .328
Advanced Graph Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .328
Filtering Out “Special Values” in Graphs . . . . . . . . . . . . . . . . . . . . . . . . . .328
Rotating, Copying, and Pasting Graphs  . . . . . . . . . . . . . . . . . . . . . . . . . .328
Hints for Making Better Graphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .328

15 Exporting Grid Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .329

Exporting Grid Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330

Managing Export Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

16 Configuring NETinventory Console Users . . . . . . . . . . . . . . . . . . . .337

User Desktop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338

BV Admin Account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338

Changing Account Passwords  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 340

Console Default Configuration Settings  . . . . . . . . . . . . . . . . . . . . . . . 341
Default Grid Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .341
Default Data Format Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .343
Default Toolbar Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .344
Default E-mail Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .345

Managing Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346

Section 4: NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
Setting up and Using the NETrc Module . . . . . . . . . . . . . . . . . . . . . . . . 349

17 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .351

What is NETrc? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352

NETinventory Console and NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . 352

NETrc and NETinventory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352

NETrc Architecture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
: Contents 12

© 2004 BindView Corporation. All Rights Reserved



NETrc Console Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .352
NETrc Master  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353
NETrc Host . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353
NETrc Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353

Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Installing NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354

Setting Up NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354

NETrc System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
NETrc Host Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .354
Network Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .355
Display Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .355
Color  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .355
Resolution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .355

18 Setting Up NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .357

NETrc Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
Setting the Default NETrc Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .358

Configuring the NETrc Master Settings . . . . . . . . . . . . . . . . . . . . . . . . 359
Configuring Advanced Master Settings . . . . . . . . . . . . . . . . . . . . . . . . . . .363

Configuring NETrc Host Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364
Configuring Host Protocol Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .366
Configuring Host Access Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .366
Configuring Host Security Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .369

Configuring NETrc Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370

Removing the NETrc Host . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
Removing Host Components Automatically . . . . . . . . . . . . . . . . . . . . . . . .373
Removing Host Components Manually  . . . . . . . . . . . . . . . . . . . . . . . . . . .374

19 Using NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .377

Taking Control with NETrc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378

Assigning a Profile to a Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
Removing the NETrc Host Software from a Node . . . . . . . . . . . . . . . . . . . .381

Using NETrc Master . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Menu and Toolbar Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
The Connection Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .382
The Edit Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .383
The View Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .383
The Options Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .385
The Goto Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .389

Remote Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
Controlling the Remote Host . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .390

File Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390
Displaying File Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .392
: Contents 13

© 2004 BindView Corporation. All Rights Reserved



Selecting Files and Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .392
Manipulating Files and Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .393

Remote Printing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394

Appendix A Uninstalling NETinventory . . . . . . . . . . . . . . . . . . . . . . . . . . .395

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396

Uninstalling the Servers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
Removing the NETinventory SQL Database . . . . . . . . . . . . . . . . . . . . . . . .396
Uninstalling Login Servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .397
Uninstalling Audit Servers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .397
Uninstalling the Master Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .398
Removing the NETinventory Service Manager Control Panel . . . . . . . . . . . .398

Uninstalling NETinventory-RMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

Uninstalling the NETinventory Console . . . . . . . . . . . . . . . . . . . . . . . . 399

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .401
: Contents 14

© 2004 BindView Corporation. All Rights Reserved



Information Resources

In This Section About BindView Corporation........................................ 16
Online Documents ..................................................... 16
Typestyle Conventions................................................ 17
Alert Statements ....................................................... 17
Contacting BindView .................................................. 18
15

© 2004 BindView Corporation. All Rights Reserved



About BindView Corporation
About BindView 
Corporation

BindView Corporation is a leading provider of proactive business 
policy, IT security and directory management software worldwide. 
BindView solutions and services enable customers to centralize and 
automate policy compliance, vulnerability management, directory 
administration and migration across the entire organization. With 
BindView insight at work™, customers benefit from reduced risk 
and improved operational efficiencies with a verifiable return on 
investment. More than 20 million licenses have shipped to 5,000 
companies worldwide, spanning all major business segments and 
the public sector.

Online Documents Documentation is provided in the following electronic formats on 
the BindView product CD:

• Adobe® Acrobat® PDF files
• HTML Release Notes files
• Online help

Using PDF Files With Adobe Acrobat PDF files, you can navigate through a document 
quickly and perform full-text searches. In addition, the PDF files can 
be viewed online, distributed to multiple users electronically, or 
printed.

You must have Adobe® Reader® installed to read the PDF files.

To view PDF files, double-click PDF files to open them, and then 
move through the document by clicking topic headings in the left 
pane or green hypertext links in the text. To print copies, click Print 
from the File menu.

Installing Adobe Reader Adobe Reader installation programs for common operating systems 
are available for a free download from the Adobe Web site at 
www.adobe.com.

User Guides The Docs directory on the BindView product CD contains copies of 
the user guides and other documentation in the PDF format. 

The NETinventory User Guide contains information about 
NETinventory v8.00 and about the BindView RMS Console and 
Information Server v8.00. If you upgrade the BindView RMS 
Console and Information Server, the BindView RMS Console and 
Information Server User Guide included with the update will contain 
information about the new version of the Console.
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Release Notes
Release Notes If the autorun function is enabled, a Readme HTML file for your 
BindView product is accessible under the Documentation menu of 
the BindView setup menu when you insert your CD. You also can 
select to view this file after the installation is completed, or by 
browsing to the Release Notes directory in the root directory for 
your program:

C:\Program Files\BindView\RMS\Release Notes

Online Help Comprehensive help is available from the Help menu on the 
BindView RMS Console and the BindView RMS Web Console. 
Additionally, you can access help by clicking the Help button in 
any dialog, by right-clicking an item and selecting Help from the 
action menu, or by pressing F1 in any dialog.

Typestyle 
Conventions

The following conventions are observed throughout this guide:

• Bold text is used to designate file and folder names, dialog titles, 
names of buttons, icons, and menus, and terms that are objects 
of a user selection. 

• Italic text is used for word emphasis, defined terms, and manual 
titles.

• Monospace text (Courier) is used to show literal text as you 
would enter it, or as it would appear onscreen.

Alert Statements The alerting statements are Notes, Cautions, and Warnings. These 
statements are formatted in the following style:

Note: Information that is incidental to the main text flow, or to an 
important point or tip provided in addition to the previous 
statement or instruction.

Caution: Advises of machine or data error that could occur should 
the user fail to take or avoid a specified action.

Warning: Requires immediate action by the user to prevent actual 
loss of data or where an action is irreversible, or when physical 
damage to the machine or devices is possible.
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Contacting BindView
Contacting 
BindView

BindView has sales and support offices around the world. For 
information on contacting BindView, please refer to the information 
below or to the BindView Web site: www.bindview.com

For Technical Support: www.bindview.com/support

Technical Support is available Monday through Friday from 
7:00 a.m. to 7:00 p.m. Central Time. Normal working hours for all 
other departments are 9:00 a.m. to 6:00 p.m.

Phone

Sales and Customer 
Service

U.S. and Canada 800-813-5869

Outside N. America 713-561-4000

Technical Support U.S. and Canada 800-813-5867

Outside N. America 713-561-4000

Training/Professional 
Service

U.S. and Canada 800-749-8439

Outside N. America 713-561-4000

Fax All Areas 713-561-1000

E-mail

Sales sales@bindview.com

Training edu@bindview.com

Documentation docs@bindview.com

Other

FTP Site ftp://ftp.bindview.com

Internet www.bindview.com

Postal Mail BindView
5151 San Felipe, Suite 2500

Houston, TX 77056
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What is NETinventory?
What is 
NETinventory?

NETinventory audits and manages information about hardware and 
software on PC workstations on networks with Windows NT®, 
Windows® 2000, Windows Server™ 2003, and NetWare® servers.

You do not need dedicated machines to perform PC audits. Audits 
are performed when a program called an Audit Agent is run from 
the network server. You can set up login scripts or policies so that 
the Audit Agent runs automatically when the user logs in to the 
enterprise network.

Audits can capture information about the hardware and software 
configuration of any node that logs into Windows NT, Windows 
2000, Windows Server 2003, or NetWare 4.x, 5.x, or 6.x servers on 
your enterprise network. The node can use DOS, Windows 3.x, 
Windows 95, Windows 98, Windows Me®, Windows NT, Windows 
2000, Windows XP®, or Windows Server™ 2003. 

Once the data has been captured, you can use the NETinventory 
Console or the BindView RMS Console with the NETinventory Snap-
in to access, analyze, report on, and manage node information 
across your network enterprise.

In addition to the basic equipment check, any number of audits for 
hardware and software can be configured. Each audit has a 
separate audit interval that controls when the audit is performed. 
An administrator can customize audits to perform required tasks or 
actions either on a regularly scheduled basis, or in response to 
specific problems. 

With NETinventory you can:

• Access information about node resources throughout your 
enterprise network across a heterogeneous mixture of network 
and client operating systems.

• Analyze the information that NETinventory gathers in various 
ways, using the NETinventory Console or BindView RMS Console.

• Report on your enterprise network information.
• Manage your enterprise network information. Use NETinventory 

to gather network information to perform management tasks, and 
keep track of hardware and software information for each node on 
your network.

NETinventory 
Architecture

NETinventory consists of several components deployed on servers 
throughout your enterprise network. The major components are:

• NETinventory console 
• NETinventory snap-in for the BindView RMS Console
• Master Server (hosted by a Windows NT, Windows 2000 Server, or 

Windows Server 2003 machine)
• Audit Server (hosted by a Windows NT, Windows 2000, Windows 

Server 2003, or NetWare machine)
• Login Server (hosted by a Windows NT, Windows 2000, Windows 

Server 2003, or NetWare machine)
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NETinventory Console
• Audit Agents

NETinventory Console All of the NETinventory configuration and control features are 
accessed using the NETinventory Console user interface.

The NETinventory user interface, seen from the NETinventory 
Console, consists of the following elements:

• NETinventory Setup Navigator - manages setup from the 
NETinventory Console

• NETinventory Reports - Grids, Graphs, and Schedules to help you 
use NETinventory to report on your enterprise

• NETinventory Node Manager - allows you to focus on detailed 
information about a particular node.

Fig. 1 shows the NETinventory Console desktop. 

Fig. 1 NETinventory Console 

NETinventory Snap-in 
for BindView RMS 
Console

If you have the BindView RMS® Console, you can use the 
NETinventory snap-in for the BindView RMS Console (NETinventory-
RMS snap-in) to access NETinventory Audit Data that has been 
copied to a SQL database on the NETinventory Master Server. The 
NETinventory-RMS snap-in allows you to use the same tools to 
report on NETinventory data that you use for other BindView RMS 
Console snap-ins. 
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Master Server
Master Server The Master Server is a service that runs on Windows NT, Windows 
2000, or Windows Server 2003 machines, together with the master 
set of audit and server preferences and the databases used by 
NETinventory. These databases are set up automatically during the 
Master Server installation process. Your enterprise network will 
have only one Master Server to synchronize and coordinate the 
work of all the other NETinventory servers on your network.

The NETinventory Master Server performs the following roles:

• Maintains the node-to-Audit Server relationship required for 
auditing. By maintaining a synchronized list of node-to-Audit 
Server relationships, NETinventory prevents storing duplicate 
audit records for any node, even if that node is moved from one 
logical point to another within your network.

• Synchronizes information stored in all the Audit Server 
databases. This information determines when audits will occur, 
and what auditing preferences will be used.

• Maintains NETinventory SQL databases for use by NETinventory 
Snap-in for the BindView RMS Console if SQL rollup is activated. 

• Helps to ensure that all NETinventory components on Audit and 
Login Servers are kept up-to-date.

A Windows NT, Windows 2000, or Windows Server 2003 machine 
that is acting as the Master Server can also act as an Audit Server, a 
Login Server, or both at the same time.

Master Server 
Requirements

The machine which will host the Master Server must meet these 
requirements:

• Pentium® II 300 MHz, 128 MB RAM
• 285 MB of free disk space (Microsoft Windows NT 4.0); 235 MB of 

free disk space (Windows 2000 or Windows Server 2003)
• Microsoft Windows NT 4.0 SP6a (Server or Workstation), 

Windows 2000 (Server or Professional), or Windows Server 2003 
installed

• Internet Explorer 5.5 or later 
• MDAC 2.6 or later is required for SQL rollup

If you will be using the NETinventory Snap-in for the BindView RMS 
Console, you will roll up NETinventory to a SQL database. The 
machine that hosts the SQL database must have Microsoft SQL 
Server™ (7.0 or later) or Microsoft SQL Server Desktop Engine 
(MSDE) (7.0 or 2000). The machine hosting the Microsoft SQL 
Server can be the Master Server or any other server. 

MSDE data storage is suitable for networks with up to 10,000 
nodes. If you have more nodes, you should use Microsoft SQL 
Server to store the NETinventory SQL Database. In addition, if you 
will have more than 4 clients (BindView Information Servers or SQL 
Clients) accessing the NETinventory data, you should use Microsoft 
SQL Server. 

Refer to the diagrams in Fig. 2 on page 27 and Fig. 3 on page 27 to 
see how the various NETinventory components interact.
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Audit Server
Audit Server An Audit Server is a service that runs on a Windows NT, Windows 
2000, or Windows Server 2003 machine, or an NLM that runs on a 
NetWare 4.x, 5.x or 6.x server, together with a copy of the set of 
audit preferences and databases. The preferences and databases 
are set up automatically during the Audit Server installation 
process, and are kept synchronized on all Audit Servers by the 
Master Server.

An Audit Server performs the following roles:

• Stores audit information for audited nodes.
• Supplies audit information to the NETinventory Console when 

queries are run.
• Supplies audit information that is “rolled up” to a SQL database 

maintained by the Master Server for access by the NETinventory-
RMS snap-in. 

• Directs Audit Agents on individual nodes to the correct Audit 
Server to store node Audit data. When an Audit Server is 
performing this activity, it is referred to as a Dispatch Server. 

• Passes auditing preferences to an Audit Agent during an audit.

You should deploy at least one Audit Server for each functional 
group in your enterprise. You should deploy at least one Audit 
Server per 2000-3000 audited nodes. Audited nodes should always 
be connected by fast (LAN-speed) links to their Audit Server. A 
Windows NT, Windows 2000, or Windows Server 2003 machine that 
is acting as an Audit Server can also host the network’s Master 
Server or a Login Server, or both, at the same time. A NetWare 
server acting as an Audit Server can also host a Login Server. 

Audit Server 
Requirements

• Pentium II 300 MHz, 128 MB RAM
• 285 MB of free disk space (Microsoft Windows NT 4.0); 235 MB of 

free disk space (Windows 2000 or Windows Server 2003)
• Microsoft Windows NT 4.0 SP6a (Server or Workstation), 

Windows 2000 (Server or Professional), Windows Server 2003, or 
NetWare 4.1 or later installed 

• Internet Explorer 5.5 or later (on Windows computers)
• 150 kilobytes disk space per audited node for the Audit Server 

database. Database files can grow over time to as much as 1 
megabyte or more per audited workstation for audit records. 

Refer to the diagrams in Fig. 2 on page 27 and Fig. 3 on page 27 to 
see how the various NETinventory components interact.

Login Server The Login Server should be deployed on every NetWare 4.x, 5.x, 6.x 
and Windows NT 3.51, 4.0, Windows 2000 server, or Windows 
Server 2003 machine where users in your network regularly log in.

A Login Server performs the following roles:

• Stores the Audit Agents for nodes to execute. Since Audit Agents 
are deployed on Login Servers, you do not need to install any 
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Audit Agents
software on the nodes that are audited. This makes upgrades 
simpler and less time-consuming.

• Runs the appropriate Audit Agent for a node’s operating system. 
You should add or modify Windows NT policies or the appropriate 
Windows or NetWare login script(s) to run the Audit Agent when 
users log in to the server. 

• Instructs Audit Agents to connect to one of two Audit Servers 
designated as “dispatch” Audit Servers for that Login Server. The 
Audit Server then connects the node to the Audit Server that 
stores the workstation Audit data. 

A Windows NT, Windows 2000, or Windows Server 2003 machine 
that is acting as a Login Server can also act as the network’s Master 
Server or an Audit Server, or both at the same time. A NetWare 
server acting as a Login Server can also host an Audit Server. 

Login Server 
Requirements

• 15 MB of free disk space for program files on the Login server(s).
• Microsoft Windows NT 4.0 SP6a (Server or Workstation), 

Windows 2000 (Server or Professional), Windows Server 2003, or 
NetWare 4.1 or later installed

Refer to the diagrams in Fig. 2 on page 27 and Fig. 3 on page 27 to 
see how the various NETinventory components interact.

Audit Agents Audit Agents are programs that gather the hardware and software 
information from nodes. 

BVAUDIT.EXE will launch either the DOS-based Audit Agent or the 
32-bit Audit Agent automatically. Audit Agents pass the information 
collected back to the node’s Audit Server, then they quit. Audit 
Agents do not stay resident in memory after gathering the data. 
Refer to the diagrams in Fig. 2 and Fig. 3 on page 27 to see how the 
NETinventory components interact.
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Installing and Setting Up NETinventory
Installing and 
Setting Up 
NETinventory 

Once you have installed the NETinventory (described in the Getting 
Started Guide) you can open the NETinventory Console and use the 
NETinventory Setup Navigator to create a New Enterprise 
Installation. After the New Enterprise Installation is complete, you 
can configure your Master Server to roll up the audit data to a SQL 
database and then configure the NETinventory-RMS snap-in to 
access the data. 

The New Enterprise Installation Wizard guides you through the 
steps to deploy a Master Server, at least one Audit Server, and at 
least one Login Server. This is the minimum requirement for using 
NETinventory to gather network data from nodes on your enterprise 
network. Refer to Chapter 2, “New Enterprise Installation,” on page 
31 for detailed information.

It is important for you to determine how you want to deploy 
additional NETinventory servers within your network to optimize it 
for your particular enterprise configuration. In most cases, you 
should install the Login Server components on all of your 
authenticating Windows NT, Windows 2000, Windows Server 2003, 
and NetWare servers. You install the Audit Server components on a 
single Windows NT, Windows 2000, Windows Server 2003, or 
NetWare server within each functional group in your enterprise, 
taking care that all nodes the server will audit are connected to it by 
fast (LAN-speed) links. Finally, you need a single Master Server for 
your entire enterprise.

For information about creating additional Audit Servers, refer to 
“Creating a New Audit Server” on page 126. For information about 
creating additional Login Servers, refer to “Creating a New Login 
Server” on page 141.

Once you complete the New Enterprise Installation, you configure 
the Audit Agent Preferences, Server Preferences, and Inventory 
Database in order to customize NETinventory to your enterprise’s 
unique needs. For more information see:

• NETinventory Audit Agent Preferences (Chapter 4 on page 59)
• NETinventory Server component Preferences (Chapter 5 on page 

101)
• NETinventory Inventory Database Settings (Chapter 6 on page 

159)

What Happens 
During an Audit?

When a workstation logs into a NETinventory Login Server, the 
Windows policy or Windows or NetWare login script starts the 
NETinventory Audit Agent from the Login Server. 

As soon as it begins execution, the Audit Agent connects to the 
dispatch Audit Server or the alternate dispatch Audit Server. 

The dispatch Audit Server checks its database to see if the 
workstation has been audited previously. If it has, then it is 
dispatched to the Audit Server where its audit information is stored. 
28 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



About NETinventory Scoping
If the node has never been audited, the dispatch Audit Server 
assigns the node to an Audit Server based on rules you set up. 

For audits to take place as quickly as possible, the primary dispatch 
Audit Server should also be the server responsible for maintaining 
the node’s audit information. You control this by carefully planning 
and setting up Audit Server Assignment rules. “Audit Server 
Assignment Rules” on page 151 has detailed instructions for setting 
up Audit Server Assignment rules.

Once the node connects to its Audit Server, then the Audit Server 
determines if an audit should be performed. If an audit is scheduled 
to be performed, the Audit Server sends the audit preferences to 
the Audit Agent.

The Audit Agent performs the audit, then returns the audit 
information to the Audit Server, which stores the information in its 
database.

The audit information is then available to the NETinventory Console 
for viewing when a Query is run.

If you have configured the Master Server to roll up data to a SQL 
database for use by the NETinventory-RMS snap-in, the Master 
Server will collect all new data from the Audit Server the next time 
the Master Server synchronizes the Enterprise Network. 

About 
NETinventory 
Scoping

With scoping, you can limit the data displayed in a Grid or Graph by 
restricting the information sources for the Query. Limiting the Scope 
of a Query to those sources you know to contain relevant 
information reduces network traffic and speeds processing of the 
Query. Whenever possible, you should limit the Scope of a Grid or 
Graph’s Query to relevant data sources.

In NETinventory, you can limit the Scope of a Query to a single 
Audit Server or some sub-set of the Audit Servers in your enterprise 
network. 

You can set a default Query Scope that is used when you create a 
new Grid or Graph, unless you explicitly choose a different Scope 
when creating the query. For information about setting the default 
Query Scope and the relationships between the Reporting 
Configuration and Scope settings, refer to “Configuration and 
Default Scope Interactions” on page 52.

Note: Only queries created in the NETinventory console can scope 
to individual Audit Servers. 
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Overview
Overview Before you can perform a New Enterprise Installation, you must 
install NETinventory. For more information on installing the 
NETinventory, please see the Getting Started Guide.

Once you have installed NETinventory, you can:

• Begin using NETinventory immediately to view data provided in 
the sample database if you installed the sample data. By default, 
NETinventory is configured to report on data stored in the sample 
database. 

• Deploy and configure the NETinventory server components within 
your enterprise and begin data collection from your enterprise 
network.

In the New Enterprise Installation, you deploy a single Master 
Server, Audit Server and Login Server on a Windows NT, Windows 
2000, or Windows Server 2003 machine within your enterprise. This 
chapter covers specific concerns as you prepare to set up 
NETinventory, and describes how to deploy the components 
required for NETinventory.

NETinventory 
Server 
Components

Once you have installed NETinventory, you can run the 
NETinventory Console and begin the NETinventory setup process.

You use the NETinventory New Enterprise Installation wizard to 
deploy and run a single Master, Audit and Login Server.

The installation described in this chapter is the simplest of 
NETinventory installations. For information on planning and 
installing in more complex situations, please refer to Chapter 5 on 
page 101. 

Master Server To set up the NETinventory Console for NETinventory you select a 
single Windows NT server, Windows 2000 server, or Windows 
Server 2003 machine within your enterprise to act as the network’s 
Master Server and install the Master Server service on it. For this 
New Enterprise Installation, the same server will also host an Audit 
Server and Login Server. 

The Master Server synchronizes the distributed databases 
maintained by the NETinventory components. Your NETinventory 
installation will have only one Master Server. 

Audit Server The Audit Server stores audit data collected from the workstations 
on your enterprise network when the run the Audit Agent. You may 
wish to install a separate Audit Server for specific network 
segments, or you may choose to install Audit Servers based on 
department functions or other groupings. The number of 
workstations a single Audit Server can audit depends on a number 
of factors, including the network load, the load on the server, the 
speed of the network itself, and how extensive the audit is. As a 
rule of thumb, you should allot one Audit Server for every 2000-
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Login Server
3000 workstations that will be audited. You can then add or delete 
Audit Servers based on your network’s situation.

For information on using additional Audit Servers, including 
NetWare based Audit Servers, see “Creating a New Audit Server” on 
page 126. 

Login Server NETinventory Login Servers are servers designated as hosts for the 
NETinventory Audit Agent and the Agent’s preference files. Login 
Servers do not run any NETinventory services or NLMs. 

Audit Agents are small executable files that run on workstations 
when they log in to the network. The Audit Agent connects to the 
workstation’s Audit Server and performs the actual work of auditing 
the workstation. In order for the Audit Agent to run automatically 
when the user logs in, you will need to add a command to the 
server’s Policies or to login scripts, as discussed in “Audit Agents 
and Windows NT Servers” on page 43.

You must set up at least one Login Server. While you must have at 
least one Login Server, normally every server that workstations 
routinely log in to should be designated as a Login Server.

Installing the New 
Enterprise

This section leads you through each step of the installation process 
for a new NETinventory enterprise. 

To set up a new enterprise

1 Run the NETinventory Console.

2 Select Options>NETinventory Setup from the NETinventory 
Console menu bar.

The NETinventory Setup Navigator appears. 

Fig. 4 NETinventory Setup Navigator

3 Click New Enterprise Installation.
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Installing the New Enterprise
The Install New Enterprise panel appears.

Fig. 5 Install New Enterprise Panel

The Install New Enterprise panel allows you to choose 
between a guided process and “Expert Mode.” If you choose to 
use Expert Mode, the New Enterprise Installation Wizard will 
use a single panel to prompt you to enter all of the information 
needed to create your new NETinventory Enterprise. 

To use Expert Mode, select the Expert Mode box in the New 
Enterprise panel. To use normal mode, leave the box 
unselected. 

Caution: If you choose to use Expert Mode, the New Enterprise 
Installation Wizard will not validate the information you supply until 
it tries to create the new server. 

4 Click Next in the Install New Enterprise panel to begin 
installing the Master Server.
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Installing the New Enterprise
No matter which mode you choose, the Insert CD panel 
appears. 

Fig. 6 Insert CD Panel

The path is the location on the hard disk where the 
NETinventory files were installed. Normally, you should be able 
to use this set of files. To choose a different set of files, click 
Browse. The Locate the SITEDFLT Directory dialog 
appears. Locate the BINDVIEW directory, then locate the 
\NI\master\ directory and select it. 

5 Once you have selected the directory, click OK.

6 Once you have selected the \NI\master\ directory in the 
BINDVIEW directory or on the CD-ROM, click Next on the 
Insert CD panel. 

7 If you have not yet installed any NETinventory licenses, the 
Install Licenses panel appears. 

Fig. 7 Install Licenses Panel

8 Click Add or Add from Disk and add your NETinventory 
Licenses to the License database. Until you have installed the 
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Installing the New Enterprise
NETinventory licences, you cannot install the Master Server. 
Click Next to continue. 

Installing Using Expert 
Mode

If you chose to use Expert Mode, the Master Server Expert 
panel appears. You should generally not use Expert Mode 
unless directed by BindView Technical Support, since no 
validation is done of the information you enter. You will prevent 
the NETinventory Enterprise from installing properly if you 
enter invalid information. 

Fig. 8 Master Server Expert Panel

9 Enter the Server Name, and a valid Admin Account and 
Password combination for NETinventory to use to create and 
maintain the server. You should enter the Admin Account in one 
of these formats:
Domain\User Name
Machine Name\User Name
User Name
The User name you supply should be a Domain Admin or a 
Local Admin for the machine which will host the servers. You 
may wish to create a special NETinventory account in your 
domain for the exclusive use of NETinventory. If you enter just 
the user name, it must be a user name and password on the 
machine where the Master Server is being created. 

Enter a valid share and a path on the share where 
NETinventory should install the Master, Audit, and Login Server 
files. Finally, if the server is not a Domain Controller, unselect 
the Agents in NETLOGON. 

Create the share NETinventory should use with normal 
Windows Administration tools. The usual path for NETinventory 
is \BVEMS. 

Click Next to continue. Turn to Step 13 on page 39 to proceed. 
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Installing the New Enterprise
Installing Without Using 
Expert Mode

If you chose not to use Expert Mode, the Select Server panel 
appears. 

Fig. 9 Select Server Panel

10 Use the Select Server panel to specify which server on your 
enterprise network should host the Master Server. Normally, 
you should have one of the domain’s Domain Controllers (DC) 
host the Master Server. If you prefer, any Windows NT, Windows 
2000, or Windows Server 2003 machine in the domain can host 
the Master Server. The main requirements for the machine 
hosting the Master Server are that the machine be running and 
available at all times, and that it have good connectivity to 
other servers in all your domains when it needs to Synchronize 
Audit and Login servers. 

Type the name of the machine which should host the Master 
Server or click Browse and use the network browser to locate 
the machine. 

After selecting the machine to host the Master Server, click 
Next to continue. 
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Installing the New Enterprise
NETinventory will check the server’s status and then the Admin 
Account panel will appear. 

Fig. 10 Admin Account Panel

11 Type a Login name and Password the Enterprise Console 
should use to access the machine. You should enter the Admin 
Account in one of these formats:
Domain\User Name
Machine Name\User Name
User Name
The User name you supply should be a Domain Admin or a 
Local Admin for the machine which will host the servers. You 
may wish to create a special NETinventory account in your 
domain for the exclusive use of NETinventory. If you enter just 
the user name, it must be a user name and password on the 
machine where the Master Server is being created. 

12 Click Next in the Admin Account panel.

The Database Path panel appears. 

Fig. 11 Database Path Panel
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Installing the New Enterprise
This panel specifies where the Master Server and Audit Server 
database files are stored. Select an existing share from the 
Shares drop-down list. Every user who needs to report on the 
data collected by NETinventory using the NETinventory console 
must have access to the share. Consider creating a new share 
specifically for NETinventory to store data in. 

If the server is a Domain Controller, you can have the Login 
Server files copied to the server’s NETLOGON share. To do so, 
leave the Copy agents to NETLOGON box selected. If the 
server is not a Domain Controller, you should unselect the box. 

Every user audited by NETinventory should be able to execute 
the Audit Agent. The NETLOGON share is best for storing Audit 
Agent files since all users have read access to it by default and 
can execute login scripts from that location. If you changed 
your server’s settings to prohibit read access to the NETLOGON 
share, create another share that all users will have read access 
to and use it to store the Audit Agent files. 

For information on using Login Scripts or Policies to run the 
Audit Agents when users log in to the Login Server, please see 
“Audit Agents and Windows NT Servers” on page 43, once the 
New Enterprise Installation wizard is complete. 

Click Next to continue. The Protocol Selection panel appears. 

Fig. 12 Protocol Selection Panel

13 The Protocol Selection panel sets the communications 
protocol the NETinventory Audit Agents on your network should 
use to communicate with this Audit Server. In addition, you can 
set the TCP/IP Hostname or Address of the Audit Server. 

On NetWare-based Audit Servers, you can use IPX or TCP/IP. 
On Windows-based Audit Servers, you must use TCP/IP. 
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Installing the New Enterprise
Enter the TCP/IP hostname or address of the machine in the 
TCP/IP Hostname or Address box, then click Next. The 
Reporting Account panel appears. 

Fig. 13 Reporting Account Panel

The reporting account is optional. 

When you enter a reporting account, the reporting account 
credentials will be used to access the Audit Server files if the 
NETinventory Console user’s own credentials do not allow 
access to the Audit Server files. If you don’t enter a reporting 
account and the user’s credentials don’t allow access to the file, 
the user will be prompted to log in to the Audit Server 
manually. 

By using the Reporting Account, users who do not have direct 
access to the directory used by NETinventory to store data can 
perform queries and process reports. 

14 To enter a reporting account, enter a user name and password 
combination. Enter the user name in one of these formats:
Domain\User Name
Machine Name\User Name
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Installing the New Enterprise
Click Next to continue. The Automatic Install panel appears. 

Fig. 14 Automatic Install Panel

Setting up the NETinventory Audit and Login Server databases 
and settings can take time. You can choose to have the 
NETinventory Master Server copy the needed files automatically 
during a routine synchronization. Automatic installation greatly 
speeds the process of creating multiple Audit Servers. 

Since this is the only Audit and Login Server you are creating 
now, you should have the NETinventory Console finish the 
installation immediately. 

15 To complete the installation immediately, select No and click 
Next to continue. The Summary panel appears. 

Fig. 15 Summary Panel

This panel summarizes the Master Server settings you have 
selected.

16 If all of the settings are correct, click Next in the Summary 
panel to install the NETinventory Master, Audit, and Login 
Server on the computer you selected. If you need to make a 
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Installing the New Enterprise
change, click Back to return to the page with the incorrect 
information, make the change, then click Next to return to the 
Summary panel.

The New Enterprise Installation wizard installs the needed files. 

Fig. 16 Installing Master Server Panel

When the wizard has finished copying files to the Login Server, 
the installation is complete, and the New Enterprise panel 
appears. 

Fig. 17 New Enterprise Panel

17 Click Finish. 

The NETinventory Console will prompt you to configure SQL 
storage for data rolled up from the NETinventory enterprise. 
Rolling up data to SQL storage allows you to use the 
NETinventory snap-in for the BindView RMS Console to retrieve 
NETinventory data. 

18 To launch the SQL Settings wizard, click Yes, and the SQL 
Settings wizard will appear. For information on configuring SQL 
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Audit Agents and Windows NT Servers
data rollup, please see “Master Server SQL Settings” on page 
104. 

Fig. 18 NETinventory Setup Navigator Dialog

Now that you have successfully completed the New Enterprise 
Installation, you should configure the Windows policies or login 
scripts on the new Login Server to automatically trigger audits when 
users log in.

Audit Agents and 
Windows NT Servers

For a node to be audited, the node must run the Audit Agent, which 
does the actual work of auditing. You must configure your Login 
Servers to run the Audit Agent when users log in. 

If per-user login scripts are enabled in your Windows-hosted Login 
Server’s User Manager, you should add the command bvaudit.exe 
to users’ login scripts. This process is easiest if multiple users share 
login scripts. If each user has a different login script, or if login 
scripts are not enabled, you can use policies to start the Audit 
Agent. 

System or group policies can be used to start the Audit Agent. For 
complete information on using System and Group policies, please 
consult your Windows documentation. 

To use policies, make sure that the directory replicator service is set 
up as specified in the Windows Server documentation. Then, use 
the System Policy Editor on a Domain Controller (DC) to add the 
Audit Agent’s Universal Naming Convention (UNC) path to the 
Default User’s Startup folder. After this is done, whenever a user 
logs into the domain, the Audit Agent will run. If a user only logs in 
to the local workstation without accessing network resources, the 
Agent will not run. 

Finally, if you prefer, you can add the command to run the Audit 
Agent to the node itself. On a DOS or Windows 3.1 node, add it to 
the node’s AUTOEXEC.BAT file. On a Windows 95, Windows 98, 
Windows Millennium Edition, Windows NT, Windows 2000, Windows 
XP, or Windows Server 2003 node, add the Audit Agent to the 
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Where to Go From Here
Startup folder in the Start menu (or in the Program Manager on 
Windows NT 3.51). 

Note: If you add the command to start the Audit Agent to a batch 
file, you must use the full UNC path for the command. That is, the 
path should be in the form:
\\server-name\path\bvaudit.exe,
with your network’s Login Server name and the path on that login 
server. 

To prevent the icon from appearing in the Start menu, you can use 
the Windows Policy Editor to add it to the Startup group without an 
icon appearing. Adding the command to run the Audit Agent to the 
node itself sacrifices the ability to do centralized maintenance 
should your Login Server change in the future. 

Where to Go From 
Here

After a Master Server, Audit Server, and Login Server have been 
successfully installed on the enterprise network, you can begin 
using NETinventory with the default settings. If you wish, you can 
make changes to the default NETinventory setup to customize it to 
your network’s needs. Use this table to help you find the 
information you need. 

Table 1  Where To Go From Here 

To learn about... go to...

Configuring the NETinventory Audit 
Agent

“Setting Up NETinventory 
Auditing” on page 59

Configuring the NETinventory Servers “Setting Up NETinventory Server 
Components” on page 101

Setting up Additional Audit Servers “Creating a New Audit Server” on 
page 126

Setting up Additional Login Servers “Creating a New Login Server” on 
page 141

Configuring the NETinventory Master 
Server Databases

“Setting Up The NETinventory 
Inventory Database” on page 159

Using the NETinventory Node Manager 
to get information about individual 
nodes

“Node Management” on page 189

Configuring NETrc NETrc User Guide

Using NETinventory as part of the 
NETinventory Console

NETinventory Console User Guide

Creating Grids, Graphs, and Schedules 
to retrieve NETinventory information

NETinventory Console User Guide
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Introduction
Introduction Before you can configure the data source that NETinventory will 
report on, you need to install NETinventory and a NETinventory 
Master Server, and at least one Audit Server and Login Server 
installed on your network. For information on deploying these 
NETinventory components, review “New Enterprise Installation” on 
page 31. 

Console Setup You can set the NETinventory Enterprise Configuration, Reporting 
Configuration, and Default Scope. These settings work together to 
set limits on how much data is returned by queries of the 
NETinventory audit information stored on your Audit Servers. 

The Enterprise Configuration determines whether NETinventory 
queries a live, working enterprise on your network or a static 
sample database. It also provides some information about the 
enterprise. 

The Reporting Configuration determines whether NETinventory uses 
live data from the network or rolled up data stored on the Master 
Server. The Reporting Configuration can be set to a Master Server 
(and all the Audit Servers associated with it), to a single Audit 
Server, or to data rolled up to the Master Server on the enterprise. 

The Default Scope is the subset of the Reporting Configuration 
which the NETinventory Console reports on when processing 
queries. Put another way, the Default Scope indicates, “of all the 
items in the Reporting Configuration, include only these items” in 
the query. If the default scope is not an appropriate choice for an 
individual query, you can override the default scope while defining 
the query. The custom scope you create can be more inclusive or 
more restrictive than the default scope. Please see the 
NETinventory Console User Guide for detailed information about 
building queries.

Opening the Console 
Setup Dialog

The Enterprise Configuration, the Reporting Configuration, and the 
Default Scope are set using the Console Setup dialog in the 
NETinventory Options. 
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Opening the Console Setup Dialog
To open the Console Setup dialog, run the NETinventory Console 
and choose Options>NETinventory Setup to open the 
NETinventory Setup Navigator. 

Fig. 19 NETinventory Setup Navigator 

Click Console Setup. The Reporting Setup dialog appears. In this 
example, a live enterprise is selected as the Enterprise 
Configuration. You can also select a Sample Enterprise as your 
default Enterprise. If you have not yet installed an enterprise, the 
Sample Enterprise will be selected. 

Fig. 20 Enterprise Configuration Panel
3: Setting Up NETinventory Console Components 47

© 2004 BindView Corporation. All Rights Reserved



Setting the Enterprise Configuration
Setting the 
Enterprise 
Configuration

The Enterprise Configuration controls where data in NETinventory 
reports originates. To control what portion of the data from the 
selected enterprise appears in reports, you also set the Reporting 
Configuration. (See “Setting the Reporting Configuration” on page 
49. 

By default, the NETinventory Console installation process sets the 
Enterprise Configuration to the sample data, either on the 
NETinventory Console CD-ROM or on your hard disk (if you chose to 
install it during the installation process). As part of the creation of a 
New Enterprise Installation, NETinventory changes the Enterprise 
Configuration to the new Live Enterprise automatically. 

To set the Enterprise Configuration

1 Open the NETinventory Console Setup dialog and make sure 
that the Enterprise Configuration panel is selected. 

Fig. 21 Enterprise Configuration Panel

2 The top part of the panel is used to set the Enterprise 
Configuration. The lower portion displays information about the 
currently selected enterprise. You may set the Enterprise to 
either a live, running enterprise or a static Sample Enterprise. 

3 Choose the Use a Live Enterprise option to select a live 
enterprise on your network. If the name of the Master Server 
on the enterprise does not appear in the Master Server field, 
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Setting the Reporting Configuration
click Select and the Select NETinventory Enterprise dialog 
appears. 

Fig. 22 Select NETinventory Enterprise Dialog

4 Type the name of the Master Server or any Audit Server that is 
part of the enterprise you are trying to connect with. 

Note: You must have rights to the directory where the Master or 
Audit Server software is stored on the server in order to connect.

5 To use a sample enterprise, select the Use a Sample 
Enterprise option in the Enterprise Configuration panel. Type 
the path to the sample data file or click the Browse button to 
the right of the field to locate the NETinventory Sample Data 
directory. 

Note: The Sample Data is static, and cannot be changed from 
within the NETinventory Node Manager or by any of the 
ActiveAdmin® editors. 

6 To save the changes without closing the dialog, click Apply. To 
save the changes and close the Console Setup dialog, click OK. 
To close the dialog without saving the changes, click Cancel. 

The lower area of the panel includes information about the currently 
selected enterprise, including the name of the Master Server on the 
enterprise, the version of the NETinventory software the Master 
Server is running, the operating system type the Master Server is 
running, and other essential information. 

Setting the 
Reporting 
Configuration 

The Reporting Data Source controls whether the NETinventory 
Console will use live data collected in real-time from your enterprise 
or will use rolled up data from the Master Server to fulfill 
NETinventory queries. 

Live vs Rolled Up Data The advantage of using rolled up data is speed. If you have a large, 
complex enterprise network tied together with slow links, queries 
will be processed much faster by using rolled up data stored on the 
Master Server. When you turn rollup on, the Master Server 
replicates some of the information stored on Audit Servers in 
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Live vs Rolled Up Data
databases on the Master Server during each synchronization. When 
a query containing fields stored on the Master Server is processed, 
the NETinventory Console contacts the Master Server for the 
needed data. 

The disadvantage of using rolled up data is that the data is not 
updated in real time. The information must first be collected by the 
Audit Server, then transferred to the Master Server during 
synchronization. Furthermore, during any synchronization, data will 
only be retrieved from 10% of the Audit Servers. Thus, some data 
will be as old as 10 synchronizations. If you change your settings so 
that there are long intervals between synchronizations, this data 
will be older, and might be out-of-date.

With synchronization settings left at the defaults, all data in the 
rollup databases will be refreshed every day. 

In addition, turning on data rollup results in higher network traffic, 
since a subset of the data from each audit is transmitted twice: 
once from the Audit Agent to the Audit Server, and once from the 
Audit Server to the Master Server. Only Audit Servers which have 
Data Rollup enabled will have their data rolled up to the Master 
Server. Turn on data rollup for an Audit Server using the Tuning 
Options button on the Audit Server Setup panel of the Server 
Setup dialog.

Only some of the audit data is rolled up to the Master Server. 
Information about the hardware and software configuration of 
nodes is rolled up. (Specifically, only information in the Hardware 
Assets and Software data sources is rolled up.) For all other data 
sources, the rollup settings do not apply. NETinventory must collect 
the query information directly from the Audit Servers. 
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To set the NETinventory Reporting Data Source

1 Open the Reporting Setup dialog and select the Reporting 
Configuration panel. 

Fig. 23 Reporting Configuration Panel

2 In the Select Reporting Data Source area, choose Report 
from Live Data on the Current Enterprise to report on live 
data. Select the name of a Master or Audit Server on the 
enterprise from the Primary Reporting Server drop-down 
list. 

3 Select Report from Rolled-Up Data on the Current 
Enterprise to use rolled up information. The name of the 
Master Server which hosts the rollup data appears in the 
Rollup Server box. 

4 To save the changes without closing the dialog, click Apply. To 
save the changes and close the Console Setup dialog, click OK. 
To close the dialog without saving the changes, click Cancel. 
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Setting the 
Default Scope

The Default Scope limits the data which the NETinventory Console 
retrieves out of that maximum possible. Instead of using all of the 
available servers when processing queries, only a specified subset is 
used.

Scoping allows you to control the amount of data received by the 
Console when processing a query. The amount of data sent to the 
console over the network influences the speed at which queries are 
processed, the load on network bandwidth, and the relevance of 
results generated by a query. 

In other words, scoping allows you to limit the extent of the 
question that the NETinventory Console asks. Rather than querying 
every Audit Server on your Enterprise Network and then discarding 
the irrelevant portions, limiting the scope only queries relevant 
servers. By limiting the scope, you limit the information transmitted 
and speed up query processing.

No matter what you set the default scope to, you can override it for 
any query and use whatever scope is appropriate. 

When defining the default scope, you have the following choices:

• All Audit Servers in the NETinventory server database
• Currently connected Audit Servers
• Specified Sites
• Specified Audit Servers

Configuration and 
Default Scope 
Interactions

The default scope affects which servers on your enterprise network 
will be queried for information when a query is processed. For more 
information on these interactions, see Table 2, “Data Path/Scope 
Interactions,” on page 53. 
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Configuration and Default Scope Interactions
In addition to the cases defined above, when a Master Server is 
selected in the Enterprise Configuration panel, the Reporting 
Configuration allows you to control whether Live data or Rolled Up 
Data is used. The Reporting Configuration panel is omitted from the 
table above. 

Default Scope is All 
Audit Servers

If you are using All Audit Servers in the NETinventory server 
database as the default scope option, the console will use all the 
Audit Servers known to the Master Server (Fig. 24).

Table 2   Data Path/Scope Interactions 

If the Enterprise 
Configuration is...

and the Default 
Scope is... Then... ...is/are

Live Enterprise All Audit Servers in 
the NETinventory 
server database

All Audit Servers Included

Currently Connected 
Audit Servers

Each Audit Server connected 
to the console workstation

Included

Each Audit Server not 
connected to the console 
workstation

Excluded

Specified Sites All Audit Servers included in 
the sites specified in the 
default scope

Included

All Audit Servers not included 
in the sites specified in the 
scope

Excluded

Specified Audit 
Servers

Each specified Audit Server Included

Each Audit Server not 
specified 

Excluded

Sample Enterprise All Cases Sample Data 
defined in 
Enterprise 
Configuration 
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Configuration and Default Scope Interactions
For any Enterprise Network, there is only one Master Server. As a 
consequence, no Audit Servers can exist without being known to 
the Master Server.

Fig. 24 Effective sources when you use Master Server as the 
enterprise configuration and all Audit Servers as the 
scope. 

Default Scope is 
Currently Connected 
Audit Servers

If you are using Currently connected Audit Servers as the 
default scope option, the console will access the Audit Servers 
found on all the servers to which the workstation is currently 
connected. A console is connected to an Audit Server when its 
workstation is logged in to the server or it has at least one drive 
mapped to that Audit Server (Fig. 25). 

Fig. 25 Effective sources when you use Master Server as the 
enterprise configuration and Currently Connected 
Audit Servers as the scope.
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Configuration and Default Scope Interactions
Default Scope is 
Specified Sites

If you are using Specified Sites as the default scope option, the 
console will see those Audit Servers which are part of the site (Fig. 
26). 

Fig. 26 Effective sources when you use Master Server as the 
enterprise configuration and specified sites as the 
scope. 

Default Scope is 
Specified Audit Servers

If you are using Specified Audit Servers as the default scope 
option you can select which of the Audit Servers in the Master 
Server’s database of servers should be included in the default scope 
(Fig. 27). 

Fig. 27 Effective sources when you use Master Server as the 
enterprise configuration and specified Audit Servers 
as the scope.
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Selecting a Default Scope
Selecting a Default 
Scope

When you set the default scope, don’t forget to consider the 
interactions between the enterprise configuration and the default 
scope. 

To set a Default Scope

1 Open the Reporting Setup dialog and select the Default 
Scope panel on the left side of the dialog. The Default Scope 
panel appears. 

Fig. 28 Default Scope Panel

2 Select the default scope to use. If you choose Specified Sites 
or Specified Audit Servers, you will need to supply additional 
information. 

3 If you choose Specified Sites or Specified Audit Servers, 
you need to specify which sites or audit servers should be 
included. Fig. 29 shows Specified Sites selected and Fig. 30 
shows Specified Audit Servers selected.
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Selecting a Default Scope
Fig. 29 Specified Sites Picker

Fig. 30 Specified Audit Servers Picker

4 Use the Add>, Add All>>, <<Remove All, and <Remove 
buttons to move the Sites or Audit Servers you wish to include 
in the scope from the All Sites/All Audit Servers box to the 
Specified Sites/Specified Audit Servers box. 
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Selecting a Default Scope
5 To save the changes without closing the dialog, click Apply. To 
save the changes and close the Console Setup dialog, click OK. 
To close the dialog without saving the changes, click Cancel. 
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Overview
Overview NETinventory audits nodes by running an Audit Agent on a node. 
The Login Server is normally configured to run Audit Agent when 
nodes The Audit Agent is stored on the Login Server. The Audit 
Agent is generally launched using NetWare or Windows login scripts 
or Windows system policies when the node logs in or authenticates 
to a server that has been set up as a NETinventory Login Server.

Although the Audit Agent runs on individual workstations, the 
options and preferences the Agent uses are set using the 
NETinventory Console. When you set preferences for audits, the 
NETinventory Console saves the preferences to the Master Server. 
The Master Server updates the preference files for all Audit Servers 
during the next scheduled or manual synchronization. After 
synchronization, the next time the Audit Agent connects to the 
Audit Server and performs an audit, the updated preferences are 
used. 

Preference changes do not take effect immediately. The preferences 
used by the Audit Agent will not change until the changes are sent 
to Audit Servers by a synchronization. When changes are made to 
Audit settings, the NETinventory Console prompts to synchronize 
immediately to reduce this delay.

Even after synchronization, a node will not be audited and node 
data will not be updated using the new settings until it runs the 
Audit Agent from a Login Server. When audit preferences are set up, 
careful planning of the kinds of information to gather will improve 
the performance of the NETinventory installation. 

If the Audit Agent is not collecting the information being sought, 
make changes to your Auditing Setup to collect the correct 
information, but keep in mind that it may take time to obtain 
updated results as nodes are audited. 
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Overview
To access Audit Settings

1 Open the NETinventory Setup Navigator by choosing 
Options>NETinventory Setup in the NETinventory Console. 
The NETinventory Setup Navigator appears. 

Fig. 31 NETinventory Setup Navigator 

2 Click Auditing Setup. The Node Settings panel appears. 

Fig. 32 Node Settings Panel

Use the panels in the Auditing Setup dialog to control the 
information the NETinventory Audit Agent collects from audited 
nodes.
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Configuring Node Settings
Configuring Node 
Settings

The Node Settings Panel configures the Node Name, Owner Name, 
and the Node ID for newly audited nodes. In addition, the Node 
Settings panel controls how often the Node Name and Owner 
Name are updated for existing nodes. 

To configure General Node Settings

The General Node Settings determine when inactive node records 
are deleted and whether or not the computer’s OEM Serial Number 
is used to determine Node ID.

1 To use the OEM Serial Number to determine the Node ID, select 
the Use OEM Serial Number for Node ID box. 

When Use OEM Serial Number for Node ID is checked, the 
Audit Agent will use the Serial Number set by the motherboard 
manufacturer to identify nodes. Some older machines lack an 
OEM Serial Number, and some manufacturers do not assign 
unique Serial Numbers—instead, they assign the same serial 
number to more than one machine. 

If you have Use OEM Serial Number for Node ID enabled 
and your nodes do not use unique serial numbers, the Audit 
Agent will not be able to identify nodes correctly. Before 
deciding to Use OEM Serial Number for Node ID for your 
entire network, allow a sample set of nodes to be audited and 
check their OEM Serial Numbers using a NETinventory report. If 
duplicate serial numbers appear, do not select Use OEM Serial 
Number for Node ID. 

2 To prevent inactive nodes from being deleted, select Inactive 
nodes never expire. To remove inactive nodes from the 
database automatically after a time, select Inactive node 
records deleted every and enter a number and unit that 
NETinventory should wait before purging inactive nodes. 

To choose default names for new nodes 

Every node has two names assigned to it in the NETinventory 
databases: 

• Node Name – Normally applies to the node itself
• Owner Name – Normally applies to the person who controls the 

node

These settings apply when a new name is created or when a name 
is refreshed. 

1 Choose a source for the Node Name from the Select source 
to use as the Node Name list. If Custom Environment 
Variable is selected, supply the name of the environment 
variable to use.

2 Choose a source for the Owner Name from the Select source 
to use as the Owner Name list. If Custom Environment 
Variable is selected, supply the name of the environment 
variable to use.
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Setting Up System Configuration Detection
3 Choose how often the NETinventory Audit Agent updates the 
Node Name and Owner Name by setting the number and the 
units the Audit Agent should wait between intervals for each in 
the Node Name is refreshed every and Owner Name is 
refreshed every fields. 

4 To save the changes without closing the dialog, click Apply. To 
save the changes and close the Console Setup dialog, click OK. 
To close the dialog without saving the changes, click Cancel. 

Setting Up System 
Configuration 
Detection

The System Configuration Detection panel controls the 
information the NETinventory Audit Agent collects about node 
configurations. It also configures how often nodes are audited and 
which tests the NETinventory Audit Agent performs. Last, it is used 
to configure the alert levels NETinventory sets when specified 
conditions are detected.

Note: NETinventory uses the built-in Desktop Management 
Interface (DMI) to collect some information about nodes. Most 
computers built since 2000 store their DMI information in a way 
that requires local administrator access to collect. If the currently-
logged in user is not a Local or Domain Admin on a computer when 
the Audit Agent runs, DMI information will not be collected. All other 
NETinventory information will be collected. 
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Setting Up System Configuration Detection
To set up System Configuration Detection

Open the NETinventory Audit Setup dialog and select the 
System Configuration Detection icon. The System 
Configuration Detection panel appears. 

Fig. 33 System Configuration Detection Settings Panel

To configure System Configuration Detection Settings 

The NETinventory Audit Agent can be configured to ignore certain 
classes of hardware configuration tests if a test causes problems. 
You can almost always enable all tests, since the tests almost never 
cause problems. Auditing does not go perceptibly faster with tests 
disabled—each test takes very little time.
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Setting Up System Configuration Detection
1 Open the System Configuration Detection panel and click 
the Detection Settings button. The System Configuration 
Detection Settings dialog is displayed. 

Fig. 34 System Configuration Detection Settings Dialog

2 The dialog is divided into five tabs that group the tests. You can 
select a test to enable it, or unselect to disable it. 

If you disable a test, it will not be performed on any of the 
nodes on your network. 

Under certain circumstances, particular tests can cause 
problems with a particular node. When problems occur on a 
particular node, the NETinventory Audit Agent will 
automatically disable the test on that node only. Refer to 
“Controlling the Tests the Audit Agent Performs” on page 210 
for information on configuring tests for individual nodes. 
System Configuration Detection Settings control testing on all 
nodes. 

To configure Default Hardware Records

NETinventory cannot detect everything that you might wish to 
record about nodes—information such as serial numbers, places of 
purchase, warranty records, and so on cannot be detected. 
NETinventory allows you to keep an inventory database with this 
information for each node. When a node is first audited, the records 
you specify are created in each node’s inventory database. For 
information on using the hardware assets for each node, see 
“Hardware Assets Information” on page 197.

The items in the hardware assets database vary greatly from 
organization to organization. The NETinventory Administrator must 
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Alerts
determine which pieces of hardware are classified as individual 
components, and which are parts of another component. For 
example, you must decide if a motherboard, power supply, and RAM 
chips be considered as three separate assets, or as a single asset—
a computer.

Use Default Hardware Records to select which components to 
include. The Node Manager is used to add additional components to 
a single node’s record manually. See “Hardware Assets Information” 
on page 197 for more information on managing the Hardware 
Assets for each node.

1 Open the System Configuration Detection panel and click 
Default Hardware Records. The Default Hardware Asset 
Records dialog appears. 

Fig. 35 Default Hardware Asset Records Dialog

2 Select the hardware items to include in default hardware asset 
records. 

3 Click OK to save the changes and close the dialog.

Alerts NETinventory Alerts are “flags” the Audit Agent can set to warn of 
potential trouble or of changes to nodes on the Enterprise Network.

Every alert is assigned to a level. Levels group alerts of similar 
importance. Alert levels range from 0 to 20. The lower the alert 
level value, the more serious the alert, except that Level 0 means to 
generate no alert. 

Some alerts should only occur one time, no matter how often the 
condition is detected; other alerts should always be generated, 
even if the alert condition is ongoing. You can set the threshold for 
repeating alerts. Alerts with values lower than the threshold will be 
generated again whenever the condition that caused them is 
detected. Alerts with values above the threshold will only generate a 
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Alerts
single alert if the condition recurs and the first alert has not been 
acknowledged.

When an alert is generated, the alert and any supporting 
information is added to the Audit Server’s database for the node.

There are two ways to examine alerts:

• Create a query that generates a grid and use the Node Manager 
to examine each node and view the node’s alerts. This approach 
allows you to examine all of the alerts associated with a node in 
detail, making it difficult to quickly see which alerts are most 
important so that you can correct the conditions which caused 
them. 

• Create a query for all nodes with alerts that have not been 
acknowledged. You can sort the resulting grid on the priority level 
of alerts so that the most serious alerts are listed first. Use the 
Node Manager to view each alert and acknowledge it. See the 
NETinventory Console User Guide for more information on using 
the Query Builder, Grids, and Schedules.

When you create alerts, keep in mind your site’s configuration and 
what potential problems your network might encounter. For each 
alert condition, decide when an alert is warranted and the alert level 
called for. 

You can choose to have an Alert Action taken on the node when the 
alert is generated. When the alert is generated, the Audit Agent will 
execute a specified command line on the node. There is a different 
command line for each Operating System the Agent runs on.

To set up System Configuration Alerts

NETinventory System Configuration Alerts generate alerts when the 
Audit Agent detects conditions related to node hardware and 
software configuration.
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1 Open the System Configuration Detection panel and click 
Alert Settings. The System Configuration Alert Settings 
dialog appears. 

Fig. 36 System Configuration Alert Settings Dialog

2 To configure an alert condition, select it and set the alert level 
the Audit Agent should set. 

Some items also can generate an alert based on the percentage 
change in an item since a prior audit. 

Other items can generate an alert if an item’s value is below a 
threshold value.

Alert levels range from 0 to 20. Lower alert level values are 
more serious. Level 0 means to generate no alert. 

To configure an action taken when an alert is generated

1 To set an action which should be taken when an alert is 
generated, click the Action button. The Alert Actions dialog 
appears. 

Fig. 37 Alert Actions Dialog
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Configuring Software Detection
2 For each operating system, enter a command line the Audit 
Agent will execute on the node when it generates an alert. 

You do not have to enter an action for each operating system. 
Blank actions are skipped. The command line will be executed 
by the node just as if it were typed at a command prompt.

3 Click Done to save the changes and close the dialog.

Configuring 
Software 
Detection

The Software Detection panel controls the information collected 
about software on audited nodes. It also determines how often 
software audits are performed, and which files are included and 
excluded from searches. Finally, you can set alert levels generated 
when software categories are detected.

To configure Software Detection

1 Open NETinventory Audit Setup dialog and select the 
Software Detection icon. The Software Detection panel 
appears. 

Fig. 38 Software Detection Panel 

2 Select the Activate software recognition box to audit the 
software on nodes at the interval in the Perform software 
recognition field. 

Note: The Audit Agent will only run when users log in to a Login 
Server. Setting the audit interval to “1 hour” means that if more 
than one hour has elapsed since a node last logged in, the node will 
be audited. It does not mean that nodes will be audited every hour.
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It takes longer to perform a software audit than to perform the 
hardware audits. Software Detection is activated, deactivated, and 
timed separately from hardware audits. Since software audits take 
more time, consider making software audits occur less frequently 
than the other audit components. 

To control which files are seen as software

Administrators can specify which files the NETinventory Audit Agent 
treats as part of software packages and which files are ignored. The 
middle of the Software Detection panel contains file specifications 
that control which files are treated as software and which are not. 

The Master Software list requires that certain items always be 
considered part of software packages. These file types are found in 
the read-only File types NETinventory will always try to 
recognize field. 

If you add Custom Software which relies on the presence of a file 
that is not one of the standard types, add the custom type or types 
to the Additional file types to try to recognize list.

To add a custom file type, type its extension in the field. Separate 
file extensions with a semicolon (;). File types should be added in 
UPPERCASE letters only. 

In addition, you control which types of files NETinventory will add to 
the list of unknown software in the Settings for the Enterprise-
wide Unknown Software List section. To include a file type, add 
its specification to the File types to include list and separate each 
file type specification with semicolons. Exclude files smaller than a 
particular size by setting the Minimum size to include field.

To configure Software Detection Alerts

The NETinventory Audit Agent can generate alerts based on 
detected software. 

You can choose to generate an alert when software in a specified 
category is added, deleted, updated, or moved. Refer to page 66 for 
more information on alerts. You can also choose to generate an 
alert based on the category of the software the Audit Agent detects. 
Categories are assigned to software in the Master and Custom 
Software Lists. For more detailed information about setting up and 
using categories, refer to Chapter 6 on page 159.
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1 Open the Software Detection panel and click Alerts. The 
Software Alert Settings dialog appears. 

Fig. 39 Software Alert Settings Dialog - Installed Software 
Tab

2 Select the appropriate boxes to generate an alert when new 
software is installed or when existing software is uninstalled or 
updated. You can set a unique alert level for each condition. 

3 Select the Discovered Software tab to set alerts for a 
particular category. 

Fig. 40 Software Alert Settings Dialog - Discovered Software 
Tab 

4 Select the category from the list and set an alert level to 
generate when software in that category is discovered, missing, 
or moved. 
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5 Click OK to close the dialog and save changes or click Cancel 
to close the window without saving changes. 

Configuring 
Tracked Files

NETinventory can track crucial system files such as AUTOEXEC.BAT. 
When files are found, you can search their contents for particular 
text strings. You can save the contents of the file to the Audit 
Server for later use. Use this to store snapshots of critical batch and 
configuration files (e.g., *.BAT, *.CFG, *.INI) on the Audit Server 
automatically. When changes to these files cause problems you can 
use the Audit Agent to transmit a known good version of the file to 
the node and force the node to restart. 

Create as many Tracked File searches as you wish. The interval, 
audit file specifications, and alert settings are configured 
independently for each file audit. 

To configure tracked files 

1 Open the NETinventory Audit Setup dialog and select the 
Tracked Files icon. The Tracked Files panel appears. 

Fig. 41 Tracked Files Panel
72 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Configuring Tracked Files
2 Select an existing tracked file search from the list on the left 
side of the panel. Click New to create a new tracked file audit. 
If you create a new audit, the Tracked File dialog appears. 

Fig. 42 Tracked File Dialog

Enter the name of the new tracked file audit and click Done to 
create it. 

A tracked file audit’s name does not have to be the same as the 
name of the file the audit should search for. The new tracked 
file audit will be created. 

Fig. 43 Tracked File Panel

3 On the right side of the panel, set the audit interval. Each file 
audit has a different interval. The files tracked by some audits 
change more often than others, and their audits should be 
performed more frequently.

4 Enter the specification for the file. For some files, you enter the 
file’s full name, including the extension; for others, you can use 
wildcards. The File Specification accepts normal DOS 
wildcards for file names.

You can enter a search path that the Audit Agent should use to 
restrict its search. Entering a search path restricts the locations 
the Audit Agent searches for the file, speeding the search and 
limiting the returned files. Any search path you enter should 
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not include a drive letter. To limit which drives are searched, 
click the Advanced button.

5 Select the maximum number of matches the file audit should 
find. Even without using wild cards in your search, more than 
one file can be found by your search, and limiting the number 
of matches allows you to set limits on how much time the Audit 
Agent spends searching. 

6 To retrieve the contents of the file to the Audit Server for 
storage, select the Retrieve Contents box.

To configure file audit alerts

File audits can generate alerts when the files being sought are 
found, are not found, are changed, or when more files than the 
maximum you specify are found. 

1 In the NETinventory Audit Setup dialog, click the Alerts 
button. The Tracked File Alerts dialog appears. 

Fig. 44 Tracked File Alerts Dialog

2 Select the file audit alerts to configure. The Audit Agent can 
generate an alert level when the file is found, when the file is 
not found, when it is changed since the last audit, or when 
more than the maximum number of allowed files are found. 

Each alert condition can also cause an action to be performed 
on the node. Click the Action to configure Alert Actions. For 
more information on Alert Actions, please see “To configure an 
action taken when an alert is generated” on page 68. 

3 Click OK to close the dialog and save changes or click Cancel 
to close the dialog without saving the changes.

To search for a string inside a tracked file

The NETinventory Audit Agent can search inside a tracked file for a 
string. String searches can generate an alert based on the results of 
the search. The Audit Agent can also retrieve a value associated 
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with the string. Tracked files can have any number of string 
searches. Only files found by the audit will be searched.

1 Select the Tracked File audit to search and click String 
Searches. The String Search dialog appears. 

Fig. 45 String Search Dialog

2 If the String Search exists, select its name from the list. Click 
New to create a new String Search. The String Name dialog 
appears. 

Fig. 46 String Name Dialog

Type a name for the string search. The name does not need to 
match the string the Audit Agent should find. 
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The new string search appears in the list of string searches. 

Fig. 47 String Search Dialog

3 Enter the string inside the file the search should find.

4 Select how many matches the String Search should find. If you 
want the search to be case sensitive (that is, to distinguish 
between “A” and “a”), select the Case Sensitive Search check 
box.

The Audit Agent can find special characters in the strings. See Table 
3.

Table 3  Special Characters in Search Strings 

Character 
String Finds

<WS> White space – one or more spaces, returns or tabs 
following a character

<CR> Carriage Return

<EL> End of Line

<BL> Beginning of Line

<FF> Form Feed

<BS> Back Space

<SP> Space

<TAB> Tab

<BELL> Control-G
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To configure advanced string search parameters

1 Select a String Search and click Advanced. The Advanced 
String Search Settings dialog appears. 

Fig. 48 Advanced String Search Settings Dialog

2 Some lines in the found file are comments and should not be 
searched for the string. Edit the Comment Prefixes field to 
define characters that begin comment lines. Items in the field 
are separated with commas (,). By default, the field contains 
the most common comment markers. You can delete them if 
you choose.

3 When Retrieve the Value Associated with the String is 
selected, Audit Agent will use the specifications you provide to 
collect a value associated with the string for storage. Use this 
ability to audit and store values in a configuration file. See Table 
3, “Special Characters in Search Strings”  for information on the 
special characters you can use in the value prefix and suffix 
boxes.

4 Select Trim Leading and Trailing Spaces from Value to 
delete extraneous spaces. 

5 Click OK to close the dialog and save changes or click Cancel 
to close the dialog without saving the changes.

To configure string search alerts

String Searches can generate alerts when strings are found, are not 
found, are changed, or when more than the maximum number of 
occurrences you specify are found. 
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1 Open the NETinventory String Search dialog and click the 
Alerts button. The Tracked File String Search Alerts dialog 
appears. 

Fig. 49 Tracked File String Search Alerts Dialog

2 Select a String Search. You can set alert levels generated when 
the selected audit finds a string, fails to find a string, finds a 
changed string, or finds more than the maximum number of 
allowed strings. 

Each alert condition can also cause an action to be performed 
on the node. Click the Action to configure Alert Actions. For 
more information on Alert Actions, please see “To configure an 
action taken when an alert is generated” on page 68. 

3 Click OK to close the dialog and save changes, or click Cancel 
to close the dialog without saving the changes.

To configure advanced tracked file settings

Advanced Tracked File Settings allow you to limit the search in 
various ways. Each Tracked File Audit has unique Advanced Tracked 
File Settings. You can limit searches based on:

• Number of subdirectories searched for matching files
• Range of possible dates for the file
• Range of possible sizes for the file 
• Drives searched for the file 

You can also specify the probable type of the file, since only certain 
types of files can be transmitted to the Audit Server for storage. 
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1 Open NETinventory Tracked Files panel and click the 
Advanced button. The Advanced Tracked File Settings 
dialog appears. 

Fig. 50 Advanced Tracked File Settings Dialog

2 Select the probable type of the file from the drop-down list. 

An ASCII file is one readable by most humans (e.g., a batch 
(*.BAT) or configuration (*.INI or *.CFG) file). A binary file 
contains only program code, and is usually not human-readable 
(e.g., *.EXE, *.COM, or *.DLL files). Binary files require less 
space in the NETinventory database, but cannot be edited and 
sent back to the node, although they can be saved to disk.

3 To use a CRC (checksum) to determine if the file has changed 
since the last audit, select the CRC the File to Detect 
Changes check box. If a CRC is not used, the file’s size and 
date will be compared to the database to determine if it has 
changed.

4 To limit the audit to a finite number of the subdirectories of the 
directory specified in the search path, enter a value in the Max 
Subdirectories to Search field. A zero (0) means to search all 
subdirectories. Limiting the subdirectories speeds the audit.

5 To limit the found files by size or date, enter the appropriate 
values into the Range of File Sizes to Match and Range of 
File Dates to Match fields.

6 Use the check boxes in Drives to Search for Match to limit 
the search to a subset of available drives. Choices are additive: 
First Local Fixed Disk and All But First Fixed Disk have the 
same meaning as All Local Fixed Disks when both are 
chosen.

7 Click OK to close the Advanced Tracked File Settings dialog 
and save changes or click Cancel to close the dialog without 
saving the changes.
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Configuring 
Tracked 
Environment 
Variables

NETinventory can track the values of Environment variables and 
NetWare Server SET variables. You search for Environment 
Variables and Server SET Variables in the same way.

Create as many tracked environment variable searches as you wish. 
The search parameters and alert settings are configured 
independently for each file audit. Every search is performed each 
time the Audit Agent runs on a node.

To configure Tracked Environment Variables

1 Open the NETinventory Audit Setup dialog and select the 
Tracked Environment Variables icon. The Tracked 
Environment Variables panel appears. 

Fig. 51 Tracked Environment Variables Panel

2 Select an existing tracked environment variable on the left side 
of the panel. Click New to create a new tracked environment 
variable audit. The Tracked Environment Variables dialog 
appears. 

Fig. 52 Tracked Environment Variables Dialog

Type a name for the tracked environment variable search. The 
name does not need to match the variable the Audit Agent 
should find. 
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The new audit appears in the list of searches. 

Fig. 53 Tracked Environment Variables Panel

3 Enter the specification for the variable in the Variable Name 
field. 

The Variable Name field accepts normal DOS wildcards for 
names.

4 Select the alert level generated when the variable is found, not 
found, or when the variable’s value changes. 

Each alert condition can also cause an action to be performed 
on the node. Click the Action to configure Alert Actions. For 
more information on Alert Actions, please see “To configure an 
action taken when an alert is generated” on page 68. 

5 Click OK to close the dialog and save changes, or click Cancel 
to close the dialog without saving the changes.

Configuring 
Tracked Drivers 
and Services

NETinventory can track Drivers and Services on Windows machines 
and NetWare NLMs. You search for Drivers, Services, and NLMs in 
the same way.

Create as many Driver and Service searches as you wish. The 
search parameters and alert settings are configured independently 
for each file audit. Every search is performed each time the Audit 
Agent runs on a node.
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To configure Tracked Drivers and Services 

1 Open NETinventory Audit Setup dialog and select the 
Tracked Drivers and Services icon. The Tracked Drivers 
and Services panel appears. 

Fig. 54 Tracked Drivers and Services Panel

2 The NETinventory Audit Agent searches for drivers, services, 
and NLMs by name. Select an existing search on the left side of 
the panel to change it. Click New to create a new search. The 
Tracked Drivers and Services dialog appears. 

Fig. 55 Tracked Drivers and Services Dialog
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3 Enter the name of the driver, service, or NLM the Audit Agent 
should search for and click Done. The new search appears in 
the Tracked Drivers and Services Panel.

Fig. 56 Tracked Drivers and Services Panel 

4 Select the alert level generated when the driver, service, or 
NLM is found, not found, or changes. 

Each alert condition can also cause an action to be performed 
on the node. Click the Action to configure Alert Actions. 

5 Click OK to close the dialog and save changes or click Cancel 
to close the dialog without saving the changes.

Configuring Audit 
Agent User 
Interaction

You can control many aspects of the NETinventory Audit Agent’s 
interaction with users. The Audit Agent can scan the node for a 
particular environment variable or ask the user to provide 
information directly. You can control the status messages the Agent 
displays while auditing the node. Finally, you can suppress Audit 
Agent status messages entirely if you choose.

To configure user defined fields

There are twelve user-defined fields you can configure to retrieve 
information from nodes or from users. Any field can be filled by the 
value of an environment variable, or by prompting the user with a 
question. The Audit Agent can attempt to fill the value with an 
environment variable and prompt the user for information only if 
the variable cannot be found.
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1 Open the NETinventory Audit Setup dialog and select the 
User Interaction icon. The User Interaction panel appears. 
Select the Custom Fields tab. 

Fig. 57 User Interaction Panel - Custom Fields Tab

The left column contains the names of the fields. These names 
are used to help you remember the information they contain. 
When you create a grid using these fields, the original names 
appear in the grid.

2 If the Audit Agent should attempt to fill the field with 
information from an Environment Variable, select the box in the 
Environment Variable column on the appropriate row and 
enter the name of the variable.

3 If the Audit Agent should prompt the user of the node being 
audited for information, select the box in the User Prompt 
column on the appropriate row and enter the text the Audit 
Agent should display to prompt the user (e.g., “Please enter 
your phone number”). 

Note: When both the Environment Variable and User Prompt 
columns are checked for a field, the Agent will first search for the 
value of the environment variable. If the variable cannot be found, 
the Agent will prompt the user for the information. 

When the Agent prompts the user for information, it will also display 
the user’s answers and ask for confirmation that they are correct. If 
no answer is supplied in a preset period of time, the Agent will 
ignore the prompt and any responses and continue with the audit.
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To configure software and hardware user defined fields

You can set the names of the fields in the Software and Hardware 
Asset pages of the Node Manager. To edit the names of these fields, 
open the User Interaction panel and select the SW/HW UDFs 
tab. 

Fig. 58 User Interaction Panel - SW/HW UDFs Tab

To configure software and hardware prompts

You can control the status messages the NETinventory Audit Agent 
displays while performing an audit. To configure either the Software 
or Hardware Audit Prompts, open the User Interaction panel and 
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select the SW Prompts or HW Prompts tabs. You can edit the 
prompts for any field (see Fig. 59, 60).

Fig. 59 User Interaction Panel—SW Prompts Tab

If the “Reboot Now Prompt” on the Software Prompts tab is left 
blank, users will not be asked for permission to reboot the computer 
after a file download. Instead, the reboot will happen automatically 
when needed. If a message is in the field, the user will be able to 
delay the reboot, although they may not be able refuse the 
download which is causing the reboot.
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Fig. 60 User Interaction Panel—HW Prompts Tab

To configure general user interaction settings

You can use the General tab of user interaction settings to control 
whether and how the user sees the Audit Agent while an Audit is 
being performed. You can also use it to force the information in User 
Defined Fields to be collected again. 

1 Open the User Interaction panel and select the General tab. 

Fig. 61 User Interaction Panel - General Tab
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2 When Display agent during audit is selected, the Audit Agent 
appears in a window while an Audit is being performed, 
whether or not user interaction is called for. 

When Minimize agent during audit is selected, the Audit 
Agent appears as a minimized application while it is running 
unless user interaction is required. If the user must respond to 
UDF prompts, the Audit Agent window appears.

When Hide agent during audit is selected, the Audit Agent 
will not appear at all unless user interaction is required. 

3 Uncheck Display copyright message during audit and the 
Audit Agent will not display its copyright message when it 
executes.

4 The UDF user prompt reset interval specifies how long User 
Defined Fields which prompt the user are valid before the Audit 
Agent requests the information from the user again. If the User 
Defined Field is filled with an environment variable, it is 
checked during each audit.

Alert Defaults and 
Global Alert 
Settings

Alert Defaults help speed up the process of creating new Device 
Driver, Environment Variable, File Audit String Search and File Audit 
alerts by setting default alert levels. It is not essential to configure 
alert defaults. Once default settings are in place, you will only need 
to make changes for special cases. 

Global Alert Settings allow you to set an expiration date to 
automatically delete old alerts. In addition, you can set a threshold 
for alerts that will always be generated when they occur. 
88 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Alert Defaults and Global Alert Settings
To configure alert defaults

1 Open the NETinventory Audit Setup dialog and select the 
Alerts icon. The Alerts panel appears. 

Fig. 62 Alerts Panel

2 You can configure the Default Alert settings for the Drivers/
Services/NLMs, Environment/SET Variables, Tracked File String 
Searches, or Tracked Files. Select the appropriate item in the 
list and set the defaults in the area on the right. Table 4 
contains information on the default alerts you can set.  

3 Some alerts are less important and you only want to be notified 
of them the first time they occur. When they occur again, the 
alerts should not be generated again. Other alerts are more 
serious, and if the conditions that caused them persist, the 
Audit Agent should continue to generate alerts until the 
condition is corrected. Use the Always Alert Threshold field 
to control which alerts are generated when they recur. 

Table 4  Alert Default Options 

Item Name You Can Configure

Drivers/Services/NLMs Driver/Service/NLM Found, Driver/Service/NLM 
Not Found, Driver/Service/NLM Changed 

Environment/SET 
Variables

Variable Found, Variable Not Found, Variable 
Changed

Tracked File String 
Searches

String Found, String Not Found, Value Changed, 
Number of Instances Changed 

Tracked Files File Found, File Not Found, File Changed, Files 
Found Exceeded Maximum 
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4 You can also choose to automatically delete old alerts. Use the 
Automatically delete alerts older than field to specify when 
old alerts are deleted.

Configuring Run 
Files

The Audit Agent can run other programs on the nodes on your 
network when performing an audit. You could use this ability to run 
a virus scanner while auditing a workstation, then later use a File 
Audit search to retrieve the results of the scan from a text log file. 
You can also use Run Files to run other types of diagnostic programs 
such as ScanDisk. 

Create as many Run Files entries as you wish. The commands to 
execute are configured independently for each Run File. You can 
select how often Run Files are executed on audited nodes. To set a 
program to be run, you must first create a command line that 
NETinventory should use to run the program on each operating 
system where the Audit Agent runs. For each Run File, there are 
separate command lines executed for DOS and Windows 3.1, 
Windows 95, Windows 98 and Windows Millennium Edition, and 
Windows NT, Windows 2000, Windows XP, and Windows Server 
2003.

To configure run files

1 Open the NETinventory Audit Setup dialog and select the 
Run File icon. The Run File panel appears. 

Fig. 63 Run File Panel
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2 Select an existing Run File from the list of Run Files. Click New 
to create a new Run File. The New Run File dialog appears. 

Fig. 64 New Run File Dialog

Type a name for the run file. The name does not need to match 
the command that the Audit Agent will execute. 

The new run file appears in the list. 

Fig. 65 Run File Panel

3 Select the box for each operating system the command should 
run on, and enter a command line the Audit Agent will execute 
on that operating system. Any unselected operating systems 
will be skipped. 

4 Use the Execute this run file every item to control how often 
the Run file is executed. 

5 Click OK to close the dialog and save changes or click Cancel 
to close the dialog without saving the changes.
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Configuring 
Standalone Audits

The standard NETinventory Audit Agent only audits nodes 
connected to the network. To include nodes not on your network 
(e.g., machines disconnected from the network for security reasons 
or off-site machines) NETinventory creates Standalone Auditing 
Disks. You can take these disks to the nodes and audit them, 
storing the audit results on a floppy or other removable disk. Later, 
you can include the data collected by the standalone agent into the 
NETinventory Audit Server databases. Other than differences in the 
way they are audited, Standalone Nodes are identical to other audit 
types. 

To create a standalone auditing disk

1 Open the NETinventory Setup dialog. Click the Standalone 
Auditing Configuration icon. The Standalone Auditing 
Configuration panel appears. 

Fig. 66 Standalone Auditing Configuration Panel
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2 Click Create Disk to start the Create Standalone Auditing 
Disk wizard. The Standalone Audit Type panel appears. 

Fig. 67 Standalone Audit Type Panel

3 Select the type of workstation you wish to audit. Click 
Windows (32-bit) for Windows 95, Windows 98, Windows ME, 
Windows NT, Windows 2000, Windows XP, and Windows Server 
2003, DOS Workstation for DOS and Windows 3.1, or 
NetWare File Server. Click Next to continue. The Select 
Drive panel appears. 

Fig. 68 Select Drive Panel

4 Select the drive containing the disk to use from the list of 
available drives. You can install the Standalone Auditing files on 
any drive mapped to a drive letter on your computer, but it is 
most helpful if you choose a removable volume such as a floppy 
disk or a removable drive so you can take the disk to another 
computer easily. Click Next to continue. 
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Note: Some machines with a very large amount of software may 
produce report files that are too large to fit on a floppy disk. For 
machines with large and complex collections of software, consider 
using some form of removable or portable hard disk for auditing. 

If there is not enough free space on the disk, an error message 
appears. Otherwise, the Summary dialog appears. 

Fig. 69 Summary Panel

5 Review the choices shown in the summary. Click Next to create 
the disk and proceed; use the Back button to make 
corrections. After the wizard copies the Standalone Audit files 
to the disk, the disk is ready for use. 

The Audit Preferences on the Standalone Auditing disk are those in 
effect when the disk is created. Since the disk cannot be updated, 
set the Audit Preferences needed before you create the disk. If you 
change your preferences, you should create new Standalone 
Auditing Disks. 

To use a standalone auditing disk on Windows or DOS

Once you have created the Standalone Auditing disk, you can use it 
to collect information from nodes which are not connected to the 
network. To use the disk, take the disk to a node you wish to audit.

Note: The standalone auditing disk type needs to match the type of 
node you are auditing. Use a Windows (32-bit) disk for Windows 95, 
Windows 98, Windows ME, Windows NT, Windows 2000, Windows 
XP, and Windows Server 2003 machines; a DOS disk for DOS and 
Windows 3.1; and a NetWare disk for NetWare file servers. 

1 Mount the floppy disk or removable cartridge on the node you 
wish to audit. 

2 Use the Windows 95, Windows 98, Windows ME, Windows NT, 
Windows 2000, Windows XP, or Windows Server 2003 Explorer, 
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or a command-line prompt on any platform to run the 
Standalone Auditing Agent. The file you execute depends on 
which operating system the node is using. The Windows (32-
bit) agent is too large to fit on a single disk. To use it, you must 
first copy the self-extracting file LONE32SE.EXE to the node, 
then open it to extract the agent, then run the agent using the 
command LONEW32.EXE. Use the commands in Table 5 to run 
the Audit Agent. 

3 If the Standalone Auditing information is too large to fit on the 
same disk as the Standalone Auditing Agent, the Agent 
prompts you to switch disks. 

4 Insert the disk you wish to save the information on and press Y 
or Enter to continue with the audit. The Standalone Auditing 
Agent audits the node and stores the information on a disk in 
the same drive the agent was run from. The information from 
the audit is stored in a file named XXXXXXXX.RAW, where 
XXXXXXXX is based on the time the audit takes place in order 
to ensure that the file name is unique. When the audit is 
complete, remove the disk.

To use a standalone auditing disk on NetWare

The NetWare Standalone Auditing Disk is very different from the 
other standalone versions. Because of the way that NetWare NLM 
files interact with the server’s hardware, the NetWare Auditing 
Agent runs in two parts. 

The first part is a version of the DOS Standalone Agent, which runs 
before NetWare starts. You can configure your server to run it 
automatically from the server’s AUTOEXEC.BAT file if you choose. 
This part of the audit analyzes the hardware of the Server. It saves 
the data it collects at the root of the server’s C: drive in a file called 
0000.RAW. 

In addition to the DOS part of the Standalone Auditing Agent, there 
is a NetWare Loadable Module called BVFSAUD.NLM, which is loaded 
manually or when the server itself starts by the server’s 
AUTOEXEC.NCF. 

At manually defined intervals, the BVFSAUD NLM audits the server. 
When the audit starts, it contacts the assigned Audit Server and 
initiates communications. The BVFSAUD NLM searches for a 
0000.RAW file produced by the agent at DOS boot time. If one is 
found, it is copied to the server’s “SYS:” volume. The agent then 
extracts the hardware data from it and sends the data to the Audit 
Server. The BVFSAUD NLM then collects lists of the server's SET 
variables, loaded NLM files, and NetWare volumes, and sends that 
data to the Audit Server. The BVFSAUD NLM then performs a 

Table 5   Standalone Auditing Agents by Platform 

Node Operating System Program to Run

Windows (32-bit) LONEW32SE.EXE, then LONEW32.EXE

DOS LONEDOS.EXE
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complete software inventory of every mounted volume in the 
server, and sends the results to the Audit Server. Finally, the 
BVFSUAD NLM closes the connection with the Audit Server and 
waits until the next audit. 

The audit interval for NetWare servers is set by a schedule in the 
BVFSAUD.INI file in the server's SYS:SYSTEM directory. You must 
manually edit the BVFSAUD.INI file with EDIT.NLM, INSTALL.NLM, 
or some other text-editing utility to change the interval between 
audits. Audits continue on the defined schedule while the BVFSAUD 
NLM is loaded.

To configure a NetWare server to be audited

Before you begin, you must decide whether you want a complete 
hardware audit of the server or a simple software audit. If you do 
not intend to perform a hardware Audit, you only need to install the 
NLM and configure it. Skip to Step 4. 

1 Using DOS, the File Manager, or the Windows Explorer, copy the 
files LONEDOS.EXE, BVAUDIT.INI, and NIINFO.EXE from the 
Standalone Auditing Disk for NetWare to the root of the C:    
drive on the server you wish to audit.

This usually requires bringing the target server down. If you 
have the COPY.NLM or BVCOPY.NLM installed and you have not 
issued a REMOVE DOS or SECURE CONSOLE command on the 
server, you can copy the files to the server’s C: drive while the 
server is still running. 

Consult your NetWare documentation for details. 

2 Edit the target server's C:\AUTOEXEC.BAT to run LONEDOS.EXE 
prior to starting the NetWare operating system. 

3 LONEDOS.EXE runs in the root directory of the C: drive and 
audits the server’s hardware. 

Editing the AUTOEXEC.BAT usually requires the server to be 
down, unless you can still access your C: drive from the 
NetWare system console by running EDIT.NLM or INSTALL.NLM.

4 Modify the server's AUTOEXEC.NCF to LOAD BVFSAUD at any time 
during startup. 

5 If editing the server’s files required bringing it down, start the 
server. 

6 On a machine connected to the server with privileges to access 
the SYS:SYSTEM directory, copy the file BVFSAUD.NLM and 
BVFSAUD.INI from the floppy to the server's SYS:SYSTEM 
directory.

7 Edit the BVFSAUD.INI file on the server and specify the name of 
the NETinventory Audit Server the BVFSAUD NLM should send 
audit data to. The selected Audit Server must be running 
version 6.0 or later of the Audit Server software. Any Audit 
Server, no matter what operating system it is running, can host 
the server’s audits. If the server is itself an Audit Server, it can 
even host its own data. 
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8 Access the target server's system console, and load the NLM by 
typing LOAD BVFSAUD. The BVFSAUD NLM will load and initialize. 
The first audit occurs according to the schedule you set in 
BVFSAUD.INI, at which point the server's software inventory 
will be available. 

After the first audit, the server appears in NETinventory databases 
as a node. The server's hardware information appears once the 
server has been rebooted and the standalone agent runs.

To retrieve DOS and Windows standalone node data

Once the data on a standalone node has been collected, it must be 
merged with the data on your Audit Servers in order to retrieve it as 
part of a query. The data is stored by the Standalone Audit Agent in 
a file with a *.RAW extension, where the first part of the file’s name 
is a serial number assigned during the audit.

1 Open the NETinventory Setup dialog. Click the Standalone 
Auditing Configuration icon. The Standalone Auditing 
Configuration panel appears. 

Fig. 70 Standalone Auditing Configuration Panel
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Configuring Standalone Audits
2 Click the Retrieve Data button and the Select Path panel 
appears. 

Fig. 71 Select Path Panel

3 Type a path where the wizard can find *.RAW files created by 
the Standalone Audit Agent or click Browse and locate the 
files. Click Next. The Choose Nodes panel appears. 

Fig. 72 Choose Nodes Panel

The wizard scans the path you give it for all of the *.RAW files it 
can find and uses the New Node Assignment rules to assign the 
node to an Audit Server (see “Audit Server Assignment Rules” 
on page 151). The nodes and the assigned Audit Servers are 
listed in the dialog. 

4 To manually reassign the Audit Server where a node is 
assigned, select its name (or Shift-click or Control-click to 
select multiple nodes) and click Change Audit Server 
Assignment (or double-click the node) to select a new Audit 
Server. 
98 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Configuring Standalone Audits
5 Click Next. The Process Data Now panel appears. 

Fig. 73 Process Data Now Panel

The NETinventory Audit Server can process the new data and 
include it in its databases immediately or wait until the next 
scheduled merger. To have the data processed immediately, 
select Yes. To wait until the next scheduled merger, select No. 

For more information on configuring how often the Audit Server 
merges data, please see “To change Audit Server tuning 
options” on page 138. 

6 Click Next. The Summary panel appears. 

Fig. 74 Summary Panel

7 The Upload Standalone Audit Node Data - Summary panel 
displays a summary. To make a change, click Back and make 
the change. To proceed, click Next. 

The data collected by the Standalone Audit Agent is uploaded to 
the Audit Server(s). When the upload is complete, the 
NETinventory Setup dialog appears. The data is merged into 
the Audit Server database automatically. 
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Configuring Standalone Audits
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Server Setup Panels
Server Setup 
Panels

The server configuration/setup panels allow you to configure the 
NETinventory Master, Audit, and Login Servers, and the node 
routing information used when nodes are audited for the first time. 
To access these panels open the NETinventory Setup Navigator 
(Fig. 75), and click Server Setup.

Fig. 75 NETinventory Setup Navigator Dialog 

Master Server 
Settings 

The Master Server keeps the Audit and Login Servers on your 
Enterprise Network synchronized. The Master Server periodically 
connects to each Audit and Login Server on the Enterprise Network 
and verifies that they all have their required files and databases, 
and that they are all using the same version of the Audit Server 
software and Audit Agents. 

The Master Server also replicates Audit, Server, and Inventory 
Setup settings to the Audit and Login Servers when needed and 
keeps the Audit Server Routing Tables synchronized. 

Master Server and 
Data Rollup

If you choose to turn on server data rollup, the Master Server hosts 
duplicate copies of some of the information on the Audit Servers. If 
you choose to use data rollup when you set your Reporting 
Configuration, data for some queries will be drawn from the Master 
Server, rather than from the Audit Servers. 

Collecting information from the Master Server speeds query 
processing. To review setting the Reporting Configuration to use 
rolled up data, see “Setting the Reporting Configuration” on page 
49. 

To use data rollup, it must be enabled for the Master Server and for 
the Audit Servers. Please see “To set Master Server tuning options” 
on page 124 for information on turning rollup on, and see “To 
change Audit Server tuning options” on page 138 for information on 
including or excluding Audit Servers. 
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Master Server and NETinventory-RMS Snap-in
Master Server and 
NETinventory-RMS 
Snap-in 

The Master Server also updates the SQL databases used by the 
NETinventory snap-in for the BindView RMS Console. The SQL 
databases are similar to, but separate from, server data rollup. 
When you enable SQL rollup, data is collected from the Audit 
Servers on your network to a SQL database maintained by the 
Master Server. You can then configure NETinventory-RMS to report 
on the data in the SQL database. 

Note: Any tool which can retrieve data from a SQL database can 
retrieve NETinventory data from the SQL rollup database. 

Master Server Roles The Master Server hosts the master copy of the NETinventory 
Routing Table and synchronizes it to every Audit Server in your 
enterprise. The Routing Table on each Audit Server in your 
enterprise should be a replica of every other Routing Table. The 
Master Server continually updates its own Routing Table, then 
updates the Routing Table for each Audit Server. The Routing Table 
determines which Audit Servers accept audit information from 
specific nodes in your enterprise network.

Whenever a node logs in to a Login Server, the Login Server starts 
the correct Audit Agent on the node and instructs the agent to 
connect to the Login Server’s Primary Dispatch Audit Server. The 
dispatch Audit Server uses its Routing Table to route the node to 
the correct Audit Agent. 

If the node has never been audited, the node is assigned to an 
Audit Server based on the Audit Server Assignment Rules. See 
“Audit Server Assignment Rules” on page 151 for information on 
setting these rules.

If the node has been audited, it is routed to the appropriate Audit 
Server (unless Audit Server Audit Restrictions overrule the 
assignment). Audit Restrictions are discussed in greater detail 
under “Audit Server Settings” on page 125.

You can also begin immediate synchronization and set detailed 
performance tuning options in the Master Server Setup panel.
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Master Server SQL Settings
To modify Master Server settings

Open the NETinventory Setup dialog. The Master Server 
Settings panel appears. 

Fig. 76 Master Server Settings Panel

Master Server SQL 
Settings 

The NETinventory Master Server can roll up audit data from Audit 
Servers to a SQL database. The SQL database can be on any 
machine the Master Server can access. 

Data rolled up to the SQL database can be accessed and reported 
on using the NETinventory snap-in for the BindView RMS Console. 
The NETinventory-RMS snap-in allows you to integrate your 
NETinventory data with that provided by the other BindView RMS 
Console snap-ins and to use the querying and reporting tools in the 
BindView RMS Console to process queries. 

When you configure SQL database rollup, you must specify the 
name of the machine hosting the Microsoft SQL Server and the path 
on the machine where the data should be stored. The following 
versions of Microsoft SQL Server are supported for storing data:

• Microsoft SQL Server 7.0 

• Microsoft SQL Server 2000 

• Microsoft SQL Server Desktop Engine (MSDE) 7.0

• Microsoft SQL Server 2000 Desktop Engine (MSDE 2000)

Note: The MSDE 2000 installer is included on the NETinventory 
product installation disc. It is also required to use the BindView RMS 
Console and Information Server, and is included on the BindView 
RMS Console and Information Server installation disc. 
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Master Server SQL Settings
MSDE data storage is suitable for networks with up to 10,000 
nodes. If you have more nodes, you should use Microsoft SQL 
Server to store the NETinventory SQL Database. In addition, if you 
will have more than 4 clients (BindView Information Servers or SQL 
Clients) accessing the NETinventory data, you should use Microsoft 
SQL Server. 

To enable NETinventory SQL database rollup

If the currently selected Master Server already is configured to use 
a SQL database, this option is not available. 

1 Open the Master Server Settings panel and click SQL 
Settings.The NETinventory SQL Database Configuration 
Wizard Welcome Page appears.

Fig. 77NETinventory SQL Database Configuration Wizard
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Master Server SQL Settings
2 Click Next. The Select Operation panel appears. 

Fig. 78 Select Operation Panel

If no SQL Database exists, you can only create a SQL Database 
for the currently selected Master Server. Therefore, the only 
option available is Configure SQL Database for the Master 
Server. 

3 Click Next. The SQL Server and Database panel appears. 

Fig. 79SQL Server and Database Panel

4 Enter the name of the SQL Server the Master Server should roll 
data up to in the SQL Server Name field or choose the 
server’s name from the drop-down list. Click the browse (...) 
button or enter the path to the SQL database in the SQL 
Database Path field. 
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Master Server SQL Settings
Note: If the SQL Server you select is set up to use Windows 
Authentication, it must be in the same domain or in a trusted 
domain of the machine which hosts the BindView Information 
Server you will use to access the information. If there is not a trust 
relationship between the two domains, you must use SQL 
Authentication instead. 

5 Click Next. The Summary panel appears. 

6 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Make sure that 
Perform Complete Database Synchronization is selected 
and click Finish to create the database and roll data up into it. 

An icon will appear in the System Tray on the Windows taskbar 
on the computer you use to enable SQL Rollup. When you 
double-click the icon, a dialog will appear allowing you to view 
the SQL Rollup status. 

Fig. 80 NETinventory SQL Configuration Status Dialog

In the future, new and changed data will be rolled up to the 
SQL server whenever the Master Server synchronizes the 
Enterprise network. 

Once you have audited nodes and a scheduled synchronization 
has taken place (by default, every hour), you will be able to use 
the NETinventory Snap-in for BindView RMS to retrieve 
NETinventory data from the SQL database. 

Note: The initial data rollup to SQL may take up to several hours, 
depending on your network configuration and how much 
NETinventory data has been collected already. 
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Master Server SQL Settings
To modify SQL database configuration

1 Open the Master Server Settings panel and click SQL 
Settings.The NETinventory SQL Database Configuration 
Wizard Welcome page appears.

Fig. 81NETinventory SQL Database Configuration Wizard

2 Click Next. The Select Operation panel appears. 

Fig. 82 Select Operation Panel
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Master Server SQL Settings
3 Choose Modify SQL Database Settings for the Master 
Server. Click Next. The SQL Server and Database panel 
appears with the current settings for the server in the fields. 

Fig. 83 SQL Server and Database Panel

4 Make any changes to the name of the SQL Server the Master 
Server should roll data up to in the SQL Server Name field. 
You can also choose the server’s name from the drop-down list. 

5 Click the browse (...) button or enter the path to the SQL 
database in the SQL Database Path field. 

Note: If the SQL Server you select is set up to use Windows 
Authentication, it must be in the same domain or in a trusted 
domain of the machine which hosts the BindView Information 
Server you will use to access the information. If there is not a trust 
relationship between the two domains, you must use SQL 
Authentication instead. 

6 Click Next. The Summary panel appears. 

7 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Make sure that 
Perform Complete Database Synchronization is selected 
and click Finish to modify the database and roll data up into it. 
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Master Server SQL Settings
To refresh rollup data in the SQL database

1 Open the Master Server Settings panel and click SQL 
Settings.The NETinventory SQL Database Configuration 
Wizard Welcome page appears.

Fig. 84NETinventory SQL Database Configuration Wizard

2 Click Next. The Select Operation panel appears. 

Fig. 85 Select Operation Panel

3 Choose Refresh the Rolled-Up Data in the SQL Database. 
Click Next. The Summary panel appears. 

4 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Click Finish to update 
the roll up data in the database. 
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Master Server SQL Settings
To delete the SQL database

1 Open the Master Server Settings panel and click SQL 
Settings.The NETinventory SQL Database Configuration 
Wizard Welcome page appears.

Fig. 86NETinventory SQL Database Configuration Wizard

2 Click Next. The Select Operation panel appears. 

Fig. 87 Select Operation Panel

3 Choose Delete the SQL Database for the Master Server. 
Click Next. The Summary panel appears. 

4 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Click Finish to disable 
SQL database rollup and delete the existing database. 
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Updating the Master Server
Updating the Master 
Server

When you upgrade the software or databases on the Master Server, 
the Audit and Login Servers on your network are upgraded in turn. 
The NETinventory Update Wizard is used to upgrade the software 
and databases on the Master Server. 

To use the NETinventory Update Wizard 

The Master Server Settings panel allows you to update your 
Master Server software “in place” and to update your Master 
Server’s NETinventory databases periodically. 

1 Open the Master Server Settings panel and click Admin 
Wizard. The NETinventory Update Wizard dialog appears. 

Fig. 88 NETinventory Update Wizard

2 The NETinventory Update Wizard can update the 
enterprise’s servers to a new version of NETinventory server 
software or update the enterprise’s databases. Select which 
task to perform and click Next to continue. 

To update the NETinventory Enterprise

When BindView releases new versions of the software used by 
Master, Audit, and Login servers, the NETinventory Update Wizard 
can update your existing servers to use the new software. 
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Updating the Master Server
1 Open the Master Server Settings panel and click Admin 
Wizard. The NETinventory Update Wizard dialog appears. 

Fig. 89 NETinventory Update Wizard 

2 Select the button labeled Update the NETinventory 
enterprise. Click Next. The Locate the NETinventory 
Update Files panel appears. 

Fig. 90 Locate the NETinventory Update Files Panel

The wizard needs the location of the update files to update your 
enterprise. If you have one, insert the NETinventory Upgrade 
CD. Normally, the files are located in the NI\MASTER directory 
on the CD. 
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Updating the Master Server
3 If you do not have an upgrade CD, click the Browse button to 
locate them. Click Next to continue. The Master Server 
Information panel appears. 

Fig. 91 Master Server Information Panel

4 Type the server’s name in the Server Name field if it is not 
there already. If the server’s TCP/IP Hostname is different from 
its name, type the Hostname or TCP/IP address in the Host 
Name field. If you are not sure of the exact spelling of the 
server’s name or hostname, click Browse to locate it. 

5 Click Next when you are ready to continue. The Review 
Service Credentials? panel appears. 

Fig. 92 Review Service Credentials? Panel 

6 If you do not wish to review the credentials, click No, I do not 
want to review the service credentials and click Next. Skip 
to Step 8 on page 116. 
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Updating the Master Server
To review the credentials, select Yes, I want to review the 
credentials now and click Next. The Service Credentials 
panel appears. 

Fig. 93 Service User Context Panel

7 Select the Security Context to use for the NETinventory 
Database Service. If the Master Server and the SQL Server the 
Master Server uses are on the same machine you should select 
Login as LocalSystem. 

If the Master Server is not on the same machine as the SQL 
Server, you should select Login as specific domain or 
machine user and enter a Username, Password and Domain 
that the BindView Database (BVBT) service should use when it 
runs. The username and password you supply should be a Local 
Admin on the computer hosting the Master Server or a Domain 
Admin in the domain. 
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Updating the Master Server
8 Click Next to continue. The wizard verifies that the server you 
specified is a valid Master Server and the Upgrade Enterprise 
Databases panel appears. 

Fig. 94 Upgrade Enterprise Databases Panel

The wizard can upgrade the databases used by your enterprise 
while upgrading the software, integrating your database 
changes into the latest version of the databases shipped by 
BindView. 

9 Select Yes if you would like to upgrade your databases now; 
Select No if you would prefer not to upgrade your databases.

10 Click Next to continue.

If you chose to upgrade your databases, the Enterprise 
Database Upgrade Options panel appears, as shown in Fig. 
95. If you chose to not upgrade your Enterprise Databases, you 
may skip to Step 11 on page 117 to continue. 

Fig. 95 Enterprise Database Upgrade Options Panel
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Updating the Master Server
The Enterprise Database Upgrade Options panel allows you 
to control how the wizard behaves if it finds new entries in the 
Master Software list distributed by BindView that match ones 
that you have created in the Custom Software list.

11 To keep the record distributed by BindView replacing the one 
you created, select Always overwrite record in target 
database. 

To retain your modified record, select Never overwrite 
record in target database. 

To have the wizard ask you which record to keep for each 
conflict it finds, select Prompt to overwrite record in target 
database. 

Note: In most cases, the new record distributed by BindView will 
contain more complete information and you should use it. 
Information that only you can enter, such as comments, copies 
owned, and so on, is always preserved, even if the rest of the data 
in the record is replaced. 

When you are ready to continue, click Next. The Synchronize 
Master Server panel appears. 

Fig. 96 Synchronize Master Server Panel

The updates the wizard makes will not take effect until your 
entire network has been synchronized. The wizard allows you to 
force the entire network to synchronize as soon as the Master 
Server update is complete. This synchronization can take a 
number of hours, since every server’s software will be updated. 
You can also wait until a later time and synchronize manually. 

12 Select Yes to force immediate synchronization; select No to 
perform the synchronization manually later.
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Updating the Master Server
If you choose to synchronize automatically, you can also 
choose to update all rollup data and upgrade the Login Server 
and Audit Server software separately from the synchronization.

Click Next. The Wizard Summary panel appears. 

Fig. 97 Wizard Summary Panel

13 The Wizard Summary panel describes the choices you have 
made. To change the settings, use the Back button to return to 
the appropriate page and make a change. Click Finish and the 
wizard will update your enterprise. A progress panel appears. 

To Update the Master Server Databases

New versions of the Master Server databases are released routinely 
by BindView. Contact BindView Technical Support or visit the 
BindView Web site at http://www.bindview.com for information on 
obtaining the latest release of the NETinventory Master Server 
Databases. 

The NETinventory Update Wizard allows you to update your 
existing Master Server database files. 
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Updating the Master Server
1 Open the Master Server Settings panel and click Admin 
Wizard. The NETinventory Update Wizard dialog appears. 

Fig. 98 NETinventory Update Wizard

2 Select the Update the databases on a NETinventory 
enterprise button and click Next. The Locate the 
NETinventory Update Files panel appears. 

Fig. 99 Locate the NETinventory Update Files Panel

3 The wizard needs the location of the update files to update your 
enterprise. If you have a NETinventory Upgrade CD, insert it. 
Normally, the files are located in the NI\MASTER directory on 
the CD. 
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Updating the Master Server
4 If you do not have an upgrade CD, click the Browse button to 
locate them. Click Next to continue. The Master Server 
Information panel appears. 

Fig. 100 Master Server Information Panel

5 Type the server’s name in the Server Name field. If the 
server’s TCP/IP Hostname is different from its name, type the 
Hostname or TCP/IP address in the Host Name field. If you are 
not sure of the exact spelling of the server’s name or 
hostname, click Browse to locate it. Click Next to continue. 

6 Enter a Username, Password and Domain that the BVBT service 
should use when it runs. The username and password you 
supply should be a Local Admin on the computer hosting the 
Master Server or a Domain Admin in the domain. 

7 Click Next when you are ready to continue. The wizard verifies 
that the server you specified is a valid Master Server and the 
Enterprise Database Upgrade Options panel appears. 

Fig. 101 Enterprise Database Upgrade Options Panel
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Updating the Master Server
The Enterprise Database Upgrade Options panel allows you 
to control how the wizard behaves if it finds new entries in the 
Master Software list distributed by BindView that match ones 
that you have created in the Custom Software list.

8 Select Always overwrite record in target database to keep 
the record distributed by BindView, replacing the one you 
created

Select Never overwrite record in target database to retain 
your modified record.

Select Prompt to overwrite record in target database to 
have the wizard ask you which record to keep for each conflict 
it finds. 

Note: In most cases, the new record distributed by BindView will 
contain more complete information and you should use it. 
Information that only you can enter, such as comments, copies 
owned, and so on, is always preserved, even if the rest of the data 
in the record is replaced. 

9 Click Next. The Synchronize Master Server panel appears. 

Fig. 102 Synchronize Master Server Panel

The updates the wizard makes will not take effect until your 
entire network has been synchronized. The wizard allows you to 
force the entire network to synchronize as soon as the Master 
Server update is complete. This synchronization can take a 
number of hours, since every server’s software will be updated. 
You can also wait until a later time and synchronize manually. 

10 Select Yes to force immediate synchronization; select No to 
perform the synchronization manually later.

If you choose to synchronize automatically, you can also 
choose to update all rollup data and upgrade the Login Server 
and Audit Server software separately from the synchronization.
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Controlling Synchronization
11 Click Next. The Wizard Summary panel appears. 

Fig. 103 Wizard Summary Panel

12 The Wizard Summary panel describes the choices you have 
made. To change the settings, use the Back button to return to 
the appropriate page and make a change. Click Finish and the 
wizard will update your enterprise. A progress panel appears 
with the status of the update. When the update is complete, the 
wizard will close. 

Controlling 
Synchronization 

You can control how often the Master Server synchronizes the 
settings and routing tables it stores with the copies kept on each 
Audit Server and Login Server. 

To force immediate synchronization

1 Open the Master Server Settings panel. 

2 Click Synchronize Enterprise. 

When you synchronize manually, select Force update of all Login 
Server this synchronization to update all Login Servers 
immediately. Since very little information changes on Login 
Servers, the Master Server normally only synchronizes one of every 
ten Login Servers on each synchronization. After the 
synchronization is complete, NETinventory automatically clears the 
check box.

When you upgrade Audit Agents, changes to Audit Server 
Assignment Rules (see “Audit Server Assignment Rules” on page 
151) or other major changes, you may want to roll your changes 
out to all Login Servers immediately. 

Select Force update of all rollup data this synchronization? to 
force the Master Server to perform a complete synchronization of all 
rolled up data. 
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Controlling Synchronization
Select Force update of Software Tally this synchronization? to 
force the Master Server to count software licenses detected on 
audited nodes. 

To set the synchronization interval 

1 Open the Master Server Settings panel. 

2 Click Sync Settings. The Synchronization Settings dialog 
appears. 

Fig. 104 Synchronization Settings Dialog

Set the interval in increments of Minutes, Hours, Days, or 
Weeks. The minimum Synchronization Interval is 1 hour, the 
maximum is 7 days. 

You can disable automatic synchronization for specified days of 
the week, or for time ranges for each day. You may want to 
suppress synchronization to control the impact of 
synchronization on network resources.

Warning: Even though you can disable synchronization entirely by 
disabling it on every day of the week, you should never do so. 
You must allow the Master Server to perform a synchronization at 
least one time per week. If you do not, the Master Server will not be 
able to update the Audit and Login Server software and databases. 
Query results, especially those using the NETinventory snap-in for 
the BindView RMS Console, will be incorrect. 

Note: BindView strongly recommends that you synchronize daily. 
You should synchronize several times a day whenever possible. You 
should allow synchronization as often as network usage permits.

3 Click OK to close the dialog and save changes or click Cancel 
to close the window without saving changes. 
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Master Server Performance Tuning
Master Server 
Performance Tuning

The Master Server Performance Tuning Options allow you to tune 
the Master Server to your network environment. Normally the 
default options will work for almost every enterprise network. 

To set Master Server tuning options

1 Click Tuning Options. The Master Server Tuning Options 
dialog appears. 

Fig. 105 Master Server Tuning Options Dialog

Caution: While you can make changes to the Master Server 
Performance Tuning Options, the defaults should give the best 
results in most circumstances. Changes from the defaults can 
severely impair the performance of your NETinventory enterprise. 
Generally, you should only make changes to these settings—except 
for rollup—if you have consulted with BindView Technical Support. 

The options in this dialog tune the following Master Server 
performance parameters: 

Automatically Reset BVMASTER.LOG at ... KB
The maximum size of the event log the Master Server keeps. 
The log size is expressed in kilobytes (KB).

Scatter Synchronization of Login Servers?
If Yes is selected, the Master Server will only contact ten 
percent of the Login Servers during each synchronization. 
Normally, this should be set to Yes since relatively few changes 
are made to the Login Servers during each synchronization.

Roll-up System Configurations Data?
If Yes is selected, the Master Server collects Node Data from 
Audit Servers which have Rollup enabled and stores a duplicate 
copy on the Master Server. 

If the data is Rolled up, and the Master Server is the Primary 
Data Path, and the Master Server is set to use Rolled Up data, 
then queries will retrieve some of the Node Data from the 
Master Server rather than the Audit Server where it originated. 

Storing the data on the Master Server can greatly increase the 
speed at which queries are processed, but there is a chance 
that the data may be out-of-date; the Audit Server may have 
newer data than the data rolled up to the Master Server. 
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Audit Server Settings
If you enable data rollup, changed data is rolled up to the 
Master Server during each synchronization. 

Roll-up Hardware/Software Assets Data?
If Yes is selected, the Master Server will collect Inventory Data 
from Audit Servers which have Rollup enabled and store a 
duplicate, consolidated copy on the Master Server in the same 
way that it collects Node Data. 

Audit Server 
Settings

Audit Servers can be hosted by Windows or NetWare servers. The 
Audit Server Settings panel allows you to make changes to Audit 
Servers. You can configure the Audit Servers to use certain network 
communication protocols to either accept or deny audit information 
from certain Login Servers, or from certain network segments, and 
you can tune the performance of Audit Servers. 

You may need to install additional Audit Servers to handle the 
auditing needs of your enterprise network. You should have at least 
one Audit Server set up for each 2000–3000 audited nodes. You can 
break the audited nodes down into smaller divisions by enterprise 
departments or regional organizations. You create and remove 
Audit Servers using the Audit Server Settings panel.

To view Audit Server Settings

1 Open the NETinventory Setup dialog and select the Audit 
Server Settings panel. The Audit Server Settings panel 
appears. 

Fig. 106 Audit Server Settings Panel

2 Select an Audit Server in the Audit Server list. 
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Creating a New Audit Server
The right side of the dialog shows basic information about the 
server, including statistics on the work the Audit Server has 
done since the last time it was loaded, the site it is assigned to, 
the location of the Audit Server databases on the server hosting 
the Audit Server, and whether the current version of the Audit 
Server is loaded. 

3 You can assign an Audit Server to a new Site by selecting its 
name and choosing the site it should be assigned to from the 
Audit Server Site Assignment list of available sites. Refer to 
“Site Configuration” on page 149 for information about Sites.

Creating a New Audit 
Server

NETinventory lets you balance the load on your servers by dividing 
the Audit Server workload among multiple Audit Servers. You can 
create as many Audit Servers as you need. You should have one 
Audit Server to host every 2000-3000 nodes although you can have 
more Audit Servers if you choose. 

To create a new Audit Server

1 Open the Audit Server Settings panel. 

2 Click Create. The Install New Audit Server wizard starts, 
and the New Audit Server panel appears. 

Fig. 107 New Audit Server Panel

3 The New Audit Server Panel allows you to choose between a 
guided process and Expert Mode. If you choose to use Expert 
Mode, the Audit Server Installation Wizard uses a single panel 
to prompt you to enter all of the information needed to create 
your new NETinventory Audit Server. 

If you choose to use Expert Mode, the Audit Server Wizard will 
not validate the information you supply until it tries to create 
the new server. In normal mode, the Wizard performs more 
checks to ensure that your new Audit Server can be set up the 
way you desire on the server you select. 
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To use Expert Mode, select the box labeled Expert Mode in the 
New Audit Server panel. To use normal mode, leave the box 
unselected. 

4 Click Next. The Select Server panel appears. 

Fig. 108 Select Server Panel

Any NetWare 4, 5, or 6 server, or Windows NT 4.0 (with Service 
Pack 6a), Windows 2000, Windows XP, or Windows Server 
2003 machine on your network can be an Audit Server. A 
server that is already hosting a Login Server can also host an 
Audit Server. 

When you choose an Audit Server, keep in mind that it must 
store audit information from nodes for the NETinventory 
Console and the Master Server to retrieve. First-time audits 
require about 150 kilobytes of stored data per audited 
workstation. Over time, audit files may require 1 megabyte or 
more per workstation. 

Dividing the work of storing audit information between Audit 
Servers speeds node auditing and prevents any single Audit 
Server from bearing too much of the auditing load. 

5 Type the name of the machine hosting an Audit Server, or click 
Browse and use the Network browser to locate the machine. 
Click Next to continue. 
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The Admin Account panel appears. 

Fig. 109 Admin Account Panel

6 Enter a valid Login Name and Password combination for the 
server. The Master Server will use the name and password to 
administer the Server. 

If this is a Windows machine, the account must be a Domain 
Admin or a Local Admin on the machine. Enter the user name in 
one of these formats:
Domain\User Name
Machine Name\User Name

If this is a NetWare machine the account must have security 
equivalent to the ADMIN account. You must also choose to use 
a Bindery Login or a Directory Services Login. If using a 
Directory Services Login, you also specify the tree the server is 
a part of. 

You may wish to create a new user for this purpose.

Click Next and the Database Path panel appears. 

Fig. 110 Database Path Panel
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7 You must set the location on the server where the Audit Server 
database files will be stored. Select an existing share or volume 
from the Shares or Volume drop-down list. 

Note: Every user who will report on audit data using the 
NETinventory Console must have access to the share or volume. 
Consider creating a new share or volume specifically for 
NETinventory to use. 

8 Enter a path on the selected share or volume to store the files. 
The default directory is BVEMS. Click Next to proceed. 

On NetWare Audit Servers, the Verify Btrieve Settings panel 
appears, as shown in Fig. 111. For a Windows Audit Server, skip 
to Step 9.

Fig. 111 Verify Btrieve Settings Panel

NETinventory requires the Btrieve NLM on NetWare Audit 
Servers. The setup wizard verifies that version 6.10c or later of 
Btrieve is installed on the selected Audit Server. If an earlier 
version of Btrieve is installed on the selected server, you will 
need to update it to version 6.10c or later to complete the 
NETinventory installation. 

If the correct version of Btrieve is installed, but the Btrieve 
settings are not correct for NETinventory to work properly, the 
setup wizard can automatically update the Btrieve settings. The 
setup wizard will prompt you to change the Btrieve settings if 
necessary. 
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9 Click Next in the Verify Btrieve Settings panel to continue. 
The Select Site panel appears. 

Fig. 112 Select Site Panel

10 Audit Servers can be assigned to a Site. If you have already 
created a site, select it from the drop-down list of available 
sites or click New to create a new Site. The Enter New Site 
Information dialog appears. 

Fig. 113 Enter New Site Information Dialog

11 Type a name for the site in the Site Name field and one line of 
identification information in the Description field. Click OK to 
close the dialog and save your changes. For more information 
about sites, see “Site Configuration” on page 149. 
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12 Click Next to continue. The Reporting Account panel 
appears. 

Fig. 114 Reporting Account Panel

The reporting account is used to connect to an Audit Server 
when a user reports on data stored on that Audit Server. If you 
do not enter a reporting account, users will be prompted to log 
in to the Audit Server if they are not already logged in. If the 
NETinventory Console uses the Reporting Account to connect to 
a server, it disconnects from the server after it has collected 
information from the server. 

The Reporting Account allows users who cannot access the 
NETinventory directory on the server to perform queries. You 
can also use Rollup data or enable SQL storage of data and use 
the NETinventory-RMS snap-in to allow access to the data. 

13 Type a Login name and Password to use for the Audit Server 
Reporting Account 

If this is a Windows machine, enter the user name in one of 
these formats:
Domain\User Name
Machine Name\User Name

If this is a NetWare machine then the account must have 
equivalent security to the ADMIN account. You must also 
choose to use a Bindery Login or a Directory Services 
Login. If using a Directory Services Login, you also specify the 
tree the server is a part of. 
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14 Click Next to continue. The Protocol Selection panel appears. 

Fig. 115 Protocol Selection Panel

This panel sets the communications protocol Audit Agents use 
to communicate with this Audit Server. You also use this panel 
to set the TCP/IP Hostname or Address of the Audit Server. 

On NetWare-based Audit Servers, you can use the IPX or TCP/
IP protocols. On Windows-based Audit Servers, you must use 
TCP/IP. 

15 Select the protocol to use. If the Audit Server will use TCP/IP, 
type its TCP/IP hostname or address in the TCP/IP Hostname 
or Address box.

16 Click Next to proceed. The Automatic Install panel appears. 

Fig. 116 Automatic Install Panel

Copying the NETinventory databases and settings to the Audit 
Server can be a slow process, especially over slow connections. 
The NETinventory Master Server can copy the needed files 
automatically during normal synchronization attempts. This 
greatly speeds up the process of creating multiple Audit 
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Servers. If the Master Server should automatically copy the 
files, select Yes; otherwise select No. 

17 Click Next to continue. The Summary panel appears. 

Fig. 117 Summary Panel

18 If the settings are correct, click Next to install the Audit Server. 
To make a change to the settings, click Back to return to the 
page with the incorrect information and make the change.

The Installing Services panel appears. This panel displays the 
installation progress.

When the installation is finished, the Start Audit Server NLMs 
dialog appears on NetWare servers. 

Fig. 118 Start Audit Server NLMs Dialog

19 On a NetWare Audit Server, you must start the Audit Server 
NLM. To do so, use the NetWare RConsole utility or go to the 
console and type LOAD BVAUDIT and press Enter. The Audit 
Server NLM will load and complete the installation. 
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When the installation is complete, the New Audit Server panel 
reappears.

Fig. 119 New Audit Server Panel

20 Click Finish to complete the installation. 

Removing an Audit 
Server

The Audit Server Settings panel is used to remove a 
NETinventory Audit Server if you need to do so. 

To remove an Audit Server

1 Open the Audit Server Settings panel and select the Audit 
Servers you wish to remove. Click Remove. The Confirm 
Delete Action panel appears. 

Fig. 120 Confirm Delete Action Panel
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2 To delete the Audit Servers, select Yes and click Next. The 
Move or Delete Nodes panel appears. 

Fig. 121 Move or Delete Nodes Panel

3 The audit data stored on the servers can be moved to another 
Audit Server or be deleted. To move the node data to another 
Audit Server, choose Move Nodes. To delete the node data 
choose Delete Nodes. Click Next to proceed. 

Note: If you are deleting your last Audit Server, you will only be 
able to delete stored node data. 

4 If you chose to move the node data, the Select Audit Server 
panel appears. 

Fig. 122 Select Audit Server Panel
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5 Select the Audit Server to receive the data from the drop-down 
list and click Next. The Summary panel appears. 

Fig. 123 Summary Panel

6 Click Next to remove the server, or click Back to make 
changes to the settings. When you click Next, a progress panel 
appears. The node data will be moved or deleted and the Audit 
Server files will be deleted from the server. 

Changing Audit Server 
Protocol Settings 

When you create an Audit Server, you can set the communications 
protocol Audit Agents to communicate with it. If your network 
changes, you can change the protocol used by an Audit Server. 

Note: Audit Servers hosted by Windows machines always use TCP/
IP Connections. 

To change Audit Server protocol settings

1 Open the Audit Server Settings panel and select the Audit 
Server whose protocol you wish to change. Click Protocol 
Settings. The Audit Server Protocol Settings dialog 
appears. 

Fig. 124 Audit Server Protocol Settings Dialog
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2 Select the communications protocol Audit Agents should use to 
communicate with the Audit Server. NetWare servers can use 
IPX-based NCP Extensions only, TCP/IP only, NCP with a TCP/IP 
backup, or TCP/IP with NCP as a backup. Windows machines 
can only use TCP/IP.

If any TCP/IP methods are selected, the Audit Server’s host 
must be configured to use TCP/IP. For information on using 
TCP/IP on NetWare servers, consult your NetWare User Guides. 

If any TCP/IP methods are selected, you must supply the Audit 
Server’s TCP/IP hostname or TCP/IP address. 

3 Click Done to save the changes and close the dialog.

Setting Audit Server 
Restrictions 

You can restrict which nodes an Audit Server audits. Restrictions 
can be based on: 

• The Login Server referring the node
• The node’s IPX or TCP/IP network

To set Audit Server Restrictions

1 Open the Audit Server Settings panel and select the Audit 
Server to configure. Click Restrictions. The Audit Server 
Restrictions dialog appears. 

Fig. 125 Audit Server Restrictions Dialog 

2 Set restrictions for the Audit Server to perform. Select View as 
Accepts or View as Denies to view the restrictions on the 
Audit Server. Select a condition and click Accept or Deny to 
change the way the Audit Server treats the condition. 

3 Click OK to save the changes and close the dialog. 

You can accept or deny audits:

• Originating with individual Login Servers.
• From network segments or network numbers.

Combine these restrictions to control which nodes are audited by 
Audit Servers.
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For example, you could configure an Audit Server to accept audit 
information from nodes in all network segments associated with a 
particular business function. At the same time, you could deny audit 
information from nodes in network segments that are part of 
another business function.

Setting Audit Server 
Tuning Options

It is possible to make changes to some Audit Server behaviors that 
affect performance. The default performance settings for Audit 
Servers are best for most installations. You should only make 
changes to the tuning options with the assistance of the BindView 
Technical Support department. 

To change Audit Server tuning options

1 Open the Audit Server Settings panel and select the Audit 
Server to configure. Click Tuning Options. The Audit Server 
Tuning Options dialog appears. 

Fig. 126 Audit Server Tuning Options

2 Use the dialog to make changes to the tuning options. The 
options and their effects are explained below.

3 Click Done to save the changes and close the dialog.

• General Settings: Include this Audit Server’s node data in 
roll-up?
When selected, the Audit Server's node data will be included in 
data rollups to the Master Server. 
To use rolled up data, you must also turn on rollup in the Master 
Server's Tuning Options dialog (see “Master Server Performance 
Tuning” on page 124). You must also activate rolled up data in the 
Reporting Configuration panel of the NETinventory Console Setup 
pages (see “Setting the Reporting Configuration” on page 49).
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Note: This setting only influences rollup for the Master Server and 
NETinventory Console, not SQL rollup for NETinventory-RMS. 

• Software Recognition: Process pending jobs every
This setting controls how often the Audit Server processes for 
unprocessed software inventory files.
When node software is audited, processing the contents of the 
audit and merging with the existing audit databases can interfere 
with the server if the server is busy. The Audit Server stores the 
audit data file and processes it later. 

• Database Integrity Verification: Verify database integrity 
every
The Audit Server periodically checks its own databases to ensure 
that they do not become corrupt. This setting controls how often 
that verification is performed.

• Walkaround Audits:Process pending audits every
The Audit Server periodically checks for the presence of files 
generated by standalone audits and processes any it finds. This 
setting controls how often the Audit Server should process them.

• Software Recognition Reprocessing:Reprocess Every 
Node’s Recognized Software Now
When selected, the Audit Server discards all Software inventory 
information from all nodes and begins analyzing every node’s 
software inventory information using the current Master and 
Custom Software lists. 

Note: This reprocessing does not require that nodes be reaudited. 
Instead, the Audit Server reanalyzes stored data using the current 
Master and Custom Software lists. 

Login Server 
Settings

You should install Login Server components on every server that 
users log in to. Add or remove Login Servers and configure settings 
using the Login Server Settings panel. 

A Login Server is a host for the NETinventory Audit Agent and an 
associated preference file. Any NetWare server or Windows machine 
on your network can host a Login Server. Every server that users 
log in to should host a Login Server. 

Running the Audit 
Agent when Logging 
In

After installing the Login Server files, you must configure the 
machines hosting Login Servers to run the Audit Agent on nodes 
which log in to the Login Server. 

On NetWare machines, edit each server’s login scripts to execute 
the Audit Agent for the operating system running on that node.

For Windows servers, this configuration depends on how the server 
is configured. If the server has user-based login scripts enabled, 
you can use them. Otherwise, you should set up a system or 
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domain policy that loads the Audit Agent from a generally available 
share such as NETLOGON when users log in to the server. 

Modifying Login 
Server Settings 

Use the Login Server Settings panel to view and configure Login 
Servers. 

To modify Login Server Settings

1 Open the NETinventory Setup dialog and select the Login 
Server Settings icon. The Login Server Settings panel 
appears. 

Fig. 127 Login Server Settings Panel

2 Select a Login Server from the list. The server’s settings appear 
on the right side of the panel. The information includes: 

• The Primary and Alternate Dispatch Servers

• The site the server is assigned to

• The location of the Login Server database files. 

3 To change the Primary and Alternate Dispatch Servers, 
choose a new server from the drop-down lists. The Alternate 
Dispatch Server is optional. 

Note: The Primary and Alternate Dispatch servers must each be 
different Audit Servers. 

4 To change the server’s site, choose a site from the Login 
Server Site Assignment list. See “Site Configuration” on page 
149 for a more detailed discussion of Site Configuration and 
how it is used. 
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5 To save the changes without closing the dialog, click Apply. To 
save the changes and close the Server Setup dialog, click OK. 
To close the dialog without saving the changes, click Cancel. 

Creating a New Login 
Server

Both Windows and NetWare machines can host Login Servers. The 
procedures for creating NetWare and Windows NT Login Servers are 
similar, and both use the Install Login Server wizard. 

To create a new Login Server 

1 Open the Login Server Settings panel and click Create. The 
Install New Login Server wizard starts and the New Login 
Server panel appears. 

Fig. 128 New Login Server Panel

2 The New Login Server Panel allows you to choose between a 
guided process and Expert Mode. If you choose to use Expert 
Mode, the Audit Server Installation Wizard uses a single panel 
to prompt you to enter all of the information needed to create 
your new NETinventory Audit Server. 

If you choose to use Expert Mode, the Login Server Wizard will 
not validate the information you supply until it tries to create 
the new server. In normal mode, the Wizard performs more 
checks to ensure that your new Login Server can be set up the 
way you desire on the server you select. 

To use Expert Mode, select the box labeled Expert Mode in the 
New Login Server panel. To use normal mode, leave the box 
unselected. 
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3 Click Next. The Select Server panel appears. 

Any NetWare 4, 5, or 6 server, or Windows NT 4.0 (with Service 
Pack 6a), Windows 2000, Windows XP , or Windows Server 
2003 machine on your network can be a Login Server. 
Machines hosting an Audit Server can also host a Login Server. 

Every server that users log in to should be a Login Server. 
Login Servers host Audit Agent files, but not any services or 
NLMs. Space requirements for Login Server files do not change 
over time, and the Master Server maintains Login Servers. 
After creating a Login Server, you can ignore it.

Type the name of the machine that will host the Login Server, 
or click Browse and use the Network browser to locate the 
machine. 

4 Click Next to continue. The Admin Account panel appears. 

Fig. 129 Admin Account Panel

5 Enter a valid Login Name and Password combination for the 
server. The credentials will be used by the Master Server to 
administer the Login Server. 
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If this is a Windows machine, enter the user name in one of 
these formats:
Domain\User Name
Machine Name\User Name

If this is a NetWare machine then the account must have 
security equivalent to the ADMIN account. You must also 
choose to use a Bindery Login or a Directory Services 
Login. If using a Directory Services Login, you also specify the 
tree the server is a part of. 

You may wish to create a new user for this purpose.

6 Click Next and the Agent Path panel appears. 

Fig. 130 Agent Path Panel

You must set the location on the server where the Login Server 
database files will be stored. Select an existing share or volume 
from the Shares (on Windows machines) or Volume (on 
NetWare servers) drop-down list. 

7 Enter a path on the selected share or volume to store the files. 
The default directory is BVEMS. Click Next to proceed. 

Every user will need the ability to run the Audit Agent on the 
Login Server. You can set a a share or volume where every user 
has access, or you can have the Audit Agent copied to locations 
all users can access. The NETLOGON share on Windows 
machines and the SYS:PUBLIC directory on NetWare servers 
work well, since all users have read access to them by default. 
If you have changed your server’s settings to prohibit read 
access to the these, you should create another share or volume 
and directory that all users will have read access to. 

If the wizard should copy the Login Server files to the server’s 
NETLOGON share on Windows machines or to the SYS:PUBLIC 
and SYS:SYSTEM directories on NetWare servers, select the 
appropriate boxes. Normally, you should choose to have the 
files copied to these locations.
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8 Click Next to continue. The Select Site panel appears. 

Fig. 131 Select Site Panel

Login Servers can be assigned to a Site. If you have already 
created a site, select it from the drop-down list of available 
sites or click New to create a new Site. The Enter New Site 
Information dialog appears. 

Fig. 132 Enter New Site Information Panel

9 Type a name for the site in the Site Name field and one line of 
identification information in the Description field. Click OK to 
close the dialog and save your changes. For more information 
on using sites, see “Site Configuration” on page 149. 
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10 Click Next to continue. The Dispatch Servers panel appears. 

Fig. 133 Dispatch Servers Panel

When an Audit begins, the Audit Agent contacts an Audit 
Server. The Audit Server sends audit preferences to the Agent 
and “dispatches” the agent to the Audit Server the node is 
assigned to. This Audit Server role is known as a Dispatch 
Server. Any Audit Server can be a Dispatch Server. The 
Dispatch Server should be close to the Login Server on the 
network, with fast communications between the two. 

Choose the Primary Dispatch Audit Server in the Primary 
Dispatch from the drop-down list. You can choose an Alternate 
Dispatch Server for the Audit Agent to contact if the primary 
server is unreachable. 

11 Click Next. The Automatic Install panel appears. 

Fig. 134 Automatic Install Panel

Copying the NETinventory databases and settings to the Audit 
Server can be a slow process, especially over slow connections. 
The NETinventory Master Server can copy the needed files 
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automatically during normal synchronization attempts. This 
greatly speeds up the process of creating multiple Login 
Servers. If the Master Server should automatically copy the 
files, select Yes; otherwise select No. 

12 Click Next to continue. The Summary panel appears. 

Fig. 135 Summary Panel

13 If the settings are correct, click Next to install the Audit Server. 
To make a change to the settings, click Back to return to the 
page with the incorrect information and make the change.

The Installing Login Server panel shows the installation 
progress.

When the installation is complete, the New Login Server 
dialog reappears. 

Fig. 136 New Login Server Panel

14 Click Finish to complete the Login Server Installation.

You must manually configure your new Login Server to 
automatically start the Audit Agent on nodes that log in to it. 
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Audit Agents and 
Windows NT Servers

For a node to be audited, the node must run the Audit Agent, which 
does the actual work of auditing. You must configure your Login 
Servers to run the Audit Agent when users log in. 

If individual user login scripts are enabled in your Windows-hosted 
Login Server’s User Manager, you should add the command 
bvaudit.exe to users’ login scripts. This process is easiest if 
multiple users share login scripts. If each user has a different login 
script, or if login scripts are not enabled, you can use policies to 
start the Audit Agent. 

System or group policies can be used to start the Audit Agent. For 
complete information on using System and Group policies, please 
consult your Windows documentation. 

To use policies, make sure that Active Directory is set up as 
specified in the Windows Server documentation. Then, use the 
System Policy Editor on a Domain Controller (DC) to add the Audit 
Agent’s Universal Naming Convention (UNC) path to the Default 
User’s Startup folder. After this is done, whenever a user logs into 
the domain, the Audit Agent will run. If a user only logs in to the 
local workstation without accessing network resources, the Agent 
will not run. 

Finally, you can add the command to run the Audit Agent to the 
node itself. On a DOS or Windows 3.1 node, add it to the node’s 
AUTOEXEC.BAT file. On a Windows 95, Windows 98, Windows 
Millennium Edition, Windows NT, Windows 2000, Windows XP, or 
Windows Server 2003 node, add the Audit Agent to the Startup 
folder in the Start menu. To prevent the icon from appearing in the 
Start menu, you can use the Windows Policy Editor to add it to the 
Startup group without an icon appearing. 

Audit Agents and 
NetWare Login Scripts

NetWare login scripts are used to run the Audit Agent on nodes 
connecting to NetWare servers. Edit NetWare login scripts on each 
Login Server to include the command #bvaudit.exe. For 
information on setting up and editing Login Scripts on your NetWare 
server, please see your NetWare documentation. 

Note: With some versions of the Novell NetWare client, you must to 
include an explicit reference to the Audit Agent's path in the Login 
Script command. If you chose to add the agent to the SYS:PUBLIC 
directory when creating the Login Server, add the command 
#BVAUDIT.EXE to the login script. 
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Removing a Login 
Server

When you remove a Login Server, you use the Login Server 
Settings panel. 

To remove a Login Server 

1 Open the Login Server Settings panel and select the Login 
Server to remove. Click Remove. The Confirm Delete Action 
dialog appears. 

Fig. 137 Confirm Delete Action Panel

2 To delete the server, select Yes and click Next. To leave the 
server, select No and click Next. 

The Summary panel appears. 

Fig. 138 Summary Panel

3 Click Next to delete the Login Server; click Back to make 
changes. The Deleting Login Server dialog appears, and the 
Login Server will be deleted. 
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Site Configuration A Site organizes a group of Audit and Login Servers. The resulting 
group can then be used when setting the scope of a query. The 
servers which make up a Site should always be linked by fast (LAN-
speed) links, and should normally be in close proximity to one 
another. 

If you have many NETinventory servers at one location, you can 
subdivide the servers into sites based on your organization. For 
example, you might have a different site for each city in which your 
company has satellite offices linked to the main LAN by low-speed 
(WAN) links. The main office might have either a single site or a 
number of sites—one for each group of floors in your building. 

You can associate contact information as well as comments with 
each Site definition.

Whenever you create an Audit or Login server, you are prompted to 
assign it to a site. You can create a new site at the same time. Any 
machine—whether it hosts one or more NETinventory servers—can 
only be associated with a single Site. 

To modify site information

1 Click Site Configuration in the Server Setup dialog. The Site 
Configuration panel appears. 

Fig. 139 Site Configuration Panel

2 Select a Site in the list of available NETinventory sites. 

The information for the selected site appears on the right side 
of the dialog.

3 Modify the site name or description. You can add comments 
about the site in the Comments field. Click Modify Contact 
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Information to make changes to the site information. The 
Site Contact Information dialog appears. 

Fig. 140 Site Contact Information Dialog

4 Make any needed changes to the Site Contact information.

5 Click Done to close the dialog and save the changes.

6 To save the changes you have made to the Site Configuration, 
click Apply (or OK) in the NETinventory Setup dialog.

To create a new site definition

1 In the NETinventory Setup dialog select the Site 
Configuration panel and click Create. The Enter New Site 
Information dialog appears. 

Fig. 141 Enter New Site Information Dialog

2 Type a Site Name and Description. If you choose, click on 
Modify Contact Information to enter contact information for 
a Site. When you do, the Site Contact Information dialog 
appears. Enter the contact information and click Done to save 
the information.

3 Click OK in the Enter New Site Information dialog. The 
Enter New Site Information dialog closes and the new Site 
Definition appears in the list of Sites.
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To remove a site definition 

1 Select a Site in the list of available NETinventory sites. The 
information for the selected site appears on the right side of the 
NETinventory Setup dialog.

2 Click Remove.

3 You are prompted to confirm that you want to delete the site 
information. 

The Site definition is permanently deleted from the displayed 
list of NETinventory sites.

Note: When you delete a site, you only delete the grouping, not the 
servers assigned to the site. 

Audit Server 
Assignment Rules

Audit Server Assignment Rules determine how nodes that have 
never connected to an Audit Server are assigned to an Audit Server. 
for storing audit information. After a node has been routed to an 
audit server according to these rules, the assignment is permanent 
unless you manually move the node to a new Audit Server.

Audit Server Assignment Rules are a three-tier method of assigning 
nodes to the most appropriate Audit Server.

The tiers consist of:

• The IPX network segment or TCP/IP network the node is 
connected to.

• The Login Server the node logged in to.
• A specified Audit Server.

A node can be trapped by the network tier and routed to a specified 
Audit Server, or passed to the Login Server tier. The node can 
either be trapped by the Login Server tier and routed to a specific 
Audit Server, or passed through to the last tier. The last tier serves 
as a “catch–all.” Any node that passes the first two tiers is assigned 
to a specific Audit Server.
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Fig. 142 shows the three-tier assignment system.

Fig. 142 New Node Audit Server Assignment Rules

Modifying Audit 
Server Assignment 
Rules 

The Audit Server Assignment Rules panel is used to define the 
three-tier Audit Server Assignment Rules. Fig. 143 illustrates how 
each tier of the assignment rules is defined. 

Fig. 143 Audit Server Assignment Rules Panel

To help you configure Audit Server Assignment Rules, each portion 
of the Audit Server Assignment Rules panel is defined as 
follows:

New Node

IPX Network Segment

Originating Login Server

All Others Go to
Audit ServerAudit Server X

Originating Login Server

or TCP/IP Network

1st Tier
Assignment Rule

2nd Tier
Assignment Rule

3rd Tier (“catch-all”)
Assignment Rule
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First Tier Assignment 
Rule

The First Tier Assignment Rule is based on network number. To 
change a network's routing, click its name one time, then click 
Modify.

When a node’s assignment is governed by both an IPX network and 
a TCP/IP network rule, the node is routed according to the IPX 
network’s rule. 

Before you can assign rules to networks, you must edit 
NETinventory’s list of those networks. For information on editing the 
network list, see “To edit the TCP/IP network list” on page 154. 

Show All Assignments/Show Active Assignments
NETinventory can display every network known to NETinventory, or 
just the subset of networks which have active routing assignments. 
If Show Active Assignments is selected, networks whose rule is 
set to “skip to next test” will not be displayed.

Edit Network List
Displays the Edit Network List dialog, which allows you to 
manually add and remove IPX and TCP/IP networks in the 
NETinventory list. For information on editing networks, see “To edit 
the TCP/IP network list” on page 154. 

Modify Rule
Displays the Network Number-based Audit Server Assignments 
dialog, which allows you to make changes to the routing rule 
associated with a network.

Second Tier Assignment 
Rule

If a node is on a network that is not governed by the first rule, the 
nodes on the network can be routed to an Audit Server based on 
the Login Server they run the Audit Agent from. Rules are listed by 
Login Server. 

Show All Assignments/ Show Active Assignments
NETinventory can display the Audit Server Assignment rules 
associated with every Login Server or just Login Servers with active 
Audit Server Assignment rules. If “Show Active Assignments” is 
selected, servers whose rule is “skip to next test” will not be 
displayed. 

Modify Rule
Displays the Secondary New Node Audit Server Assignment Rule 
dialog, which allows you to make changes to the New Node Audit 
Server Assignment rules associated with servers.

Third Tier (“Catch-All”) 
Assignment Rule

If a new node is not assigned based on its network or on its Login 
Server, it will be routed to a specified Audit Server. Select a default 
Audit server to use when the other rules do not apply.

Click Apply to save the changes without closing the dialog, or OK 
to save the changes and close the dialog.

Editing the Network List Before you can assign rules to networks, you must list the networks 
you wish to use. You can edit both IPX and TCP/IP networks. 

How TCP/IP Addresses 
are Used

NETinventory uses the TCP/IP address of a valid node on the 
network and the subnet mask you supply together to arrive at the 
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network number. When you enter a valid TCP/IP Address and 
Subnet Mask in the Enter TCP/IP Network dialog, NETinventory 
uses the subnet mask to determine a network number.

Consider a TCP/IP Network Number and Subnet Mask written out in 
binary. For example, the address 10.7.2.10 and the subnet mask 
255.255.0.0:

10.7.2.10 = 00001010.00000111.00000010.00001010

255.255.0.0 = 11111111.11111111.00000000.00000000

In this case, if the values in a node’s TCP/IP address match the 
values in the reference address in the locations where there are 
binary 1’s in the subnet mask, then the node will be considered to 
be on the same network as the reference address. You might 
imagine that the binary 1’s in the subnet mask serve as a “filter” for 
the network number. When you write the node’s address, the 
reference address, and the subnet mask as a binary string, the 
values in the node’s address and the reference address are 
compared only where the subnet mask has binary 1’s in the string. 

Note: NETinventory stores only the number of significant bits of the 
subnet mask, not the entire mask (an 8-bit piece of data instead of 
a 32-bit or 48-bit piece of data). As a consequence, NETinventory 
only supports subnet masks which are formed of contiguous high-
order bits, i.e., all the significant bits are in a block on the left end 
of the address. Subnet masks which are discontiguous are not 
supported.

In this example, any node whose address is of the pattern 10.7.X.Y 
will be on the same network as far as NETinventory is concerned.

To edit the TCP/IP network list

1 Open the Server Setup dialog and select the Audit Server 
Assignment Rules panel. Click the Edit Network List button. 
The Edit Network List dialog appears. 

Fig. 144 Edit Network List Dialog
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2 To create a new TCP/IP network in the list, click New TCP/IP. 
The Enter TCP/IP Network dialog appears. 

Fig. 145 Enter TCP/IP Network Dialog

TCP/IP addresses have both the node’s network number and ID 
on that network in a single value; the Subnet mask allows you 
to determine which part of the address is the network number 
and which refers to the individual node. 

3 Enter a valid TCP/IP Address and Subnet Mask in the fields in 
the Enter TCP/IP Network dialog. 

4 Click OK to close the dialog and save the changes, or click 
Cancel to close the dialog without saving the changes. 

To edit the IPX network list

1 Open the Server Setup dialog and select the Audit Server 
Assignment Rules panel. Click the Edit Network List button. 
The Edit Network List dialog will appear. 

Fig. 146 Edit Network List Dialog
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2 Click New IPX. The New IPX Network dialog appears. 

Fig. 147 New IPX Network Dialog

3 Enter the new IPX network number. 

4 Click OK to close the dialog and save the changes, or click 
Cancel to close the dialog without saving the changes.

To delete an existing network from the list

To delete an existing network, select it in the list and click Delete. 

Account 
Configuration

NETinventory needs credentials to manage Master, Audit and Login 
Servers. The Account Configuration panel allows you to make 
changes to credentials without deleting and reinstalling servers. 

There are two types of accounts you can configure: administrative 
and reporting. You must create an administrative account for each 
NETinventory server. The NETinventory Console and the Master 
Server use the credentials to connect with and maintain Master, 
Audit, and Login Servers. The reporting account, used only on Audit 
Servers, gives access to reporting tools in the NETinventory Console 
without compromising access to the machine hosting the Audit 
Server.
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To configure NETinventory server accounts

1 Click Account Configuration in the Server Setup dialog. The 
Account Configuration panel appears. 

Fig. 148 Account Configuration Panel 

2 Select a server.

The account information for the server appears on the right 
side of the NETinventory Setup dialog.

Note: The appropriate account types are displayed for the selected 
server. Only Audit Servers have both Administrative and Reporting 
Account Information displayed. Login and Master Servers have only 
Administrative Account Information. 

3 Enter the Domain (for Windows machines) Login name, 
Password, and Verify Password information for each type of 
account.

Select Login to NT Domain to log in to the domain on 
Windows machines. For NetWare, select Login to NDS Tree to 
log in to the tree.

4 Click Apply or OK to save the changes. 

Click Remove to remove the server’s information completely. 
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Overview
Overview NETinventory stores a database of hardware and software products 
installed on nodes. The hardware and software may be off-the-shelf 
or custom products. NETinventory includes records for off-the-shelf 
products. You create records for custom products, or new products 
released since you installed NETinventory. Use Inventory Setup to 
create and manage records for custom products.

The Inventory Setup dialog contains the following setup panels:

• Year 2000 Identification
• Master Software 
• Custom Software 
• Unknown Software 
• Category Information 
• Vendor Information 
• Manufacturer Information 
• Hardware Product Information 
• Maintenance Types 
• BIOS Identification 

Each panel is used to manage an aspect of your software and 
hardware inventories.

To open the Inventory Setup dialog 

The Inventory Setup dialog allows you to view and change the 
NETinventory databases. 

1 Choose Options>NETinventory Setup. The NETinventory 
Setup Navigator dialog appears. 

Fig. 149 NETinventory Setup Navigator Dialog
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Year 2000 Identification
2 Click Inventory Setup. The NETinventory Setup dialog 
appears.

Fig. 150 NETinventory Setup Dialog

Year 2000 
Identification

NETinventory includes information from manufacturers on BIOS 
Year 2000 compliance. NETinventory identifies a BIOS using a BIOS 
identification string and the date the BIOS was manufactured. 

If you identified any Year 2000-related BIOS Limitations for BIOSes 
detected in your enterprise you can add them to the database.
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To add a BIOS to the Year 2000 Identification Database

1 Open the NETinventory Inventory Setup dialog. Select the 
Year 2000 Identification item.

Fig. 151 Year 2000 Identification Panel

2 Click New Entry. The New Year 2000 BIOS Entry dialog 
appears. 

Fig. 152 New Year 2000 BIOS Entry Dialog

3 Select a manufacturer from the System BIOS Name drop-
down list.

4 Enter a date range including the date the BIOS chip was 
manufactured.

5 Select the BIOS date-handling capability.

6 Click OK to save the BIOS limitation record. Any BIOS 
produced by that manufacturer during the date range will be 
identified in the BIOS Compliance Information Grid.
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Software Lists
Software Lists NETinventory tracks the software on your network using two 
separate databases. The first of these is the Master Software List. 
The Master Software list contains information about software 
packages and the files that make them up. The Master Software list 
is created by BindView, and new versions are released periodically. 
For information on updating the Master Software list on your Master 
Server to a new version, see “Updating the Master Server” on page 
112. 

Programs you have developed in-house and programs released 
since the most recent Master Software list update are not included 
in the Master Software list. Instead, information about these 
programs is stored in second database, the Custom Software list. 
You control the contents of the Custom Software list, and you define 
“packages” of software that the Audit Agent recognizes.

When software on a node is inventoried, the Audit Agent lists files 
that could be software—generally .EXE and .COM files. The Audit 
Server compares this file list to the files in the Master and Custom 
Software lists.

Files that cannot be positively identified in either list are placed in 
the Unknown Software list, found on the Unknown Software 
panel. You can use the Unknown Software list to build new package 
definitions for the Custom Software list. As you define additional 
custom software packages, fewer files will be listed in the unknown 
software list.

Master Software The Master Software panel lists each off-the-shelf software 
product included in the NETinventory database on your Master 
Server. When you select a product in the Master Software list, you 
can:

• View an item’s details.
• Modify information in the item’s record.

When the Audit Agent scans nodes for software, it uses the entries 
in the Master Software list (and the Custom Software list) to 
determine which software packages are installed on nodes. If the 
files in a package are found on a node, the package is added to the 
node’s Software Inventory database. 
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To open the Master Software panel and view a software 
product’s details

1 Open the NETinventory Inventory Setup dialog and select 
Master Software. The Master Software panel appears. 

Fig. 153 Master Software Panel

2 Select the item whose details you wish to view.

3 The product’s details appear in the Item Details area.

Fig. 154 Master Software Panel
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Some of the record details shown in the Master Software list can 
be modified. You can modify the following data:

• Number of Licenses
• Category
• Year 2000 Status
• Windows 2000 Status
• Comments

The Licenses value lets you store the number of valid licensed 
copies of the product you own. 

The Category value lets you classify and organize software 
products.

The Year 2000 Status and Windows 2000 Status fields contain 
information about Year 2000 and Windows 2000 compatibility from 
the manufacturer. 

The Comments value lets you store product-related notes.

To modify a software product’s details

1 Open Master Software panel and select the product to 
modify. 

2 Make changes to the Licenses, Category, Year 2000 Status, 
Win2000 Status, or Comments. 

Fig. 155 Master Software Panel

3 Click Done to save the changes and close the dialog.

4 Click OK to save the changes and close the dialog or click 
Apply to save the changes and leave the dialog open.
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Custom Software The Custom Software List contains custom or company-specific 
software you add to the list the Audit Agent detects. You have 
complete control over the Custom Software List. You select which 
files make up a package, the package name and category, and 
which files are required for the package and which are optional.

A Custom Software Package consists of a single main file, which 
must always be present for the package to exist. For the 
NETinventory Console, the main file is BVW.EXE. The main file is 
often the file you use to start the program. On DOS machines, this 
is the file name you type to launch the program. On Windows 
machines, the main file is usually the file opened when you select 
the program in the Start Menu. For more information on 
determining which file the icon refers to, see your Windows User’s 
Guide.

In addition to the main file, a package may contain one or more 
ancillary files—files that are part of the package, but which are not 
required for the package to be considered present. Ancillary files 
include utility programs or add-on programs. DLL files usually are 
not considered ancillary files since the default Software Audit does 
not track them. If you alter software auditing to include DLL files, 
you can include them as ancillary files.

You can define files that are required for the presence of a package 
and files that rule out the presence of a package. For example, the 
Audit Agent might find one or two components of an office software 
suite on a node, but the office suite is ruled out unless all the 
components are present. Since there is only a subset of the 
components present, the programs which make up the office suite 
are treated as individual packages.

The Custom Software panel lists each custom software product 
that has been entered to date. Use the Custom Software panel to:

• View and modify custom product details.

• Create a record for new Custom Software.
• Edit the package of files that define a Custom Software list entry.
• Convert unknown software into Custom Software records.
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Custom Software
To open the Custom Software panel and view an 
existing entry

1 Open the NETinventory Inventory Setup dialog and select 
Custom Software. The Custom Software panel appears. 

Fig. 156 Custom Software Panel

2 Select a software package. The package’s details appear in the 
Custom Software Package Information group.

Fig. 157 Custom Software Panel with Package Information
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Custom Software
To change an existing Custom Software entry

1 With the Custom Software panel displayed, Select a software 
package. The package details appear in the Custom Software 
Package Information group.

2 Edit the fields containing the information you want to change. 

3 Click OK to save the changes and close the dialog, or click 
Apply to save the changes and leave the dialog open.

To add a new package

1 Open the Custom Software panel and click New Package.

The New Custom Software Entry dialog appears.

Fig. 158 New Custom Software Entry Dialog

2 Enter appropriate values and click OK to create the new 
package. Mandatory fields are marked with an asterisk (*). All 
others are optional. 

The new Custom Software package appears in the Custom 
Software Package list.
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To add files to a Custom Software package

1 Open the Custom Software panel displayed and select a 
package to add files to. Click Custom Package File List. The 
Custom Software Package Properties dialog appears. 

Fig. 159 Custom Software Package Properties Dialog 

2 If the software package is already installed on an audited node, 
you can select an Unknown Software file that should be the 
package’s Main file by clicking Add from Unknown in the 
Main Package File area of the dialog.
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The Select Software to Identify as Custom Software dialog 
appears. 

Fig. 160 Select Software to Identify as Custom Software 
Dialog

3 Select the file to designate as this package’s main file and click 
OK. 

The name of the file appears in the Custom Software 
Package Properties dialog. 

Fig. 161 Custom Software Package Properties Dialog
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If you know the name, date, and size of a file, you can enter its 
parameters manually. If you add a file’s parameters manually, 
the file name is not case-sensitive. Wildcards are not allowed. 

4 To more precisely define the existence or absence of a software 
package, click Advanced. The Advanced File Settings dialog 
appears, as shown in Fig. 162. 

The Advanced File Settings allow you to specify one or two files 
whose presence is required for the package to exist, or 
conversely, one or two files whose presence rules out the 
existence of the package.

The Advanced File Settings dialog defines the current Include 
and Exclude file settings. The file names the agent searches for 
are not case-sensitive. 

Fig. 162 Advanced File Settings Dialog

5 Click OK to save the changes and close the dialog.

6 You can include one or more ancillary files in the package. For 
each file to include in the custom software package, do one of 
the following:

Click Add from Unknown in the Ancillary File Information 
area, select a file to add and click OK. 

or

Click New in the Ancillary File Information area and enter the 
file’s details manually.

Files included in the package appear in the Ancillary File 
Information file list.

7 If you want to include or exclude an ancillary file from a 
package based on the presence or absence of other files, select 
the file in the ancillary file list and click Advanced.

8 Specify the inclusion or exclusion, and click OK.

9 When the package’s files are defined, click OK to save the 
changes and close the dialog.

Unknown 
Software

The Unknown Software panel lists the found unknown files of the 
types set in the Software Detection panel of the Audit Setup dialog. 
See “Configuring Software Detection” on page 69 for information on 
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configuring software detection. Use the Unknown Software panel 
to: 

• View unknown file details.
• Define unknown files as part of a package and move them into 

the Custom Software List.

To open the Unknown Software panel and view file 
details

1 Open the NETinventory Inventory Setup dialog and select 
Unknown Software. The Unknown Software panel appears. 

Fig. 163 Unknown Software Panel
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2 Select a file from the list. Details related to the file appear in 
the Software Information and Source Node Information 
groups.

3 Unknown Software Panel with File Information

To identify an Unknown Software file as Custom 
Software

1 Open the Unknown Software panel and select one or more 
unknown software files in the File Name list. 
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2 Click Identify as Custom Software. The Unknown Software 
Identification dialog appears. 

Fig. 164 Identify as Custom Software Dialog

3 Enter appropriate values. Mandatory fields are marked with an 
asterisk (*). All others are optional. 

4 If you selected more than one file, select one from the list to 
designate as the package’s main file. The file’s name cannot 
include wildcards. 

You can alter the range of acceptable dates and times and the 
range of acceptable sizes for the file. Any file with the name 
you enter which was created in the range you specify and in the 
size range you specify will qualify as the package’s main file.

5 If you want the presence of the selected file to affect the 
identification of a software package, click Advanced.

The Advanced File Settings dialog defines the current Include 
and Exclude file settings. The file names the agent searches for 
are not case-sensitive. 

Fig. 165 Advanced File Settings Dialog
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6 Click OK to save the changes and close the dialog.

The files in the new Custom Software package are removed 
from the Unknown Software panel’s File Name list and the 
new package is added to the Custom Software Package list. 

A package can contain a number of ancillary files related to the 
package. Use the Custom Software panel’s Custom Package 
Files dialog to add ancillary files to the package. For more 
information, see “To add files to a Custom Software package” 
on page 169.

When a package’s files have been identified, they will be 
removed from the Unknown Software list.

Category 
Information

The Category Information panel lists categories available to 
classify inventory items, including both hardware and software. You 
can:

• View a category’s details.
• Modify an existing category’s details. 
• Add a new category. 

To open the Category Information panel and view 
category details

1 Open the NETinventory Inventory Setup dialog and select 
Category Information. The Category Information panel 
appears. 

Fig. 166 Category Information Panel
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2 Select a category in the list. The category’s details appear in 
the Category Information area of the panel.

Fig. 167 Category Information Panel with Category Selected

To change an existing category entry

1 Open the Category Information panel. Select a category. 

The category’s details appear in the Category Information 
area of the panel.

2 Edit the Category Information. The Category Name and ID 
must each be unique. 

3 Click OK to save the changes and close the dialog or click 
Apply to save the changes and leave the dialog open.

To create a new category

1 Open the Category Information panel and click New Entry.

The New Category Entry dialog appears.

Fig. 168 New Category Entry Dialog

2 Enter the Category Name and ID values and click OK. The 
Category Name and ID must both be unique, and both are 
required.

The new entry appears in the Category List. 
176 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Vendor Information
Vendor 
Information

The Vendor Information panel lists vendors for inventory items, 
including both hardware and software. You can:

• View vendor details.
• Modify existing vendor details. 
• Add a vendor. 

When you install NETinventory, no Vendor definitions are included. 
You define vendors to fit your situation. Vendors can include 
companies you purchase hardware and software from, companies 
that maintain your network and the computers on it, or any other 
vendor type you find useful. 

To open the Vendor Information panel and view vendor 
details

1 Open the NETinventory Inventory Setup dialog and select 
Vendor Information. The Vendor Information panel 
appears. 

Fig. 169 Vendor Information Panel
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Vendor Information
2 Select the desired vendor. Details related to the selected 
vendor appear. 

Fig. 170 Vendor Information Panel with Vendor Selected

To change an existing vendor entry

1 Open the Vendor Information panel and select the desired 
vendor. 

Details related to the selected vendor appear.

2 Edit the Vendor Information fields containing the information 
you want to change. You must enter unique values for the 
Vendor Name and ID; the other fields are optional.

3 Click OK to save the changes and close the dialog or click 
Apply to save the changes and leave the dialog open.
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To add a new vendor

1 Open the Vendor Information panel and click New Entry. 
The New Vendor Entry dialog appears. 

Fig. 171 New Vendor Entry Dialog

2 Enter appropriate values and click OK to save the new vendor. 
The Vendor name and ID must be unique and are mandatory. 
All other fields are optional.

The new entry appears in the Vendor list. 

Manufacturer 
Information 

The Manufacturer Information panel lists manufacturers for 
products in software and hardware inventories. You can:

• View manufacturer details.
• Modify existing manufacturer details.
• Add a manufacturer.

Manufacturer records can be linked to the items in the Master and 
Custom Software lists and to items in the Hardware Products list. 
Manufacturers and inventory items are linked, Manufacturer contact 
information can be included in an inventory report. A suitably 
formatted report can be exported and used in conjunction with a 
word processor’s mail merge capability to contact manufacturers. 
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Manufacturer Information
To open the Manufacturer Information panel and view 
manufacturer information 

1 Open the NETinventory Inventory Setup dialog and select 
Manufacturer Information. The Manufacturer 
Information panel appears. 

Fig. 172 Manufacturer Information Panel 
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Hardware Product Information
2 Select the desired manufacturer. Details related to the 
manufacturer appear.

Fig. 173 Manufacturer Information Panel with Manufacturer 
Selected

To modify an existing manufacturer’s entry

1 Open the Manufacturer Information panel, and select the 
desired manufacturer. Details related to the manufacturer 
appear. 

2 Edit the Manufacturer Information fields. The Manufacturer 
Name and ID you provide must be unique, and are required. 
The other fields are optional.

3 Click OK to close the dialog and save the changes you have 
made, or click Apply to save the changes without closing the 
dialog.

To add a new manufacturer

1 Open the Manufacturer Information panel and click New 
Entry. The New Manufacturer Entry dialog appears. 

2 Enter appropriate values. The Manufacturer Name and ID must 
be unique, and are required. The other fields are optional. 

3 Click OK to save the changes and close the dialog.

The new entry appears in the Manufacturer list. 

Hardware Product 
Information

The Hardware Product Information panel lists information about 
the hardware products in the hardware inventory. You can:
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Hardware Product Information
• View a hardware product’s details.
• Modify a hardware product’s details.
• Add a hardware product.
• Add a model of a hardware product.

To open the Hardware Product Information panel and 
view details 

1 Open the NETinventory Inventory Setup dialog and select 
Hardware Product Information. The Hardware Product 
Information panel appears. 

Fig. 174 Hardware Product Information Panel
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Hardware Product Information
2 Select the desired hardware. Details appear in the Hardware 
Product Information group.

Fig. 175 Hardware Product Information Panel with Product 
Selected

To modify existing Hardware Product Information

1 Open the Hardware Product Information panel and select a 
hardware product. Details related to the selected hardware 
product appear in the Hardware Product Information group. 

2 Edit the Hardware Product Information fields. 

3 Click OK to save the changes and close the dialog, or click 
Apply to save the changes and leave the dialog open.

To add a new hardware product

1 Open the Hardware Product Information panel and click 
New Entry. The New Hardware Product Entry dialog 
appears. 

Fig. 176 New Hardware Product Entry Dialog

2 Enter appropriate values and click OK. The Product name and 
ID you provide are required and must be unique. The other 
fields are optional
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To add a new hardware model

1 Open the Hardware Product Information panel and select a 
Hardware Product.

2 Click Add Model. The New Hardware Model dialog appears. 

Fig. 177 New Hardware Model Dialog

3 Enter a name for the new Hardware model and click Done.

The new entry appears in the selected hardware product’s 
Available Model list.

Maintenance 
Types

The Maintenance Types panel edits maintenance types software 
and hardware inventory. A maintenance type can be assigned to 
each item in your inventory to keep track of warranties and 
maintenance contracts on individual items. Using the Maintenance 
Types panel, you can:

• View maintenance type details.
• Modify an existing maintenance type’s details.
• Add a maintenance type.
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Maintenance Types
To open the Maintenance Types panel and view type 
details

1 Open the NETinventory Inventory Setup dialog and select 
Maintenance Types. The Maintenance Types panel appears. 

Fig. 178 Maintenance Types Panel

2 Select the desired maintenance type. Details appear in the 
Maintenance Type panel.

Fig. 179 Maintenance Types Panel with Type Selected
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To change an existing Maintenance Type entry

1 Open the Maintenance Type panel and select the 
maintenance type. 

Details related to the maintenance type appear. 

2 Click OK to save the changes and close the dialog or click 
Apply to save the changes and leave the dialog open.

To enter a new Maintenance Type

1 Open the Maintenance Type panel and click New Entry. The 
New Maintenance Type Entry dialog appears. 

Fig. 180 New Maintenance Type Entry Dialog

2 Enter the appropriate values and click OK. Both the 
Maintenance Type and ID are mandatory. The ID must be 
unique.

BIOS 
Identification

The BIOS Identification panel contains the database of BIOSes 
the Audit Agent searches for. You can:

• View BIOS details. 
• Modify existing BIOS details.
• Add a BIOS identification string and manufacturer name.

Furthermore, the items in the BIOS Identification list can be linked 
to the Manufacturers in the Manufacturers List. 
186 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



BIOS Identification
To open the BIOS Identification panel and view BIOS 
details

1 Open the NETinventory Inventory Setup dialog and select 
BIOS Identification. The BIOS Identification panel 
appears. 

Fig. 181 BIOS Identification Panel

2 Select the desired BIOS. Details appear in the BIOS 
Information panel.

Fig. 182 BIOS Identification Panel with BIOS Selected
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To modify an existing BIOS identification string 

1 Open the BIOS Identification panel and select a BIOS from 
the list. 

Details related to the selected BIOS Identification String appear 
in the BIOS Information panel.

2 Edit the BIOS Identification fields. The BIOS Ident String is 
the string of characters the Audit Agent searches for in the 
BIOS of each audited node. 

3 Click OK to save the changes and close the dialog or click 
Apply to save the changes and leave the dialog open.

To add a new BIOS Identification string

1 Open the BIOS Identification panel and click New Entry. 
The New BIOS Entry dialog appears. 

Fig. 183 New BIOS Entry Dialog

2 Enter appropriate values and click OK to save the new BIOS 
Identification. The BIOS Ident. String is required, but the 
Manufacturer is optional. If the manufacturer you wish to use is 
not in the list of known manufacturers, you can add the 
manufacturer. See “To add a new manufacturer” on page 181. 
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Overview
Overview The NETinventory Snap-in Module gathers hundreds of pieces of 
information about each node it audits. This information is collected 
by the NETinventory Audit Agent and is stored by the Audit Server. 

The NETinventory Node Manager is used when viewing any grid 
within the NETinventory Console to access all information about any 
single node within your enterprise.

You can open the Node Manager while viewing any NETinventory 
grid. When you open the Node Manager, it displays information 
about a single node. To access the Node Manager, run any 
NETinventory grid, then double-click any field in the grid. 

The Node Manager has a number of individual panels detailing 
many aspects of the node. The Node Manager also allows you to 
maintain node hardware and software inventory data. You also use 
the Node Manager to view the results of file audits and string 
searches performed on nodes.

Opening the Node 
Manager

The Node Manager is accessible when you are viewing a 
NETinventory grid.

To open the Node Manager

1 Run any grid containing NETinventory information.

2 Double-click any field in the grid to open the Node Manager. 

Fig. 184 NETinventory Node Manager

3 The information in the Node Manager is grouped according to 
type. Select an icon in the scrolling area on the left side of the 
Node Manager dialog to determine the category of node 
information displayed. 
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The two buttons at the bottom of the scrolling list of panels 
allow you to scroll through the available nodes in the current 
grid.

Information 
Available Through 
the Node Manager

All NETinventory information about nodes is available using the 
Node Manager. To make the information easy to find and use, the 
information is divided into logical groups on panels in a dialog book. 
The contents of some panels are subdivided into tabbed pages. 
Some panels are organized by the node’s operating system, others 
are grouped according to content. Most of the panels are 
informational, and their contents cannot be changed. The 
NETinventory User Guide only discusses the panels where you can 
make significant changes to the information NETinventory stores. 

The panels in the Node Manager are categorized according to the 
information found on them. In order from top to bottom, the panels 
are:

• Overview
• NETinventory Status
• Operating System
• Logical Drives
• Physical Drives
• Software
• Hardware Assets
• NIC and Modem
• Network Configuration
• NetWare Configuration
• Environment/SET Variables
• Drivers/Services/NLMs

• User Defined Fields
• Alerts
• Tracked Files
• File Download History
• DMI System
• DMI CPU
• DMI BIOS
• DMI Memory
• DMI Chassis
• CPU
• BIOS
• Memory
• PCI and EISA
• Ports (COM & LPT) 
• Sound Card
• Mouse
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• Video
• Audit Detect Flags
• Custom Audit Interval
• NETrc

NETinventory 
Status Panel

The NETinventory Status panel contains information about the 
names NETinventory knows the node by. You can also view 
information about when the node was audited and the Audit Server 
the node is assigned to. 

Moving and Deleting 
Nodes

Normally, Audit Server Assignment Rules(“Audit Server Assignment 
Rules” on page 151), control which Audit Server a node is assigned 
to. The NETinventory Status panel in the Node Manager allows you 
to move an existing node from Audit Server to Audit Server. 

To move a node

1 Open the Node Manager and select the NETinventory Status 
icon. The NETinventory Status panel appears. 

Fig. 185 NETinventory Node Manager - Status Panel

2 The node’s current server is listed in the Audit Server field. To 
move the node to a different Audit Server, click Move. The 
Select New Audit Server dialog appears. 

Fig. 186 Select New Audit Server Dialog
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3 Select the node’s new Audit Server from the drop-down list. 

4 Click OK to move the node and close the dialog.

To delete a node

1 Open the Node Manager and select the NETinventory Status 
icon. The NETinventory Status panel appears. 

Fig. 187 NETinventory Node Manager - Status Panel

2 Click Delete. You will be prompted to confirm the deletion. 

3 Click Yes to delete the node.

Node Comments NETinventory allows you to record general comments about each 
audited node on your enterprise network. Use this area to record 
information that does not fit in any other area.
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To enter general comments for a node

1 Open the Node Manager and select the NETinventory Status 
icon. 

Fig. 188 NETinventory Node Manager - Status Panel

2 Enter any comments about the node in the Comments field.

3 Click OK to close the Node Manager and save the comments. 
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Hardware and 
Software 
Inventory 
Information

The Software panel and Hardware Assets panel help you keep track 
of the hardware and software in your enterprise. The Node Manager 
panels allow you to enter information specific to each node into the 
NETinventory databases. 

Software Asset 
Information

The Software panel lists all identified software packages installed 
on the node’s local drives. You can add asset management 
information about each software application found.

NETinventory can track a great deal of information about each 
software package. Items tracked include:

• Package name
• Manufacturer
• Vendor
• Software category
• Serial number

Some of these fields are assigned automatically when software is 
identified, and can only be edited in the Master and Custom 
Software Lists. See “Master Software” on page 163 and “Custom 
Software” on page 166 for more information. Other fields store 
information about an individual node and can be edited. 

To view software information for a node

1 Open the Node Manager and select Software. The Software 
panel appears. 

Fig. 189 NETinventory Node Manager - Software Panel

2 Select Show Software Recognized by NETinventory to list 
the software packages NETinventory found on the node. 
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3 Select Show Unknown Software to view the software 
NETinventory was unable to categorize on the node.

4 Select Show the Windows ‘Add/Remove Programs’ List to 
view the items listed in the Add/Remove Programs Control 
Panel. 

5 For any item, click File Details for information about the files 
in the package. 

To view software asset details

The brief listing in the Software panel displays the name of the 
package identified, its version, and the number of copies found. 
NETinventory stores additional information about each item, 
including asset information you set. 

1 Open the Software panel.

2 Double-click any software package or select Software package 
and click Asset Details. The Software Maintenance 
Information dialog appears. 

Fig. 190 Software Maintenance Information Dialog

3 Click in any field to edit it. Fields assigned when the product is 
identified cannot be edited and are dimmed. Change these 
items in the Master or Custom Software lists. 
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4 Click the Depreciation button to edit depreciation. The 
Software Asset Depreciation Information dialog appears. 

Fig. 191 Software Asset Depreciation Information Dialog

5 Enter a value for the Amount Depreciated\Month. Only 
whole-dollar amounts can be tracked. 

If the Price is entered in the Software Maintenance 
Information screen, the time since purchase (in months and 
fractions of months) will be multiplied by the Amount 
Depreciated\Month and the result will be subtracted from the 
purchase price to yield the Tracked Balance. 

Click Save to save the changes and close the dialog.

6 NETinventory stores up to 6 User Defined Fields for each 
software asset. These are separate from the general User 
Defined Fields. You can include these UDFs in queries you 
create. 

7 Click the UDFs button.The Software Asset User Defined 
Fields dialog appears. 

Fig. 192 Software Asset User Defined Fields Dialog

8 Click in any of the six User Defined Fields in the User Defined 
Fields screen to edit them. 

9 Click Save to save the changes and close the dialog.

10 Click Done in the Software Maintenance Information dialog 
to save the changes and close the dialog. 

Hardware Assets 
Information

The Hardware Assets panel contains a list of all identified 
hardware components as well as components you may have added 
manually for a particular node.
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Determining what 
constitutes Hardware 
Assets 

The list of items considered to be hardware assets varies greatly 
from organization to organization. Which pieces of hardware are 
classified as individual components, and which are simply parts of 
another component depends on corporate policies. What is 
considered to be a component worth tracking on its own in one 
organization will be considered part of another component in a 
different organization. 

To view and edit Hardware Asset information

Open the Node Manager and select Hardware Assets. The 
Hardware Assets Information panel appears. 

Fig. 193 NETinventory Node Manager - Hardware Assets Panel

The panel lists the hardware components NETinventory tracks for 
the selected node. 

To view hardware asset details

1 The brief listing only displays the type of item tracked and brief 
descriptive information. NETinventory also stores detailed 
information about each item.
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2 Double-click any hardware item or select the hardware item 
and click Edit Item. The Hardware Maintenance 
Information dialog appears. 

Fig. 194 Hardware Maintenance Information Dialog

3 Click in any field to edit it. 

4 Click the Depreciation button to edit depreciation. The 
Hardware Asset Depreciation Information dialog appears. 

Fig. 195 Hardware Asset Depreciation Information Panel

5 Enter a value for the Amount Depreciated\Month. Only 
whole-dollar amounts can be tracked. 

If the Price is entered in the Hardware Maintenance 
Information screen, the time since purchase (in months and 
fractions of months) will be multiplied by the Amount 
Depreciated\Month and the result will be subtracted from the 
purchase price to yield the Tracked Balance. 

6 Click Save to save the changes and close the dialog.

NETinventory stores up to 6 User Defined Fields for each 
hardware asset. These are separate from the general User 
Defined Fields. You can include these UDFs in queries you 
create. 
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7 Click the UDFs button.The Hardware Asset User Defined 
Fields dialog appears. 

Fig. 196 Hardware Asset User Defined Fields Dialog

8 Click in any of the six User Defined Fields to edit them. 

9 Click Save to save the changes and close the dialog.

10 Click Done in the Hardware Maintenance Information 
dialog to save the changes and close the dialog.

To create a new hardware asset

If the Audit Agent does not locate a hardware item associated with 
a particular node (e.g. an Uninterruptible Power Supply) and you 
wish to associate it with a node, you can create a hardware asset 
record for the node. 

1 In the Hardware Assets panel of the Node Manager, click 
New. The Hardware Maintenance Information dialog 
appears, blank. 

Fig. 197 Hardware Maintenance Information Dialog
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2 Enter the information for the hardware asset you wish to add. 
The Product Name is mandatory. All other fields are optional. 
You can also add Depreciation and UDF information. 

3 Click Done in the Hardware Maintenance Information 
dialog to save the changes and close the dialog.

To delete an item from the hardware assets database 

1 Select the item’s name in the Hardware Assets panel.

2 Click Delete Item.

NETinventory will ask you to confirm that you want the item 
deleted. If you click Yes, the item will be deleted.

Managing Node 
Alerts

The Node Manager’s Alerts panel collects and manages all alerts 
relevant to a node. 

During an audit, the NETinventory Audit Agent generates alerts 
when specified conditions are met. The conditions are defined using 
the Auditing Setup dialog. See Chapter 4, “Alerts,” on page 66 for 
more information about creating alerts.

Every alert is associated with a specific node. Each alert contains a 
message describing the alert condition, the alert’s date and time, 
and the acknowledgment associated with the alert. This data 
appears as rows on the Alerts panel.

You use the Node Manager to acknowledge alerts, delete alerts, and 
view alert details. 

Acknowledging an alert marks it so that it can be filtered from 
queries. 

Alerts appear in the Node Manager’s Node Alert Information 
panel until you delete them. 

Alert details in the Alert Detail dialog that appear when you view 
an alert describe the node, the condition that triggered the alert, 
the alert level, and the acknowledgment status.
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To view node alerts

1 Open the Node Manager and select Alerts. The Alerts panel 
appears if the node has one or more alerts associated with it. 

Fig. 198 NETinventory Node Manager - Alerts Panel

2 If a node has alerts associated with it, you can view the details 
of any alert. Double-click any alert. The Alert Details dialog 
appears. 

3 Click Close Without Acknowledging or Acknowledge and 
Close to close the dialog.

To acknowledge an alert

1 Open the Alerts panel and select the alert to acknowledge.

2 Click Acknowledge or Acknowledge All. 
202 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Managing Node Alerts
Acknowledged alerts are displayed with “Ack” in the Ack 
(Acknowledged) column. 

Fig. 199 NETinventory Node Manager - Alerts Panel

To delete an alert 

Once an alert is generated, it remains until deleted. Acknowledged 
alerts can be deleted.

To delete an alert associated with the current node:

1 Open the Alerts panel and select the alert to delete.

2 Click Delete or Delete All. 
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Managing Tracked 
Files

When the Audit Agent performs a file audit on a workstation, it can 
automatically store a compressed copy of audited files on the Audit 
Server. For information on configuring file auditing, see “Configuring 
Tracked Files” on page 72. Each type of file you track is called a File 
Audit. Once a file has been set for auditing, the NETinventory Audit 
Agent will monitor all versions of that file found on audited nodes.

When a file is stored on the Audit Server in this way, you can view 
and edit the file, receive alerts when it changes, and keep a revision 
history of the file. 

You use the Tracked Files panel in the Node Manager to:

• View a listing of each copy of each tracked file. 
• View and edit the contents of tracked files.
• Download edited or original copies of tracked files back to the 

original workstation and optionally force the node to reboot when 
the download is complete.

To view tracked file information

1 Open the Node Manager dialog and select Tracked Files. The 
Tracked Files panel appears.

Fig. 200 NETinventory Node Manager - Tracked Files Panel

The Tracked Files panel lists each tracked file type in a 
drop-down list at the top of the panel. The sections below list 
the individual files that were located and each located file’s 
revisions. 

2 Select the type of tracked files to view from the drop-down list 
at the top of the panel, then select an individual tracked file of 
that type to see the revisions of the individual file.

Each tracked file type represents a single file audit. Each file audit 
may be configured to track a single file (i.e., AUTOEXEC.BAT), or a 
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range of files by using wildcards (i.e., *.BAT or *.INI). For more 
information on configuring file audits, see “Configuring Tracked 
Files” on page 72.

Viewing the Contents 
of a Tracked File

If a file audit retrieves the contents of the files it tracks, you can 
view the contents of any given revision of the file. If the file audit 
was not configured to retrieve the file’s contents, you only view 
basic information about the file, such as its size, the date and time 
it was last modified, and its path. 

To view or edit the contents of a tracked file

1 Select the tracked file type you wish to view from the Tracked 
File Audits Applicable to This Node drop-down list. 

2 If more than one file is tracked by the audit, select the 
appropriate instance. A list of revisions appears in the Tracked 
File Retrieved History field.

The dates shown in the Tracked File Retrieved History field 
are the dates the Audit Agent found a new version of the file. 
There is a separate listing for each revision, with the most 
current revision listed last (at the end of the list). 

3 Select the individual revision of the file you want to view and 
double-click it or click Edit for Download. If the file’s contents 
are stored on the Audit Server, the file editing dialog appears. 

Fig. 201 File Editing Dialog

4 Make any changes you wish to the file. 

5 Click Save As to save the file or Download Back to Node to 
send it to the node. Click Cancel or press ESC to close the 
editing window.
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To download a tracked file to a node

After viewing or editing a tracked file, you can download the 
changed file to the workstation it was retrieved from. You can also 
select any revision of a tracked file and schedule it for download to 
the node where it originated. 

1 When viewing a tracked file, click Download Back to Node. 
You can also click Schedule for Download in the Tracked 
Files panel without editing the file. The File Download 
Configuration dialog appears. 

Fig. 202 File Configuration Dialog

2 Configure the download and click OK to save the settings and 
schedule the file to be downloaded to the node. For information 
on each setting, see Table 6, “File Download Configuration 
Options” .

The file download is now pending. The next time the node is 
audited, the Audit Agent will download the file according to the 
preferences you have set.

The download job is added to the File Download History panel 
with a status of “Pending.” To alter or delete the download job 
before it downloads, use the File Download History panel in the 
Node Manager. For information on the File Download History 
panel, please see “Using the File Download History” on page 209. 

Table 6  File Download Configuration Options 

Message Description

Message to User Edit or delete the message that appears on the 
node when a file download is pending. The message 
always appears, even if the user is not allowed to 
refuse the download, unless the message is blank.

Target File <Path> Specifies the file name and the path where the file 
will be placed. The default for this option is the 
original location on the workstation.
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Backup file to 
<Path>

Specifies the name and path on the node where the 
Audit Agent should back up the file being replaced. 
This option allows restoring the original 
configuration file if there is a problem with the 
download.

Download on or 
after

Enables you to specify a future time and date for 
the download to take place. The download will 
occur at the first audit following the specified date. 
The default date for download is the day when the 
download is created, meaning the file will be 
downloaded during the next audit. Download on 
or after is useful if changes need to be made but 
should not take effect until a later date.

User can postpone 
this download

Specifies if the user of node can delay the download 
of file. If User can postpone download is 
selected, the user node will be prompted during 
every audit to download the file until they accept it, 
or the Number of postpones are exhausted. 
If User can postpone download is unselected, 
the download will happen when the node is next 
audited.

Number of 
postpones allowed

Sets the number of times a user may refuse the 
download of a new file. Once the number of grace 
logins reaches zero, the file will either be 
automatically downloaded during the next login or 
the download will be canceled (depending on the 
action specified in the User Can Refuse 
Download option). If the user should not be 
allowed to refuse the file for even a few logins, the 
grace login count may be set to zero. To download 
the file without notifying the user that it is even 
occurring, be sure to also clear the Message to 
User field.

Keep attributes of 
existing target 
file?

Enables you to specify whether the downloaded file 
should have a specific set of file attributes, or if it 
should take on the file attributes of the file being 
replaced. When selected, the downloaded file will 
be set to the same attributes as the file being 
replaced on the workstation. When unselected, the 
file will be downloaded with the file attributes listed 
in the New File Attributes area (see the next field 
definition).

New File 
Attributes

Enables you to specify the attributes that the 
downloaded file will have on the user’s node. These 
attributes are assigned only if Keep attributes of 
existing target file is unselected (see previous 
field definition). To change the attributes for the 
downloaded file, select or unselect the appropriate 
attributes.

Table 6  File Download Configuration Options  (Continued)

Message Description
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Download even if 
target file has 
been modified?

 Download even if target file has been 
modified allows you to specify if the download 
should proceed if the file being replaced is more 
recent than the most recent revision of the tracked 
file in the NETinventory database. 

This will occur if that file was edited between the 
time of the last audit and the current download. 
Selecting this box ensures that the download will 
proceed anyway. 

When the box is unselected, the download will not 
proceed if the file has been modified. You can then 
review the changes made before deciding whether 
to proceed with the download.

Make target 
directory if it 
doesn’t already 
exist?

When selected, the Audit Agent will create the 
specified directory and then download the file to it. 
If the box is unselected, the download will not take 
place if the target directory does not exist.

Download even if 
a backup cannot 
be made? 

This box enables you to specify whether the 
download should proceed even if the file being 
replaced cannot be backed up. When the box is 
unselected, the download will not proceed if the file 
being replaced cannot be backed up (to the 
directory and file name specified in the Backup file 
to field) for any reason. Selecting this box ensures 
that the download will proceed regardless of the 
ability of the Audit Agent to back up the file being 
replaced.

No reboot after 
downloading/
Cold-boot/
Shutdown after 
downloading/
Warm-boot/
Restart after 
downloading

Specifies whether the node should be automatically 
rebooted immediately following the download of the 
file. 
This option is useful for downloading new versions 
of files such as CONFIG.SYS which will not take 
effect until the system is rebooted. 
You can force a reboot by choosing either the Cold 
or Warm reboot options. When you do so, the next 
time a user logs in from that workstation, the 
workstation will be audited, the file downloaded, 
the station logged out, and then rebooted. Please 
see “To configure software and hardware prompts” 
on page 85 for more information about reboot 
options.

Reboot warning Specifies a message the Audit Agent should display 
immediately before rebooting the machine. This 
allows you to notify the user that the node must be 
rebooted in order to complete the download or for 
the change to take effect.

Table 6  File Download Configuration Options  (Continued)

Message Description
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Using the File 
Download History

The File Download History Information panel lets you track all 
file downloads performed through the Tracked Files panel. The File 
Download History is a database of all file downloads to a selected 
node. 

To view the File Download History

Select File Download History panel in the Node Manager. The 
File Download History Information panel appears. 

Fig. 203 File Download History Information Panel

Any time a configuration file is edited and scheduled for download 
through the Tracked Files panel, a record of that action is placed 
in the File Download History log and marked Pending. As soon 
as the new file is successfully downloaded or rejected, the status of 
that record is updated to reflect the outcome of the download. 

To cancel a pending download

A download may be canceled by selecting a download with status 
Pending and clicking Delete. 

To change download options for a pending download

1 Open the Node Manager and select File Download History. 
The File Download History Information panel appears.
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2 Select any pending file download and click Download 
Information. The same File Download Configuration dialog 
used by the File Management panel appears. 

Fig. 204 File Download Information Dialog

To view download errors

If a download had any errors, you may view the error messages 
relating to the download failure by selecting the download record 
and clicking Display Errors.

To repeat a download 

It is also possible to re-queue a previously downloaded file to be 
downloaded again to the PC. To do this, select the desired file 
download, and click Make Pending. This creates a copy of the 
previous download and sets it for downloading with the same 
parameters as the last time it was downloaded. The new download 
appears on the File Download History list with a status of Pending.

Customizing 
Audits for Nodes

Use the Audit Setup dialog, described in Chapter 4 on page 59, to 
control the kinds of information that the NETinventory Audit Agent 
collects from all nodes on your network. When finer control is 
necessary, you can use the Node Manager to configure custom 
audit intervals and specific tests the Audit Agent performs for 
individual nodes. 

Controlling the Tests 
the Audit Agent 
Performs

Audit Setup controls which tests the Audit Agent performs on every 
node. The Node Manager can control the tests on a node-by-node 
basis. A particular test might cause a crash or other difficulty on a 
given node, or you might choose to omit the test for a particular 
node. The Audit Detect Flags panel in the Node Manager can enable 
or disable tests on individual nodes.
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To select which tests the audit agent performs on a 
node 

1 Open the Node Manager dialog and select Audit Detect 
Flags. The Audit Detect Flags panel appears. 

Fig. 205 Audit Detect Flags Panel

2 The tests are grouped according to type. Select the tab for the 
type of test you wish to perform, then select an individual test 
from the list.

3 The option set indicates the status of the test on the node. You 
can make changes to the status by selecting a new status. 
When you change to a different panel or click OK, NETinventory 
will save the changes you made. Refer to Table 7, “Audit Detect 
Flag Options” .

Table 7  Audit Detect Flag Options 

Option Effect

Normal detection When Normal detection is selected, 
the selected test will be performed 
normally.

Disabled automatically If a problem occurs while NETinventory 
is performing an audit, the Disabled 
automatically option is set. While this 
option is set, the NETinventory Audit 
Agent will not perform the selected test 
on the node.
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Setting a Custom 
Audit Interval

Most nodes are audited at the same interval. For certain nodes, a 
custom audit interval is required. The Node Manager allows you to 
set a custom interval for both the hardware and software portions 
of an audit.

To set a custom audit interval

1 Open the Node Manager and select Custom Audit Interval. 
The Custom Audit Interval Information panel appears. 

Fig. 206 Custom Audit Interval Information Panel – No 
Custom Interval

2 If the node already has a Custom Audit Interval, it appears in 
the panel. If the node does not have a Custom Audit Interval 

Try test again If NETinventory sets the test option to 
Disabled Automatically, but you 
believe the test should work properly, 
you can set the flag to Try test again 
to force the test to be performed. If the 
test fails again, NETinventory will not 
change the setting.

Skip this test When selected, NETinventory will not 
attempt the selected test on the 
current node.

Table 7  Audit Detect Flag Options  (Continued)

Option Effect
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defined, click Create One. The Custom Audit Interval 
Information panel appears. 

Fig. 207 Custom Audit Interval Information Panel – With 
Custom Interval

3 Select the units to use for the System Configuration Detection 
and Software Recognition intervals and enter the number of 
those units each audit should wait between audits.

4 Click OK to close the Node Manager and save the changes you 
made, or click Cancel to close and discard your changes.
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To remove a custom audit interval

1 Open the Node Manager and select Custom Audit Interval. 
The Custom Audit Interval Information panel appears. 

Fig. 208 Custom Audit Interval Information Panel – Removing 
Custom Interval

2 Click Remove Custom Audit Interval. NETinventory discards 
the custom audit interval and the Custom Audit Interval 
Information panel appears. 

Fig. 209 Custom Audit Interval Information Panel– Custom 
Interval Removed

3 Click OK to close the Node Manager and save the changes you 
made, or click Cancel to close the dialog and discard your 
changes.
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Taking Control 
with NETrc

To take control of a node with the NETrc Host software installed, 
you can use the NETinventory Node Manager. In order to take 
control of a node, NETrc must be installed, as well as licenses for 
each node you wish to remotely control. You must also assign a 
profile to the node which installs the NETrc Host software. For more 
information on installing, configuring, and using NETrc, please see 
the NETrc User Guide. 

To take control with the Node Manager

1 Open the Node Manager, and select NETrc. The NETrc panel 
appears. 

Fig. 210 NETinventory Node Manager - NETrc Panel

2 Click Take Control. The NETrc Master runs.

If the user of the node must be prompted for permission, or if 
the person taking control must enter a password to control the 
node, a password prompt appears on the host. 

The screen of the node under control appears. 

3 When you are finished controlling the node, click the NETrc 
Master’s close box or double-click the System menu to close 
NETrc Master and disconnect from the node. 

Assigning a Profile to 
a Node

The NETrc panel in the Node Manager also indicates the NETrc 
status of the node, including the profile the node is currently using, 
the last date the profile was installed or refreshed by the Audit 
Agent, and the installation status of the profile on the node. 

1 To assign a specific profile to the node, select Use Node 
Specific Profile. 

2 Choose a profile to assign from the list of available profiles. 
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3 Click OK to close the window and save the changes you have 
made, or click Cancel to close the window without saving the 
changes. 

The Audit Agent updates the profile on the node the next time the 
node is audited. 

Removing NETrc Host 
Software from a Node

You can use profiles to remove the NETrc Host software from a node 
you select. When you select the profile named None (Uninstall), 
the NETinventory Audit Agent removes the NETrc Host software and 
preferences from nodes. 

1 In the NETrc panel of the Node Manager, select Use Node 
Specific Profile. 

2 Select the profile named None (Uninstall). 

3 Click OK to close the window and save the changes you have 
made. 

The NETinventory Audit Agent uninstalls the NETrc Host software 
from the node the next time the node is audited. 

Using the 
NETinventory Node 
Viewer

NETinventory also includes a separate utility, the NETinventory 
Node Viewer that allows you to take control of a node without 
starting the NETinventory Console. You can copy this utility to any 
machine on your network and use it to take control of nodes with 
NETrc installed. To use the NETinventory Node Viewer, you must 
enable NETinventory SQL Rollup. For more information, please see 
“Master Server SQL Settings” on page 104. 

To take control of a node using the NETinventory Node 
Viewer

1 The NETinventory Node Viewer utility is separate from the 
NETinventory Console. Open the \NI\Utility folder in the folder 
where the NETinventory Console is installed (normally 
C:\BindView), and double-click the NINodeViewer.exe file. The 
NETinventory Node Viewer appears. 

Fig. 211 NETinventory Node Viewer Dialog

2 Enter the name of your Master Server in the Master Server 
field. 
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3 Click Connect. The Node Viewer connects to the Master Server 
and lists all audited nodes in the Master Server database in the 
Node Name field. 

Fig. 212 NETinventory Node Viewer with Nodes listed

4 The Node Name drop-down list displays all nodes in the 
Master Server’s database. If you wish to restrict the nodes 
displayed, click Advanced. The Advance Settings dialog 
appears. 

Fig. 213 Advance Settings Dialog

5 Enter a partial name to use as a filter in the Node Filter field. 
You can use the * wildcard in this field. Select a default network 
protocol to use to connect to the node using from the Protocol 
field. Click OK to close the dialog and filter on the conditions 
you’ve set. The NETinventory Node Viewer dialog reappears. 
Only nodes that match the conditions you set in the Advance 
Settings dialog appear in the Node Name drop-down list. 

6 Select a node name from the Node Name drop-down list. To 
view information about the node, click View Node Details. 
The Node Details dialog appears. 

Fig. 214 Node Details Dialog
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7 When you are finished viewing the node’s details, click Close. 
The NETinventory Node Viewer dialog reappears. 

8 To take control of a node using NETrc, click Take Control of 
Node in either the Node Details or the NETinventory Node 
Viewer dialog. The NETrc Viewer will appear and allow you to 
take control of the node. 

9 When you are finished controlling the node, close NETrc and 
take control of another node or click the Close button in the 
NETinventory Node Viewer to close it. 

10 When you close the NETinventory Node Viewer, you will be 
prompted to save the current settings. If you click Yes, the 
same settings will be applied the next time you start the 
NETinventory Node Viewer. 

If you wish, you can also connect to a node using NETinventory 
Node Manager from the command line. The name of the program to 
run is NINodeViewer.EXE. The command-line options are listed in 
Table 8, “NINodeViewer.EXE Options”  and in the NINodeViewer.EXE 
help. 

Table 8  NINodeViewer.EXE Options 

Option Notes

/M<Master Server> Start the NINodeViewer and connect to the 
specified Master Server. 

/N<NodeName> The Node that should be selected by default when 
when the NINodeViewer utility starts. 

/P<Protocol> The protocol to be used. Can be either IP or IPX.

/C<Name or IP> Take control of a computer using NETrc without 
launching NINodeViewer utility. You can specify 
the Windows machine name or the IP address of 
the node. The NETrc Host must be installed on the 
node, and the NETrc Viewer must be installed on 
the machine running the NINodeViewer utility. 

/F<Filter String> Start the NINodeViewer using this value as a filter 
for node names. If you specify /F along with the /N 
option then the /F option will be ignored.

/X<Password> The password to use when connecting to a node. 

/? Start the NINodeViewer and display the help. 
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Using the NETinventory Service Manager Control Panel
Using the 
NETinventory 
Service Manager 
Control Panel

The NETinventory Service Manager is a Windows Control Panel. To 
open it, open the Windows Control Panel folder and double-click the 
NETinventory Service Manager icon. The NETinventory Service 
Manager dialog appears. If you have the Master Server service 
installed on the server, the Master Server tab appears (Fig. 215). If 
you have the Audit Server services installed but not the Master 
Server services, the Audit Server tab appears (). 

Fig. 215 Master Server Tab

The Master Server Tab The top portion of the Master Server tab contains information about 
the current status of the Master Server. The Synchronization area 
allows you to manually control synchronization of the enterprise. 

To force an immediate synchronization

Click the Synchronize Enterprise button. The Master Server 
immediately begins synchronizing the enterprise, using the 
preferences you have set.

Normally only 10% of the Login Servers on the network are 
synchronized during a given synchronization. When you select 
Force update of all Login Servers this synchronization and 
click Synchronize Enterprise, all Login Servers will be updated 
during the synchronization.

Normally only some of the rolled up databases are updated during 
each synchronization. When you select Force update of all rollup 
data this synchronization and click Synchronize Enterprise, all 
rolled up databases will be updated.

Select Force update of Software Tally this synchronization? to 
force the Master Server to count software licenses detected on 
audited nodes. 
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To stop or start the service

When you click the Stop Service or Start Service button, the 
Service Manager will attempt to stop or start the Master Server 
Service immediately and report its progress. The button changes 
name depending on whether or not the service is currently running. 

To change advanced server settings

Click the Advanced button and the Master Server Advanced 
Settings Dialog appears. 

Fig. 216 Master Server Advanced Settings Dialog

The items in the Advanced Settings dialog configure how the 
Master Server behaves. You should only change the items in this 
dialog when instructed to do so by BindView technical support. For 
more information on these settings consult the available Help or 
BindView Technical Support. 

Caution: Changes to these settings have the capability of slowing 
the Master Server considerably. Use extreme caution if you make 
changes to these settings. 
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The Audit Server Tab The Audit Server tab allows you to see the current status of the 
Audit Server installed on the machine and to force the Audit Server 
to perform some operations immediately. 

Fig. 217 Audit Server Tab

The top of the tab includes information about the status of the Audit 
Server. The lower portion of the tab allows you to control the Audit 
Server. 

To force immediate processing

You can force the Audit Server to immediately process any 
accumulated Software Inventory data or Standalone Audit data, or 
to verify its databases by clicking the corresponding button in the 
lower portion of the Audit Server tab. You can also force the Service 
Manager to reset the Audit Server statistics in the top part of the 
tab by clicking the Reset Audit Statistics button. 

The Database Engine 
Tab

The Master and Audit Servers both rely on a separate database 
engine to store information collected from nodes, preferences, and 
so on. The Database Engine tab allows you to control some 
aspects of the database engine’s performance. With the exception 
of the User Name and password you can change by clicking the 
Configure Service button, You should only make changes to these 
settings when directed by BindView Technical Support. For more 
information on the items in the tab, consult the available help or 
BindView Technical Support.
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Caution: Changes to these settings have the capability of slowing 
the Master or Audit Server considerably. Use extreme caution if you 
make changes to these settings. 

Fig. 218 Database Engine Tab

To change the database engine service context

1 Open the NETinventory Control Panel and select the Database 
Engine tab. 

2 Click Configure Service. The Database Engine 
Configuration dialog appears.  

Fig. 219 Database Engine Configuration Dialog
8: NETinventory Control Panel 223

© 2004 BindView Corporation. All Rights Reserved



TCP/IP Ports
3 Choose Login as LocalSystem or Login as specific domain 
or machine user. If you choose to login as a specific user, 
make any needed changes to the User Name and Password. 
Any user name must be in the format Domain\User Name or 
Machine Name\User Name. If you change the password, you 
must confirm it in the Confirm Password field. Click OK to 
close the dialog and save the changes you have made. 

TCP/IP Ports On Windows Servers, the Master and Audit Servers use TCP/IP to 
communicate. The ports used are:

• Audit Server service: port 22850
• Master Server service: port 23850
• Database Engine service: port 21850
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Section 2: NETinventory-RMS
Using NETinventory with the BindView RMS Console
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Overview
Overview The NETinventory® Snap-in for the BindView RMS® system allows 
you to use the BindView RMS Console to retrieve and display 
information collected by NETinventory. The BindView RMS Console 
includes data analysis features that are not included in the 
NETinventory Console. 

When you use the NETinventory-RMS snap-in, the data collected 
from Audit Agents by the Audit Servers is rolled up to a SQL 
database by the Master Server. The NETinventory-RMS snap-in can 
then retrieve the data. 

When data is rolled up to the SQL database, you cannot perform 
ActiveAdmin changes of the data, since the transfer to the SQL 
database is one-way. In addition, some data may be out-of-date, 
since rollup only occurs when the Master Server synchronizes with 
the Audit Servers. For complete information on data rollup and on 
scheduling and controlling synchronization, see Chapter 5 “Setting 
Up NETinventory Server Components.” 

System 
Requirements

In order to use the NETinventory Snap-in for the BindView RMS 
Console, your system must meet these requirements:

BindView RMS Console 
and NETinventory 
Snap-in Only

• Pentium® II 450 MHz
• 256 MB RAM 
• 300 MB of free disk space 
• SVGA monitor that supports 256 colors with the display set to 

800 x 600 pixels or greater 
• Microsoft® Windows® 2000 SP3 (server or workstation), Windows 

XP® Professional SP1, or Windows Server™ 2003 or later 
• Microsoft Internet Explorer v5.5 SP1 or later 

• Microsoft® Outlook® 2000, Novell® GroupWise® v5.5, Lotus 
Notes® v5.0 or Lotus Domino (only required for e-mailing export 
files) 

• Microsoft® Excel (required for Excel (using OLE) export files) 
• Client for Microsoft® Networks 

BindView RMS Console 
and Information Server 
and NETinventory 
Snap-in

• Pentium III 800 MHz
• 512 MB RAM 
• 500 MB of free disk space 
• Microsoft Windows 2000 SP3 (server or workstation), Windows XP 

Professional SP1, or Windows Server 2003 or later 
• Microsoft SQL Server v7.0 or 2000, or Microsoft SQL Server 

Desktop Engine (MSDE) v1.0 or 2000 
• Microsoft Internet Explorer v5.5 SP1 or later 
• Microsoft Outlook 2000, Novell GroupWise v5.5, Lotus Notes v5.0 

or Lotus Domino (only required for e-mailing export files) 
• Microsoft Excel (required for Excel (using OLE) export files) 
• Client for Microsoft Networks 
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If you install the Console and Information Server on the same 
machine, the machine must meet all of the listed system 
requirements.

Configuring 
Master Server SQL 
Rollup

When you configure the SQL database rollup, you must specify the 
SQL server to store the data and the path on the server where the 
data should be stored. The following SQL server applications are 
supported for storing data:

• SQL Server 7.0 

• SQL Server 2000 

• MSDE 7.0

• MSDE 2000 

Note: MSDE is required to use the BindView RMS Console and 
Information Server, and is included on the BindView RMS Console 
and Information Server installation disc. 

MSDE data storage is suitable for networks with up to 10,000 
nodes. If you have more nodes, you should use Microsoft SQL 
Server to store the NETinventory SQL Database. In addition, if you 
will have more than 4 clients (BindView Information Servers or SQL 
Clients) accessing the NETinventory data, you should use Microsoft 
SQL Server. 

To enable NETinventory SQL database rollup

1 Open the Master Server Settings panel and click SQL 
Settings.The NETinventory SQL Database Configuration 
Wizard Welcome page appears.

Fig. 220 NETinventory SQL Database Configuration Wizard
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Configuring Master Server SQL Rollup
2 Click Next. The Select Operation panel appears. Since you 
can only create a SQL Database for the currently-selected 
Master Server if none exists, the only option available is 
Configure SQL Database for the Master Server. Click Next. 
The SQL Server and Database panel appears. 

Fig. 221 NETinventory SQL Database Configuration Wizard - 
SQL Server and Database Panel

3 Enter the name of the SQL Server the Master Server should roll 
data up to in the SQL Server Name field or choose the 
server’s name from the drop-down list. Click the browse (...) 
button or enter the path to the SQL database in the SQL 
Database Path field. 

Note: If the SQL Server you select is set up to use Windows 
Authentication, it must be in the same domain or in a trusted 
domain of the machine which will hosts the BindView Information 
Server you will use to access the information. If there is not a trust 
relationship between the two domains, you must use SQL 
Authentication instead. 

4 Click Next. The Summary panel appears. 

5 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Make sure that 
Perform Complete Database Synchronization is selected 
and click Finish to create the database and roll data up into it. 

6 Click Synchronize all records to Master Server to create the 
database and copy all existing data to the SQL database. 

In the future, new and changed data will be rolled up to the 
SQL server whenever the Master Server synchronizes the 
Enterprise network. 
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Once you have audited nodes and a scheduled synchronization 
has taken place (by default, every hour), you will be able to use 
the NETinventory Snap-in for BindView RMS to retrieve 
NETinventory data from the SQL database. 

Note: The initial data rollup to SQL may take up to several hours, 
depending on your network configuration and how much 
NETinventory data has been collected already. 

Configuring 
NETinventory-RMS 

You must configure the BindView RMS Console and Information 
Server and the NETinventory-RMS snap-in before you can retrieve 
NETinventory information. 

To configure the BindView RMS Console 

1 Open the BindView RMS Console. The simplest way to start the 
console is to select BindView RMS Console from the BindView 
RMS group in the Start menu. The BindView RMS Console 
Configuration Wizard Welcome panel appears. 

Fig. 222 BindView RMS Console Configuration Wizard Welcome 
Panel
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2 Click Next. The Add/Remove Products panel appears. 

Fig. 223 Add/Remove Products Panel

3 Select the box for any new BindView RMS snap-in modules you 
have installed and click Next. The Add Licenses panel 
appears.

Fig. 224 Add Licenses Panel

4 Enter a license code in the text box, then click Add. The 
NETinventory Snap-in for the BindView RMS console does not 
require licenses, but you may need to add a license for the 
BindView RMS Console or for other BindView RMS Snap-in 
modules you install. The licenses may be provided on disk. If 
they are, insert the disk and click Have Disk. 

Note: BindView RMS Console licenses are separate from the 
licenses required by the NETinventory Console. BindView RMS 
Console licenses are stored in text (.txt) files. NETinventory Console 
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licenses are stored in .lic files. You must enter a license code for the 
BindView RMS Console, but no license code is required for the 
NETinventory-RMS snap-in. 

5 Continue adding licenses until all licenses have been entered, 
then click Next. The License Summary panel appears. 

Fig. 225 License Summary Panel

6 Click Next to install the licenses. The Add Licenses 
Completed panel appears. 

Fig. 226 Add Licenses Completed Panel
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7 Click Next. The Add/Remove Products in progress panel 
appears.

Fig. 227 Add/Remove Products in progress Panel

8 When the installation is complete, click Next to proceed. The 
Add Users panel appears. 

Fig. 228 Add Users Panel

Individual users of the BindView RMS Console can have unique 
privileges. When you have multiple BindView Snap-ins installed, 
different users can have access to different modules, based on 
credentials.

To add a BindView RMS Console user

1 Click in the Users field to add a user by typing their name and 
domain, or click the browse button (...) to locate the user.
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2 Set the user’s rights in the User Properties area. Repeat to 
create additional users, then click Next to proceed. The Add 
Users Summary panel appears. 

Fig. 229 Add Users Summary Panel

3 Review the summary, then click Next to finish the installation. 
The Configuration Complete panel appears. 

Fig. 230 Configuration Complete Panel
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4 Click Finish to close the Wizard. The BindView RMS Console 
appears. 

Fig. 231 BindView RMS Console 

To configure the NETinventory-RMS snap-in

1 Select the NETinventory(Not Configured) item. The 
NETinventory configuration item appears. 

Fig. 232 BindView RMS Console Dialog - NETinventory Node
236 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Configuring NETinventory-RMS
2 Double-click the <double-click to configure NETinventory 
Snap-in> item. The NETinventory Configuration Wizard 
Welcome panel appears. 

Fig. 233 NETinventory Configuration Wizard - Welcome Panel

3 Click Next. The Register Master Servers panel appears. 

Fig. 234 Register Master Servers Panel

4 Master Servers must be registered for the NETinventory-RMS 
snap-in to access them. Type the name of your Master Server in 
the New Master Server field and click Add. The Master Server 
you add must have SQL data rollup enabled. 
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5 Click Next. The Add Credential Databases panel appears. 

Fig. 235 Add Credential Databases Panel

6 Click in the Database Name field on Click and edit here to 
add new credential database to add a new Credential 
Database. Type the name of the new database, and press 
Enter. The Create New Database dialog appears. 

Fig. 236 Create New Database Dialog

7 Enter a password for the database and verify it and click OK. 
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8 The Add Credential Databases panel reappears. Click Next 
to proceed. The Select Credentials panel appears. 

Fig. 237 Select Credentials Panel

9 Click the plus (+) sign next to Registered Master Servers to 
expand the list of available servers. Select the server’s name 
and click >> to add the server to the credentials database. The 
Additional Settings dialog appears. 

Fig. 238 Additional Settings Dialog

10 Enter credentials the NETinventory-RMS snap-in will use to 
access the SQL database where the NETinventory data is 
located. 

You can select Windows Authentication and enter a Domain 
Name, User Name, and Password combination, or you can 
choose SQL Authentication and enter a User Name and 
Password combination. The authentication method you use 
depends on how your SQL server is configured. 
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11 When you have entered the credentials, click OK, and the 
Select Credentials panel will reappear. Click Next. The 
Assign a Credential Database to Each User panel appears. 

Fig. 239 Assign a Credential Database to Each User Panel

12 Beside each user name is a drop-down list of available 
Credential Databases. For each listed user, select the 
Credential Database to assign to the user from the drop-down 
list. When all users who should be able to access NETinventory 
data are assigned a Credentials Database, click Next. The 
Verify Credentials panel appears. 

Fig. 240 Verify Credentials Panel

13 Click Verify Credentials to test the connections to the Master 
Servers. Servers whose credentials cannot be verified will be 
listed in the Servers With Invalid Credentials field.
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If any server’s credentials cannot be verified, click Back to edit 
the credentials database. 

If all server credentials are verified, click Next. The Change 
Default Scopes panel appears. 

Fig. 241 Change Default Scopes Panel

14 Available Master Servers are listed in the Registered Master 
Servers field. Click Add to add them to the default 
NETinventory scope on the right side. Click Next. 

The Completing the NETinventory Configuration Wizard 
panel appears. 

Fig. 242 Completing the NETinventory Configuration Wizard 
Panel

15 Click Finish to close the wizard. 
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You can now use the BindView RMS Console to view NETinventory 
data.

When you open the NETinventory item in the BindView RMS 
Console, the <double-click to configure NETinventory Snap-
in> item is replaced with two new items. Registered Master 
Servers lists all NETinventory Master Servers available to report 
on. Configuration starts the NETinventory Configuration 
Wizard, allowing you to add additional Master Servers or to make 
changes to the NETinventory-RMS configuration. 

Note: If you double-click on a Registered Master Server, every node 
in that server’s SQL database is listed. 
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Understanding Queries
Understanding 
Queries

A query is a question that you define based on a specific set of 
criteria, and submit to the Information Server to receive specific 
information about resource objects in your environment.

By querying your environment using the NETinventory-RMS 
snap-in, administrators can use the Query Builder process to create 
reports that are specific to the data sources and fields of the query. 
The query can be customized to report on specific information in 
your organization. The query results can then be saved for analysis 
and planning of your environment at a later time.

You must have processing rights to create and modify queries. Only 
BindView Administrators can assign user rights for query 
processing.

For information on assigning query rights, see the BindView RMS 
Console and Information Server User Guide, or online Help.

In order to process a query, you must first configure the 
NETinventory-RMS snap-in and create a credential database that 
will be used to process queries. For information on configuring 
NETinventory-RMS, please see “Configuring NETinventory-RMS” on 
page 231. 

Pre-Defined Reports The NETinventory-RMS snap-in provides pre-defined reports that 
allow you to get started using the product immediately. You can 
access the pre-defined reports under the Risk Assessment and 
Control>Pre-Defined>NETinventory folders in the Console tree.

For a complete list of pre-defined reports and their definitions, see 
the NETinventory Query Summary Report.

Query Components The following components allow you to create a query:

• Data Source - Fields that represent a resource object or a 
collection of resource objects that are specific to NETinventory.

• Field Specification - Allows you to select the fields to be 
reported on by the query.

• Filter Specification - Allows you to define values for certain 
fields in the query results. These fields are used to select specific 
records, and to more narrowly define the information that the 
query gathers.
Filters are not required in query definitions.

• Sort Specification - Allows you to determine the order in which 
fields and values appear in the query results.
Sorts are not required in query definitions.

• Scope Specification - Allows you to restrict query processing to 
one or more of the Master Servers you have registered with the 
NETinventory-RMS snap-in. 
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Creating a Query
Creating a Query The first step in defining a query is to determine the information 
about your environment that you want to gather. When defining a 
query, use the Select Data Source dialog and the Query Builder 
dialog to specify the information that you want and the manner in 
which you want it collected. These dialogs can be accessed from the 
New Query icon on the BindView product toolbar.

For additional information about the Select Data Source and 
Query Builder dialogs, see the BindView RMS Console and 
Information Server User Guide.

Selecting a Data 
Source

You must select a data source for the query definition. A data 
source contains fields that represent a resource object, or a 
collection of resource objects. 

To select a data source

1 Click the New Query  icon on the product toolbar.

The Select Data Source dialog appears.

Fig. 243 Select Data Source Dialog

2 Select a data source and click OK.

The Query Builder dialog appears (Fig. 244 on page 246). 
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Adding Fields
Adding Fields To add fields to the query definition, use the Field Specification 
tab on the Query Builder dialog. A query definition must contain at 
least one field.

The added fields define the type of information received about the 
resource objects when the query is run.

To add a field

1 Select a field in the Available Fields list.

You can view a description of the selected field by clicking the 
Field Info button.

Fig. 244 Query Builder Dialog - Field Specification Tab

2 Click Add.

The field appears in the Selected Fields list. 

Fields can also be added by double-clicking them, or by 
dragging them to the Selected Fields list.

Fields appear in the dataset in the order they appear in the 
Selected Fields list. The field order can be rearranged by 
dragging fields.
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Adding Filters
Some fields, such as ranges, require a descriptor value. A 
dialog (Fig. 245) for that field appears after you click Add.

Fig. 245 Descriptor Field Dialog - Prompt Value

After you enter the value and click OK, the field with its value 
appears in the Selected Fields area.

Filtering the Available 
Fields List

You can quickly search for a specific field in the selected data source 
by creating a filter for the Available Fields list.

To filter the Available Fields list

1 Enter the string in the Filter Field Names text box (Fig. 244 
on page 246).

2 Click Apply.

The fields that contain the string appear in the Available 
Fields list (Fig. 244).

Clearing the Filter Field Names box and clicking Apply 
repopulates the Available Fields list with all the fields contained in 
the data source.

Adding Filters You can add filters to the query definition to reduce the number of 
resource object records returned in the dataset. Filters consist of 
one or more filter terms. A filter term is a value, or group of values, 
selected by the user that defines the record types that are returned 
in the dataset.

Users must supply all filter term values before the Information 
Server can process a query that contains a filter. Users supply filter 
term values either immediately after adding a filter term to a query 
definition, or each time the query is run. If the user who creates the 
query definition includes a prompt user command, the filter term 
value must be defined by the user who runs the query.

When the Information Server processes a query, it applies the filter 
to each record that is gathered for the selected resource objects. 
Only the records that match the filter are included in the dataset. 
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Adding Filters
To add a filter term

1 Select the Filter Specification tab on the Query Builder 
dialog.

Fig. 246 Query Builder Dialog - Filter Specification Tab

2 Select a field for which you want to define a filter term and click 
Add.

The Filter Term Definition dialog appears. 

Fig. 247 Specific Value Filter Term Definition

The Filter Term Definition dialog allows you to further filter 
the selected field.

3 Select a filter option.

4 Select an operator from the drop-down list.

5 Enter a specific value for the operator in the Specify a value 
box.
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Adding Sorts
6 Click OK. 

The filter term appears in the Expression list on the Filter 
Specification tab (Fig. 246 on page 248).

Grouping Filter Terms You can group two or more filter terms that you want to function as 
a single unit by using the Add parentheses buttons on the Filter 
Specification tab to group filter terms. The Remove parentheses 
buttons ungroup the filter terms.

Modifying and 
Removing Filter Term 
Definitions

To modify the filter term, select the filter term and click Modify. The 
Modify button invokes the Filter Term Definition dialog 
(Fig. 247). To remove a filter term, select the filter term and click 
Remove. 

Filtering Field Names As on the Field Specification tab, you can quickly search for a 
specific field in the selected data source by creating a filter for the 
Filter Field Names. See “Filtering the Available Fields List” on page 
247.

Adding Sorts Sorts determine the order in which sort fields and sort field values 
appear in the dataset. You can only apply sorts to fields that you 
added to the query definition. 

To add a sort

1 Select the Sort Specification tab on the Query Builder 
dialog.

Fig. 248 Query Builder Dialog - Sort Specification Tab
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Adding Scopes
2 Select a field and click Add. 

The selected sort fields appear in the Selected Fields list.

The fields and field values appear in the dataset according to 
the sort specification.

3 Select a duplicate key option.

• Allow Records with Duplicate Key - Includes all records 
regardless of key duplication.

• Only Allow Records with Duplicate Key - Includes only 
those records that have duplicate keys.

• Suppress Records with Duplicate Key - Includes only the 
first record of a key.

Modifying and 
Removing Sort Fields

To modify the sort direction of the fields, select a field and click 
Toggle Sort to toggle between an A to Z or Z to A sort for the 
values returned for the sort field. You also can change the sort 
direction by double-clicking the sort field.

To modify the sort order of the fields, select a field and drag it to 
the desired position.

To remove a field, select a field and click Remove. The field is 
removed from the Selected Fields list.

Adding Scopes A scope narrows the range of resource objects that are queried. A 
scope consists of user-selected scope items. A scope item is a single 
resource object or a container that holds several resource objects.

Since the Information Server only queries the resource objects 
indicated by the scope, you can use scopes to significantly reduce 
the time it takes to retrieve a dataset.

In NETinventory-RMS, the only resource object type is the 
Registered Master Server. 

To add a Scope

1 Select the Scope tab on the Query Builder dialog (Fig. 249).
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Adding Scopes
2 Select a scope in the Available Items list.

Fig. 249 Query Builder Dialog - Scope Tab

3 Click Add Scope.

The scope appears in the Selected Item(s) list.
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Adding Scopes
Using Dynamic Indexing Dynamic indexing reduces the display time of scope items on the 
Scope tab of the Query Builder dialog. Dynamic indexing 
alphabetically categorizes large numbers of nodes, or scope items, 
into several folders.

Dynamic index folders have a unique icon  and are labeled with 
the name of the first and last scope item in the folder. By default, 
dynamic indexing is enabled for all users. Each user has their own 
default dynamic indexing settings. 

To disable or modify your default dynamic index 
settings

1 Click Configure Dynamic Indexing on the Scope tab.

The Configure Dynamic Indexing dialog appears.

Fig. 250 Configure Dynamic Indexing Dialog

2 Select to enable or disable dynamic indexing. If you disable 
dynamic indexing, proceed to step 4.

3 Enter the number of folders and nodes that you want to be 
displayed in the Available Items list.

4 Click OK.

Saving Named Scopes A named scope is a group of saved scope items stored on the 
Information Server. All users of the Information Server can access 
any named scope saved on it.

1 Select the Scope tab on the Query Builder dialog (Fig. 249 on 
page 251). 

2 Select the item in the Selected Item(s) list.

3 Click Save Scope.

The Named Scope dialog appears. 

Fig. 251 Named Scope Dialog

4 Enter the name for the scope.

5 Click OK.
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Saving a Query Definition
The named scope is saved on the Information Server that you 
are currently using and can be reused for other queries based 
on the data source.

Adding Named Scopes 
to Query Definitions

You can add a named scope to any query definition that contains 
the same data source as the one associated with the named scope. 
When you add a named scope, you link the named scope to the 
query definition.

To add a named scope to a query definition

1 Expand the Named Scopes folder on the Scope tab on the 
Query Builder dialog (Fig. 249 on page 251).

All named scopes stored on the Information Server for the 
selected data source appear.

2 Select the named scope.

3 Click Add Scope.

The scope is now listed in the Selected Item(s) field.

4 Click OK.

The named scope is linked to the query definition. 

Note: If you save a query definition that contains a link to a named 
scope, any modifications made to the named scope are 
automatically applied to query definitions that use the named 
scope.

Removing a Scope To remove a scope, select the scope and click Remove. The scope 
is removed from the Selected Fields list.

Saving a Query 
Definition

A query definition is referred to as the Query Binder by the 
BindView RMS Console. By default, the Query Binder file is saved in 
the My Items folder, a subfolder found in the Risk Assessment 
and Control subfolder of the BindView Risk Management 
container. If you want to save your Query Binder in a different 
location, you can browse for the location and select it. The Query 
Options dialog is used to save the Query Binder.
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Running Queries
To save a Query Binder

1 Click OK on the Query Builder dialog.

The Query Options dialog appears.

Fig. 252 Query Options Dialog

2 Click Save.

The Save Query dialog appears.

Fig. 253 Save Query Dialog

3 Enter the name of the Query Binder in the Selection Name 
field.

4 Click OK.

The Query Options dialog reappears (Fig. 252), and you are 
now ready to run the query. 

Running Queries You can run a query from the Query Options dialog or the Query 
Binder shortcut menu. When you run a query, the Information 
Server polls the resource objects you selected in the query 
definition and returns this information in a dataset.

Datasets can be displayed in the following view types:

• Grid - Displays the dataset in a spreadsheet-style interface. Grid 
columns represent the fields included in the query definition, the 
grid rows represent the resource object records, and grid cells 
contain the gathered resource object attributes.
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Running Queries
If a record length exceeds the displayed column width, a red 
arrow appears in the record cell. Red arrows invoke pop-up 
windows when you place the cursor on them.

After running a query, always check for messages that have been 
returned with the query results. Click the Messages button at 
the lower right-side of the report to view messages.

• Chart - Displays the results of a query in a graphic format. Charts 
are created and modified using the Chart Builder Wizard. The 
wizard guides you through the process of building a custom chart 
for your query. During the building process, you select the type of 
chart (column, pie, or histogram) you want to build, and how you 
want the chart to be labeled.

• Report - Allows you to create a variety of customized reports for 
your query results, and to print a report of the data results from 
your query. The Console is installed with default settings. 
However, you can customize the default settings by using the 
Global Report Style Settings item in the BindView RMS 
Configuration folder.

For more information about query results settings, see the BindView 
RMS Console and Information Server User Guide.

To run a query from the Query Options dialog

1 Click OK on the Query Builder dialog.

The Query Options dialog appears.

Fig. 254 Query Options Dialog

2 Select the view type in the View As area.

3 Click Run.

The query results are returned in a dataset.

Fig. 255 Query Results in Grid View Type
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Rerunning Queries from the Grid Toolbar
To run a query from an existing query binder

1 Double-click Risk Assessment and Control in the BindView 
RMS container.

2 Click My Items to view the existing saved queries.

3 Select the query you want to run.

Fig. 256 Accessing the Query Binder

4 Click Run And View As Grid to run the query.

The query results appear in a grid (Fig. 255).

Rerunning Queries 
from the Grid Toolbar

The Rerun Query  icon on the grid toolbar allows you to rerun 
the query that was used to create the dataset displayed on the grid. 
The resulting dataset is automatically displayed as a grid. 

Saving datasets in a query binder using either the Save or Save As 
command removes the query task from the Task Status dialog 
because the corresponding dataset has been moved into a query 
binder.

Monitoring the Status 
of Processed Queries

Using the Task Status dialog, you can quickly monitor and manage 
your query tasks that are processed by the Information Server.
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Baselining
You can access the Task Status dialog by clicking the Task Status 

icon  on the product toolbar, or the View Task Status option 

on a taskpad.

Fig. 257 Task Status Dialog

You can monitor query tasks by observing their associated status 
icons. You can manage query tasks using the Query Task shortcut 
menu commands: 

• View – Displays the dataset gathered for the query as a grid.
• Halt – Stops query processing and displays the gathered dataset 

as a grid.
• Delete – Stops query processing and deletes the gathered 

dataset.
• Save or Save As – Links the dataset to the query binder 

containing the query definition for the processed query.

Baselining Baselining compares the records of two historical datasets linked to 
a query binder and produces a delta dataset that you can export or 
display as a grid or report. Delta datasets are used to view 
exceptions and monitor changes in your resource objects over time.

Baselining can help you perform risk management by allowing you 
to view exceptions and monitor changes in your environment. You 
can then analyze the differences to determine how your 
environment has changed between query executions.

You must have at least two historical datasets linked to a query 
binder to use the baseline feature. These historical datasets must 
be created from a query definition that contains a data source that 
supports baselining.

When you baseline two historical datasets, the records in the newer 
dataset are compared against the records in the older dataset. The 
older dataset is called the baselined dataset, and the newer dataset 
is called the compared dataset.

When you run a baseline, the Information Server creates a delta 
dataset that contains all baselined and compared dataset records 
that match the user-selected record status options. 
10: Using the NETinventory Snap-in for BindView RMS 257

© 2004 BindView Corporation. All Rights Reserved



Creating a Delta Dataset
Each record status has an associated icon.

Creating a Delta 
Dataset

When you create a delta dataset, it is automatically displayed as a 
grid. Although you cannot save delta datasets, you can use the grid 
functionality to print a report or export the delta dataset.

To create a delta dataset

1 Right-click the query binder file in the BindView RMS>My 
Items folder and select Manage>Historical Data from the 
shortcut menu. 

The Manage Historical Data dialog appears.

Fig. 258 Manage Historical Data Dialog

2 Select the two historical datasets that you want to baseline. 
Hold the Control key down as you make your selections.

Note: The Run Baseline button appears dimmed if the data source 
in the query definition does not support baselining. 

Baseline Record Status Types

Added

Deleted

Changed

Unchanged
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Creating a Delta Dataset
3 Click Run Baseline. 

The Baseline Options dialog appears, configured with the 
default settings.

Fig. 259 Baseline Options Dialog

4 Select a Record Status option.

5 Select a List Field Display option.

6 Click OK.

The delta dataset results appear on a baseline grid. 

Fig. 260 Delta Dataset Results on a Baseline Grid

The baseline grid displays all records from the two historical 
datasets that match the selected record status options.The 
baseline grid is used to create a report of the delta dataset, or 
to create a delta dataset export file. 
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Exporting
Exporting The Exporting feature allows you to format and send data so that it 
can be used by another application. You can export the following 
types of BindView data:

• Datasets
• Historical datasets
• Delta datasets
• Session logs
• Charts

The Export Setup dialog is used to export datasets and session 
logs. The data is exported by either the Console or the Information 
Server machine, depending on how you open the Export Setup 
dialog.

Exporting from the Information Server machine is more secure 
because BindView Administrators can restrict the directories that 
users can send export files to. 

You can also use the Export Settings dialog to save export 
settings so that you can apply them to multiple datasets or session 
logs.

Table 9  Invoking the Export Setup Dialog

Items that invoke the 
Export Setup Dialog

Machine to Export 
From

Export button  on the Grid 
toolbar

Console

Export command on the Grid 
menu 
of a grid

Console

Export button and command on 
the 
Grid menu of a baseline grid

Information Server

Run>And Export command on 
the Query Binder shortcut 
menu

Information Server

Export button on the Manage 
Historical Data dialog

Information Server

Query or Baseline Post 
Process Commands dialog

Console or Information 
Server
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Exporting Prerequisites
Exporting 
Prerequisites

Before you export a dataset or session log, you must configure the 
report settings and the export mail server.

Report Settings Report settings determine the appearance of the report.

To configure the report settings

1 Click the Grid menu on the dataset and select Report 
Settings.

2 Select the Fields tab and select the Print check boxes for each 
field you want to export.

3 If you are creating a text-based export file, you should select 
Auto in the Column Width area on the Spreadsheet tab. 

For additional information on report settings, see the BindView RMS 
Console and Information Server User Guide.

Export Mail Server For e-mail and Microsoft Exchange exports, you must designate 
your mail server on the Export Mail Server dialog. For information 
on designating your mail server, see the BindView RMS Console and 
Information Server User Guide.

Export File Format 
Types

You can export a dataset or session log in the following file formats. 
Text-based formats are represented by an asterisk (*). 

For information on file formats, see the online Help.

Table 10  Available File Formats for Exporting Datasets

• Acrobat format (PDF)
• Microsoft® Access 2000 (MDB)
• Character-separated values*
• Comma-separated values (CSV)*
• Crystal Reports® (RPT)
• dBase IV®
• Excel 5.0 (XLS)
• Excel 7.0 (XLS) 
• Excel 8.0 (XLS)
• Excel (using OLE)
• HTML 4.0*

• HTML (Enhanced)
• Microsoft SQL Server
• Microsoft SQL Server (Enhanced)
• Paginated Text*
• Record style (columns of values)*
• Rich text format (RTF)*
• Tab-separated values*
• Text*
• Word for Windows® (DOC)*
• XML
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Exporting to a Disk File
Exporting to a Disk 
File

You can export a dataset or session log to a disk file by specifying a 
path in the File Name box on the Export Settings dialog. 

To export to a disk file

1 Open the Export Setup dialog using one of the methods listed 
in Table 9 on page 260.

Fig. 261 Export Setup Dialog

2 Click Choose.

The Choose Export dialog appears. 

Fig. 262 Choose Export Dialog

3 Select a format for the export file from the Format drop-down 
list.

4 Select Disk file from the Destination drop-down list.

5 Click OK. 

The Export Setup dialog reappears with the format and 
destination settings that you defined (Fig. 261).

Note: If you selected Character-separated values, Paginated 
Text or MS SQL Server for your format, a secondary dialog 
appears. Access the context-sensitive Help on the dialog for 
detailed information on defining the required format settings.
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Exporting to an Exchange Mailbox
6 Enter the path and file name in the Folder Name and File 
boxes. You can use the browse (...) button to select a different 
folder. 

7 If you want to add the exported data to an existing file or table, 
select Append to file/table if it already exists.

If the selected export format does not support the append 
feature, this option will be dimmed. 

8 Click Export now.

The dataset or session log is exported in the defined format to 
the disk file destination indicated in the Folder Name box.

Exporting to an 
Exchange Mailbox

You can email the dataset or session log export file to any user 
mailbox using the Exchange mailbox destination type. When you 
create an email export file, your default Exchange Server is used. If 
you are exporting from the Information Server machine, you must 
provide your password in your default export setup to successfully 
email the export file.

To email an export file to any user mailbox

1 Open the Export Setup dialog (Fig. 261 on page 262).

2 Click Choose.

The Choose Export dialog appears. 

Fig. 263 Choose Export Dialog

3 Select a format for the export file from the Format drop-down 
list.

4 Select Exchange mailbox from the Destination drop-down 
list.

5 Click OK. 

Note: If you selected Character-separated values, Access 
2000, or Paginated Text for your format, a secondary dialog 
appears. Access the context-sensitive Help on the dialog for 
detailed information on defining the required format settings.
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Saving Export Settings
The EMail Settings dialog appears. 

Fig. 264 EMail Settings Dialog

6 Enter the recipients, subject, and message for the email export 
file and click OK. 

If a recipient belongs to a different mail server than your 
default Exchange server, you must enter their entire email 
address.

The Export Setup dialog reappears (Fig. 261 on page 262).

The field at the top of the dialog displays the format and 
destination settings you defined.

7 Click Export now.

The dataset or session log export file is emailed to the specified 
recipients.

Saving Export 
Settings

The three types of default export settings are automatically applied 
to the Export Settings dialog according to the following hierarchy:

• Export Settings Item 
• User (My Setup)
• Global (Everyone’s Setup)

All default export settings are stored on the Information Server. The 
export settings item and user default export settings are specific to 
the user who created them. However, all users can access export 
settings items that reside in the Shared folder, and the global 
default export settings that are saved by the BindView 
Administrator.
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Saving Export Settings
To save export settings

1 Open the Export Setup dialog (Fig. 261 on page 262).

2 Click To Export Settings Item.

The Save Report Item dialog appears.

Fig. 265 Save Report Item Dialog

3 Enter the name of the export settings item in the Selection 
Name box.

4 Click OK. 

The Export Setup dialog reappears (Fig. 261 on page 262).

5 Click OK.

The settings are saved as the default for the query binder.

As My Setup Export 
Settings

If you want to save the settings defined in the Export Setup dialog 
as your user default export settings, click As My Setup in the Save 
area.

Global Default Export 
Settings

Only BindView Administrators can save global default export 
settings for users of the Information Server. 

An Information Server can store only one group of global default 
export style settings at a time. When a BindView Administrator 
saves new global default export style settings, the old settings are 
automatically deleted. 

Information Servers cannot share global default export style 
settings.

BindView Administrators use the As Everyone’s Setup button in 
the Save area of the Export Setup dialog to save the settings 
defined on the dialog as the global default export settings.

Note: The As Everyone’s Setup option appears dimmed if you are 
not a BindView Administrator.
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Creating Task Lists
To apply export settings

1 Open the Export Setup dialog (Fig. 261 on page 262). 

2 Click From Export Settings Item in the Load area.

The Select Report Item/Folder/Shortcut dialog appears.

Fig. 266 Select Report Item/Folder/Shortcut Dialog

3 Select the export settings item and click OK.

The Export Setup dialog is now configured with the settings 
saved in the export settings items.

For detailed information on exporting, see the BindView RMS 
Console and Information Server User Guide.

Creating Task 
Lists

The Task List feature allows you to group several tasks and 
manage them as one task file. A task list file can contain the 
following items:

• Query tasks
• Baseline tasks
• Post-process commands for added tasks
• Summary file commands

When you run a task list, the Information Server processes all tasks 
and post process commands added to the task list in a sequence. If 
a baseline task is dependent on a query task, the Information 
Server processes the query task before the baseline task.

When you create a task list, you can perform the following 
activities:

• Add query tasks from query binders
• Define post process commands for added query tasks
• Apply a scope for added query tasks
• Add baseline tasks from query binders
• Define post process commands for added baseline tasks
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Creating Task Lists
• Import query or baseline tasks from saved task lists
• Define summary file properties

To create a new task list

1 Click the New Task List icon on the product toolbar.

The Task List dialog appears.

Fig. 267 Task List Dialog

2 Click Add.

The Select a Task Type dialog appears.

Fig. 268 Select a Task Type Dialog

3 Select the task type and click Add. 
10: Using the NETinventory Snap-in for BindView RMS 267

© 2004 BindView Corporation. All Rights Reserved



Creating Task Lists
The Select Query Binder dialog appears.

Fig. 269 Select Query Binder Dialog

4 Select the Query Binder from the Available Items list and 
click > or click in the Selected Items list and enter the full 
path of the item. To add all items from the Available Items 
list, click >>.

You can browse to other folders using the  button.

5 Click OK to close the Select Query Binder dialog.

The following dialogs that appear are based on the user 
selecting a Query task type. The dialogs and steps are similar 
for a Baseline task type.

The Query Task Item dialog appears configured with the 
selected query binder and default post process commands.

Fig. 270 Query Task Item Dialog
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Running Task Lists
6 If you want to add additional query binders to the task item, 
click the browse (...) button and select the items. 

7 If you want the Information Server machine to execute the 
added post process commands when the task list is run, select 
the Run Post Process Commands Unattended check box.

If this check box is cleared, the Console machine executes the 
commands.

8 Click Add.

The Query Post Process Commands dialog appears.

Fig. 271 Query Post Process Commands Dialog

A query task post process command tells the Console or 
Information Server machine what to do with the dataset 
gathered for the query task. You must have at least one post 
process command defined.

9 Select the post process command.

10 Click OK.

If the post process command requires additional user 
selections, a secondary dialog appears.

If additional user selections are not required, the Query Task 
Item dialog reappears. The post process command you added 
appears in the Post Process Commands list.

If you want to add another post process command, click Add 
and repeat Step 9 and Step 10.

11 Continue to add post process commands, if needed.

12 Click OK.

The Task List dialog reappears. The query task you added 
appears in the list of added tasks.

After you have saved the task list, you can run it at any time.

Running Task Lists You run task lists from the following locations:

• Task List dialog
• Shortcut menu of a saved task list
• Schedules
• Command line
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Creating Schedules
Use the Run button on the Task List dialog to run the task list. 
After you run the task list, the Run button changes to Run Again.

Saved task lists have shortcut menus that you can use to run the 
task list.

To start a task list at a specified time, you can use the Console 
Create Schedule Wizard. As long as the BindView RMS Information 
Server is running, the task will be processed at the time you 
specify.

Note: If you create the Scheduled Task on a machine hosting the 
BindView RMS Console, rather than a machine hosting the 
Information Server, and the machine is off, the Task List may not 
be processed on schedule. To ensure that it is processed at the 
desired time, you should consider creating the Scheduled Task on 
the machine hosting the Information Server.

You can also use the command-line task list launcher or a 
third-party scheduling application. For additional information on 
scheduling task lists, see “Creating Schedules” on page 270.

For information on using the command-line task list launcher or a 
third-party scheduling application, see the BindView RMS Console 
and Information Server User Guide.

Creating 
Schedules

You can schedule existing task lists and queries for automatic 
processing by the BindView Information Server using the Create 
Schedule Wizard. As long as the machine that hosts the BindView 
Information Server is on and the BindView Information Server 
Service is running, the scheduled item will be processed at the 
specified time. 

You can schedule tasks lists or queries and have them processed 
one time only, or on a daily, weekly, or monthly basis. When a task 
list is scheduled, the task list is processed using the user name and 
password combination you supply, exactly as if that user executed 
the task list. Any post processing the task list performs will also be 
executed. 

If the tasks in the task list are not set up to run post process 
commands unattended, all non-interactive post process commands 
(such as exporting) will be performed. Post process commands that 
require user interaction (such as displaying a grid or chart) will be 
performed when the user who created the schedule starts the 
Console. 

To view existing schedules, click the Schedules container in the 
Console tree.

Note: If the current user is a BindView User, only the schedules 
they create appear. If the current user is a BindView Administrator, 
all existing schedules appear. 
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Creating Schedules
For complete information on Schedules, see the BindView RMS 
Console and Information Server User Guide.

To schedule task lists

1 Click the New Schedule  icon on the product toolbar, or 
click Schedules in the Console tree and double-click 
<double-click to add new schedule> in the Details pane.

The Welcome to the Create Schedules Wizard appears 
(Fig. 272 on page 271).

Fig. 272 Welcome to the Create Schedules Wizard

2 Click Next. 

The Choose a schedule type panel appears. 

Fig. 273 Choose a Schedule Type Panel
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Creating Schedules
3 Select Task List Schedule and click Next. 

The Add Items panel appears. 

Fig. 274 Add Items Panel

4 Enter the full path and name of the folder or item to be added 
to the schedule. You can also use the browse (...) button that 
appears when you click in the text box to select the item. You 
can add one or more task lists, shortcuts to task lists, or 
folders. 

If you add a folder, all the items in that folder will be added to 
the schedule, including subfolder contents, shortcuts, and 
linked folders.

If you click the browse (...) button, the Select file dialog 
appears. 

Fig. 275 Select File Dialog

5 Select the item from the Available Items list and click >. To 
add all items from the Available Items list, click >>. 
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Creating Schedules
To remove an item in the Selected Items list, select it and 
click <. To remove all items, click <<.

6 Click OK.

The Add Items panel reappears (Fig. 274 on page 272).

7 Click Next. 

The Name the schedule panel appears. 

Fig. 276 Name the Schedule Panel

8 Enter a name for the schedule in the Type a name for this 
schedule field and select how often the task should be run.

9 Click Next. 

The Specify Schedule panel appears. 

Fig. 277 Specify Schedule Panel - Weekly Options 
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Creating Schedules
The contents of the Specify Schedule panel vary depending 
on how often you chose to run the task on the Name the 
schedule panel.

10 Select the time the task should run in the Start time box.

11 Select the options specific to the schedule and click Next.

The Specify Account Information panel appears. 

Fig. 278 Specify Account Information Panel 

12 Enter the User Name and Password that the BindView 
Information Server uses when processing the task lists in the 
schedule, and confirm the password. 

Caution: Use caution when using another user’s credentials. The 
other user could make changes to their account, including changing 
the password, at any time. If changes are made to the account and 
you do not update the credentials in the schedule, the schedule will 
not be processed at the specified time. 
274 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Creating Schedules
13 Click Next. The Summary panel appears.

Fig. 279 Summary Panel

14 Verify that the settings are correct and enter a description of 
the schedule in the Type a brief description for this 
schedule field.

If you want to change any of the settings, click Back. 

15 Click Next.

The Create Schedules Wizard completion panel appears. 

Fig. 280 Create Schedules Wizard Completion Panel

16 Click Finish to close the Wizard.

17 The new schedule item appears in the Details pane of the 
Schedules container.
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Charting
Charting The chart feature is used to display datasets in a graphic format. 
Using the Chart Builder Wizard, you can create the following types 
of charts:

• Series – Displays the relative values of one or more fields for 
each record in a dataset.

• Histogram – Displays the value frequencies for the records 
associated with a single field in a dataset. For information on 
creating a Histogram Chart, see the BindView RMS Console and 
Information Server User Guide.

You can open the Chart Builder Wizard from the following 
locations:

• Chart options in the Query Options dialog
• Chart-related Post Process Commands dialogs
• Grid toolbar and View menu
• Chart toolbar and View menu
• Query Binder shortcut menu

Creating a Series 
Chart

You should only use the series chart type if the dataset you are 
charting contains a limited number of fields and records.

To create a series chart

1 Open the Chart Builder Wizard and click Next. 

Fig. 281 Chart Builder Wizard Welcome Panel
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Creating a Series Chart
The Chart Type panel appears.

Fig. 282 Chart Type Panel

2 Ensure that the Histogram check box is cleared and click 
Next.

The Chart Data Source panel appears.

Fig. 283 Chart Data Source Panel

3 Designate a field for each Series position by selecting the field 
from the Source field list.

4 Click Add. You must designate a field for each series position in 
the Series list.

5 Select the desired label from the Category (X) axis labels list 
and click Next.
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Creating a Series Chart
The Chart Titles panel appears. 

Fig. 284 Chart Titles Panel

6 Enter the titles for the chart and click Next.

The Chart Legends panel appears.

Fig. 285 Chart Legends Panel

7 Select the legend check boxes and the position.

Even if you do not select legends now, you can use the chart 
legend shortcut menu of the completed chart to add them later. 

8 Add a scroll bar, if needed, and enter the number of series 
displayed on the chart at one time. 

A scroll bar is automatically added to charts that have 20 or 
more series positions.

9 Click Finish.

A series chart for the specified properties appears.
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Section 3: NETinventory Console
Using the NETinventory Console to Create Queries
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The NETinventory Console User Interface
The NETinventory 
Console User 
Interface

The NETinventory Console includes several elements. When you run 
the NETinventory Console, a window appears with a menu, toolbar, 
and work space. Fig. 286 shows the NETinventory Console User 
Interface elements. 

Fig. 286 NETinventory Console User Interface 

User Interface Terms 
Defined

Table 11 defines the parts of the NETinventory Console User 
Interface. 

NETinventory Console application window

User
Toolbar

User
Desktop

Report
Item

Subfolders

Folder Tabs

Console
Main Menu

Table 11  Console User Interface Terms 

Term Definition

User Toolbar Contains tool buttons for common Console actions. 

User Desktop Automatically appears when you run the NETinventory 
Console. Your user Desktop is based on your login name 
and password. 

Folders Highest-level organizational item used to contain and 
organize Report Items and Subfolders on a user 
Desktop. Folders are selected by clicking Folder Tabs. 
This brings the Folder contents to the foreground.
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The NETinventory Console Desktop
The NETinventory 
Console Desktop

When you log into the NETinventory Console, your user Desktop 
appears. Each Desktop is self-contained and can be configured to 
individual needs. 

When you start the NETinventory Console, a prompt appears asking 
you to enter a user name and password. The user name and 
password combination determines the user Desktop that appears. 

When you launch the NETinventory Console for the first time, you 
log in as the BindView Administrator (BV Admin). You can create 
additional users later. 

Item Definitions The parameters used to generate grid or graph items is called the 
item definition. The components of an item definition vary 
depending upon the item type (e.g., Grid, Graph, or Schedule 
item). The major components of the item definition are the data 
source, query, page setup, and graph setup.

Data source Data Sources are categories of information the NETinventory 
Console can report on. Each category is called a Data Source.

Query Queries are part of Grid and Graph item definitions. A query allows 
you to obtain specific information in a particular Data Source. The 
NETinventory Console Query Builder guides you through the 
process of formulating a query. ActiveAdmin gives the ability to 
update editable fields generated by a query

Page setup The page setup definition is part of a Grid item definition. The 
NETinventory Console reporting engine uses the dataset of a Grid 

Subfolders Categorize and organize Report Items within Folders. 
Subfolders can contain Report Items or other 
Subfolders.

Report Items Report Items enable you to analyze and manage 
various aspects of your network. The three types of 
Report Items are: Grids, Graphs, and Schedules.

Grid The Grid is used to gather, view, and manage network 
information. Grids contain a query. When you run a 
Grid, the embedded query gathers data and displays 
the query results.

Graph The Graph is used to gather and view network 
information. Graphs contain a query. When you run a 
Graph, the embedded query gathers data and displays 
the query results in a graphical format. You can choose 
the type of Graph displayed.

Schedule Schedules group Grids and Graphs into logical business 
functions.

Table 11  Console User Interface Terms  (Continued)

Term Definition
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NETinventory Console Snap-in Modules
item as the basis for report content. Most of the configuration of a 
report layout is performed within a grid query using page setup.

Graph setup Graph Setup is part of a Graph item’s definition. Use it to change 
the look or layout of a Graph.

NETinventory 
Console Snap-in 
Modules

The NETinventory Console is modular and only the modules you 
purchase are loaded. The two modules available for the 
NETinventory Console are NETinventory and NETrc®.

NETinventory NETinventory is the primary Snap-in Module for the NETinventory 
Console.

Examples of some of the NETinventory capabilities:

• Comprehensive configuration information (over 600 unique items 
of information per node). 

• Master software list of over 12,000 software packages.
• Three-tier, client-server database architecture with low 

requirements on network bandwidth.
• Real-time enterprise-wide reporting.
• Centralized, automated configuration management of workstation 

inventory throughout your entire enterprise—a must for 
managing enterprise-wide inventory on large, distributed 
networks.

• Easy, point-and-click configuration file management.
• User-definable alerts, priority levels, and alert actions.
• Unlimited tracking of node configuration history.

NETrc NETrc is a Snap-in Module for the NETinventory Console that works 
in conjunction with the NETinventory Console and the NETinventory 
Snap-in Module. Once NETrc is installed, you can view or control 
any workstation that has the NETrc Host software installed. Once 
you have taken control of a workstation, you can view its screen, 
investigate problem reports, or troubleshoot, just as if you were in 
front of the workstation. NETrc components work in conjunction 
with the NETinventory components to let you efficiently manage the 
workstations on your enterprise network. 
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Item Definition
Item Definition The parameters used to collect information from your enterprise are 
called the item definition. The components of the item definition 
vary depending upon the item type (e.g., Grid, Graph, or 
Schedule). 

Properties of an Item You can customize how an item is displayed in the Folder Manager 
by editing the item’s properties. Edit the item properties by 
highlighting the item and selecting Properties from the Edit menu or 
by pressing Alt+Enter. The Modify Item Properties dialog 
appears.

Fig. 287 Modify Item Properties Dialog

Item Properties • Item Name - The name assigned to an item. 
• Ref Count - A reference can be shared between users, and the 

reference count contains the number of desktops that include the 
reference. An item always has at least one reference.

• Other users can modify object - When selected, allows other 
users to modify the definition of an item sent as a reference. For 
more information on references, please see “Sharing Items 
Between Desktops” on page 306.

• Default Mouse Double-Click Action - Defines the action taken 
when double-clicking an item. Choose to Modify Definition, Print 
to Printer, or Launch when the item is double-clicked.

• Item Comments - Optional description or comment about the 
item. When the mouse is over the item, the comments appear in 
the lower left portion of the NETinventory Console window.

• Change Icon - Change the item icon.
• Entry ID - The internal NETinventory Console serial number for 

the item. 

Queries and the Query 
Builder

Create queries using the Query Builder. To create a meaningful 
query, you should understand the query process itself.

What is a Query? A query collects information about your enterprise network. 
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Queries and the Query Builder
The NETinventory Console gathers data and displays the results 
that answer these types of questions. Results can be displayed in a 
grid (spreadsheet style interface), a printed report, or a graph. 
Every time you process a query, the results are updated.

Why Create a Query? A query defines the information you wish to retrieve and provides a 
way to retrieve all or a portion of the information about a resource.

Expressed simply, a sample query might be: 

For all audited nodes on my enterprise network, display the 
computers that do not have a processor of a certain speed or 
faster, or which do not have a certain amount of memory.

What is a Data Source? Within each Module are categories of information. Each category is 
called a Data Source. 

Note: Once a query item is created, the Data Source for that item 
cannot be changed.

What is a Query 
Builder? 

The Query Builder is used to create or modify a query. The results 
of a query can be displayed in Grid or Graph format and can be 
printed. The Query Builder consists of a dialog with four panels. 

Fig. 288 NETinventory Console Query Builder

The parts of the Query Builder are:

• Field Specification - Use to select which fields the NETinventory 
Console collects when it processes the query.

• Filter Specification - Allows you to prevent the inclusion of 
unwanted records in query results. Filter criteria can be grouped 
using logical AND/OR operators and the parentheses.
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Grid Item Defined
• Sort Specification - Allows you to define the order that 
information collected by the query displays in.

• Scope - Allows you to restrict a search to particular Audit 
Servers.
Instead of searching the entire network, the query can focus only 
on the Audit Servers of interest. This speeds processing the query 
and reduces the time necessary to produce results.

Grid Item Defined A Grid is used to analyze, display, and print information about 
resources in your enterprise in the form of a spreadsheet interface. 
In addition, ActiveAdmin gives the ability to update editable fields. 
A Grid can serve as the basis for generating printed reports. 

Fig. 289 Grid Dialog

Components of a Grid 
Item 

The components of a Grid item are:

• Query
• Item Properties
• Page Setup settings
• Display Font

A report is the printed output of a Grid. To customize a report, use 
Page Setup. Page Setup allows you to customize the appearance of 
your reports.

Scroll Buttons Record Counter % of Records in Scope Columns (Fields)% of Records in Scope
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Graph Item Defined
Graph Item 
Defined

A Graph is used to analyze, display, and print information about 
particular aspects of your enterprise in an pictorial format. An 
example a Graph is shown below.

Fig. 290 Graph Dialog

Components of a 
Graph Item 

A Graph item consists of the following components:

• Query
• Item Properties
• Graph Setup

Graph Setup Graph Setup is available when creating or modifying a Graph item. 
It is also available from an open Graph. The Graph Setup dialog 
controls the layout of the Graph. To access Graph Setup for an 
existing Graph item, right-click a Graph item and select Modify 
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Schedule Item Defined
Definition from the pop-up menu. To access Graph Setup in an open 
Graph, select Graph from the Main menu and select Modify Graph. 

Fig. 291 Modify Graph Dialog

Schedule Item 
Defined

Schedules group Grid, Graph, or Schedule items into a batch. The 
items contained in the Schedule can be launched immediately or at 
another time. A schedule can contain any grid, graph, or schedule 
items available on your NETinventory Console desktop. 

Fig. 292 Select Items for Scheduling Dialog
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Components of a Schedule
Components of a 
Schedule

Schedules combine items into a batch process. A Schedule Item 
consists of the following components: 

• The list of items in the Schedule. 
• The item properties, which customize appearance on the desktop. 

Select Properties from the Edit menu to view Schedule properties. 
Edit the Item List for a Schedule by clicking the Schedule item and 
selecting Modify Definition from the Edit menu.
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Components of a Schedule
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Creating a New Grid or Graph Item
Creating a New 
Grid or Graph 
Item

Use the NETinventory Console to create new grid and graph report 
items. When you create a Grid or Graph, you use the Query Builder 
to specify the data you want to display. After specifying the data to 
display, use Page Setup or Graph Setup to customize the 
presentation of the report.

Data Source You must select the data source for a query when you create it. 
Every property of a query can be changed after you create it except 
the Data Source. 

To select a Data Source

1 Click the New Grid or New Graph icon in the NETinventory 
Console toolbar. Or select New Grid or New Graph from the 
File menu. 

Fig. 293 New Grid Button

Fig. 294 New Graph Button

2 Highlight a data source to use in this query.

Once an item is created, the Data Source cannot be changed 
for that item. 

The Description field provides a general description of the 
information available in the highlighted data source.

3 Click Show Advanced Data Sources to display less 
commonly used Data Sources, including internal data sources 
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Field Specification
used by the NETinventory Console, such as lists of available 
fields. 

Fig. 295 Select Data Source Dialog

4 Click OK to select the data source and start the Query Builder.

Field Specification You can customize the query you are creating by adding or 
removing fields to display the information you need. 

The Category field contains a list of categories that narrow the 
number of fields displayed. The default Category is “All Fields.”

To add a field to a query

1 Select a Category or leave the Category field set to All Fields 
to display all fields available for the selected Data Source.

Fig. 296 Query Builder Dialog - Field Specification Panel
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Filter Specification
2 Select the fields to add to the query and click Add.

To select multiple fields, hold down the CTRL key, select each 
item in turn, and then click Add.

Filter Specification Filters allow you to restrict the information the query will display. 
Use the filter specification option to add filters to the query. 

To add a filter to a query

1 Click Filter Specification.

Fig. 297 Query Builder Dialog - Filter Specification Panel

2 Select the field to add as a filter and click Add.

3 In the Define Filter Term dialog, select the filter term and add 
any needed conditions. If the browse (...) button is present, 
click it to display a list of choices.

Fig. 298 Define Filter Term Dialog

4 Click OK. The Query Builder dialog appears.
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Sort Specification
Sort Specification Use the Sort Specification to change the way information is sorted 
and grouped. Duplicate Key Options can limit the report to allow 
duplicates, allow only duplicates, or suppress duplicates. 

To change the sort order of information

1 Click Sort Specification. 

Fig. 299 Query Builder Dialog - Sort Specification Panel

2 Highlight the field to add to the Sort Specification and click 
Add.

3 Drag and drop fields in the Selected Sort Fields area into the 
sort order you choose.

The fields in the query will be sorted according to the order that 
they appear in the list. For each field you add to the Sort 
Specification, you can choose to sort in ascending sequence (that is, 
A to Z or lowest number to highest number) or descending 
sequence (that is, Z to A or highest number to lowest number) 
sequence. 

To change the sort direction

Highlight the name of the field you wish to change the sort 
order for and click the Ascend/Descend button.

You can also change the ascend/descend direction by double-
clicking the red arrow beside the field name.

Duplicate Record 
Processing

The NETinventory Console gives options for duplicate record 
processing. Duplicate record processing options include the ability 
to suppress duplicates or to allow only duplicates. By default no 
special duplicate processing takes place; all records that meet the 
13: Creating and Changing Items 297

© 2004 BindView Corporation. All Rights Reserved



Scope
scope and filter conditions in the query will appear, without regard 
to their status as duplicates. Duplicate Key Options can restrict the 
inclusion of duplicate records in the result. 

Duplicate options only function within a selected sort sequence 
(e.g., a record is considered a duplicate if all the fields selected for 
sorting match another record). If no fields are selected for sorting, 
duplicate key options are not available.

Scope The Scope option allows you to target sites or Audit Servers to 
search. Use this feature to reduce the size of the area to be 
searched, thereby reducing the amount of time it takes to create a 
report. 

To define the areas to search

1 In the query builder, click Scope.

Fig. 300 Query Builder Dialog - Scope Panel

2 To use a scope other than the default scope, deselect Use 
Default Scope.

3 Select the new scope to use. 

4 To change the default scope for all queries, click Modify 
Default Scope to modify the default NETinventory scope. 

Save the New Grid or 
Graph Item

You can save Graph or Grid items for later use. You can also export 
saved items you create or send references to your items to other 
users. 
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Save the New Grid or Graph Item
To save your new Grid or Graph item

1 Click OK in the Query Builder to define the query. 

2 Click Save Grid Definition or Save Graph Definition.

Fig. 301 Select Save/Launch Dialog - Grid

Fig. 302 Select Save/Launch Dialog - Graph

The Save As dialog appears.
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Changing Existing Grid or Graph Items
Fig. 303 Save As Dialog

3 Select the NETinventory Console folder where you want to save 
the item. Click the Navigate button if you want to change the 
view, add a folder or sub-folder, or delete a folder or item.

4 Enter the name of the item. 

5 Click OK.

Changing Existing 
Grid or Graph 
Items

You can use the Query Builder to modify the definitions of existing 
grid and graph items. In addition, you can customize the attributes 
of an item using the Properties menu option.

To modify an existing Grid or Graph Item

1 Right-click an existing item and select Modify Definition or 
choose Modify Definition from the Edit menu.

Fig. 304 Grid Context (Right-Click) Menu

2 In the Modify Grid Definition or Modify Graph Definition 
dialog, click Query. 

Fig. 305 Modify Grid Definition Dialog

The Query Builder dialog appears.

Use the Query Builder to add or remove fields; to add, remove, 
or modify filters; to change the sort specification; or to change 
the scope of the query. 
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Creating a New Schedule Item
3 When you have made changes, the NETinventory Console will 
prompt you to save or launch the modified query. 

Creating a New 
Schedule Item

Schedules group related items together, allowing you to process 
them easily. 

To create a new Schedule item

1 Click the New Schedule icon in the NETinventory Console 
toolbar or select New Schedule in the File menu.

Fig. 306 New Schedule Icon

The Select Items for Scheduling dialog appears. 

Fig. 307 Select Items for Scheduling Dialog

2 Use the tabs to locate the items to add to the Schedule. 
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Creating a New Schedule Item
3 Select items to add to the Schedule and click Add, or click Add 
All to add all items in a folder to the Schedule. The Scheduled 
Item Properties dialog appears. 

Fig. 308 Scheduled Item Properties Dialog

4 Choose what actions the NETinventory Console should take 
when the Schedule is processed.

If Print Item is selected, click Printer Setup to review or 
override the default print setup. 

Fig. 309 Print Setup Dialog

If Export Item is selected, refer to the Export Data instructions 
on page 330.

5 Click OK to add the item to the schedule. If you choose, you 
can continue to add items to the schedule. 
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Creating a New Schedule Item
6 If you choose, select one or more items and click Advanced 
Schedule Options. The Advanced Schedule Options dialog 
appears. 

Fig. 310 Advanced Schedule Options Dialog

7 The NETinventory Console can export all the items in the 
Schedule as a group for the bv-Web analysis tool, or can 
override the before and after programs in any schedules 
included in the schedule. Make any changes to the bv-Web 
export settings if needed, and set up any programs to run 
before or after the schedule is run. Press the browse (...) 
button to search/select files from a directory list. 

8 Click OK to save the changes and close the Advanced 
Schedule Options dialog. 

9 Click OK in the Select items for Scheduling dialog to save 
the schedule. The Save As dialog appears. 

10 Select the location to save the Schedule. Click the Navigate 
button if you want to change the view, add a folder or sub-
folder, or delete a folder or item.
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Creating a New Schedule Item
Enter the name of the Schedule. Click OK.

Fig. 311 Save As Dialog

To create a command-line file

1 If you wish to run selected Schedule Items automatically using 
a third-party scheduling tool, select Create Command-Line 
File from the File menu.

Fig. 312 NETinventory Console File Menu 
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Creating a New Schedule Item
The Command-Line File Creation dialog appears. 

Fig. 313 Command-Line File Creation Dialog

2 Double-click to add the Schedule Items you want to run 
automatically. The Schedule Items will run in the sequence you 
select them. You can set up the same Schedule Item to run 
multiple times.

Enter Comments describing the type of command line file. It is 
a good idea to note the purpose of the file as well as the 
individuals who will receive the information generated when the 
Schedule Items automatically run.

3 Enter the Current User Password. Asterisks (*) appear in 
place of the password you enter.

4 Enter the Command-Line File Name or press the browse (...) 
button and enter the file name in the search window.

The File Name extension must be .ARF.

Fig. 314 Command-Line File (Auto Run File) Dialog 
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Changing Existing Schedule Items
5 Enter the command-line file name and Schedule run details into 
your third-party scheduling program.

You can use any third-party scheduling application to set a date and 
time to run a Schedule item. You can use any scheduler program 
you choose with the NETinventory Console, including the Windows 
task scheduler. When the scheduling program starts the Command-
line file, the NETinventory Console will start and use the current 
user’s name and the password you supplied to process the queries 
in the schedule. 

Changing Existing 
Schedule Items 

You can make changes to an existing schedule item if you need to 
add items to or delete items from an existing schedule. 

To modify an existing Schedule

1 Right-click a Schedule item and select Modify Definition or 
choose Modify Definition from the Edit menu. The Select 
Items for Scheduling dialog appears. 

Fig. 315 Select Items for Scheduling Dialog 

2 Add items to the schedule, delete items from the schedule, or 
change the Advanced Schedule Options. 

3 Click OK to save the changes you have made to the Schedule.

Sharing Items 
Between Desktops

The NETinventory Console provides two ways to share Grid or 
Graph items. You can send and receive references to items or 
export and import items. 
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Sending/Receiving References to Report Items
References create a link that exists on more than one NETinventory 
Console desktop. Changes made to an item by one user affect other 
users of the item. If you export items and then import them into 
another desktop, the items are copied; there is no link between an 
item and its copy. Copies can be modified without any impact on 
the original item. 

When a reference is sent to another user’s desktop, the sender can 
control the recipient’s the ability to modify the item.

Sending/Receiving 
References to Report 
Items

References are links to Grid and Graph items. References can be 
from one NETinventory Console desktop to another. You can send 
and receive references to Grids, Graphs, or Schedules.

Fig. 316 illustrates how references work. 

Sending and receiving references allows items to be shared while 
keeping control over item definitions. This allows corporate 
standardization, while still allowing multiple users to generate the 
report. If you change an item definition, all references to the item 
will reflect the changes.

FMGR.DAT file
The FMGR.DAT file contains 
desktop information for all 
defined users. Depending on how 
the NETinventory Console is 
installed, this file may reside on a local 
or network drive.

User Desktop #1
When an item is created, is appears on 
the creator’s desktop. The report 
definition is stored in the FMGR.DAT 
file, which can be on a local drive or a 
network drive—depending on how you 
installed the NETinventory Console.

User Desktop #2
A user’s desktop can contain a reference 
to an item created by another user. A 
reference to the item was sent from one 
user’s desktop to another user’s 
desktop. The reference “points” to the 
Report Item definition in the FMGR.DAT 
file.

Original
Report

Reference to
Original Report

Reference
The reference shown on the Desktop 
above (Desktop #2) “links” to the 
same Report Item definition contained 
in the FMGR.DAT file. The user who 
received the reference can modify the 
underlying item definition if the sender 
gave permission to modify it.

Fig. 316 References to Desktop 
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Sending/Receiving References to Report Items
Note: References within a single desktop provide easy access to the 
most-used items. Using references, a single report is accessible 
from multiple NETinventory Console folders. 

A reference does not create a copy of the item. Deleting the 
references does not delete the original item, only the reference. 

To send a reference

1 Choose Send References from the Desktop menu. The 
Select Items to Send dialog appears. 

Fig. 317 Select Items to Send Dialog

2 Choose a user from the Send References To drop-down list.

3 Select the items to be sent as references and click Add or click 
Add All to add all items in the active folder to the list of items 
to send. Repeat to add items to send as references.

4 Click Send to send the items as references. A message when 
the items have been sent as references.

5 Click Close to close the Select Items to Send dialog.

To receive a reference

1 Select Receive References from the Desktop menu. 
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Sending/Receiving References to Report Items
2 If there are no new received references, a message will inform 
you that there are no new references. Click OK to close the 
dialog. 

Fig. 318 No References to Receive Dialog

3 If there are new received references, the Receive Item 
References dialog appears. Select the folder where you want 
to save the references.

Fig. 319 Receive Item References Dialog 

4 Select the References to place in the selected folder.

5 Click Add To Selected Folder. The references are added to 
your desktop.

6 Click OK to close the Receive Item References dialog.
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Copying Items
To scan for new references

Scanning for references alerts you when references are waiting to 
be received.

1 Choose Scan for New References from the Desktop menu. 
The Incoming Reference Options dialog appears.

Fig. 320 Incoming Reference Options Dialog 

2 Select an option for saving the references and click OK. The 
NETinventory Console will process the incoming references and 
close the dialog. 

Copying Items Copying an item creates an entirely new item definition. Copying 
differs from creating a reference to an item because when an item 
is copied the connection or reference to the original item is 
removed.

To copy an item

Right-click an item and select Duplicate. 

The copied item is placed in the current folder.

Exporting and 
Importing Items

The NETinventory Console has the ability to export and import 
report items or entire user desktops. Exporting and importing a 
desktop allows you to replicate a desktop setup for a new user. 
Exporting and importing report items allows you to give another 
user a copy of a report item that they can make changes to without 
affecting the original. 

Any user can be given the right to export and import report items. 
Exporting and Importing report items gives the person importing 
the items the ability to run them from their own desktop. Since 
there are multiple copies of the items in the FMGR.DAT file, each 
can be modified independently of the other. Changes to the query in 
the exported copy of the report item are not reflected in the original 
item.

Exporting and importing Grid and Graph items allows you to share 
Grids and Graphs from one NETinventory Console installation to 
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Exporting and Importing Items
another. In contrast, references remain within a single installation 
of the NETinventory Console

Exporting and 
Importing Individual 
Report Items

Exported items are saved by the NETinventory Console in *.EXP 
(exported item) files. The exported files must be accessible to the 
NETinventory Console to import them. 

To export report items

You can export the contents of an entire folder tab and its contents, 
a subfolder and its contents, or individual grids or graphs.

1 Select the Folder, Subfolder, Grid, or Graph to export. 

2 In the NETinventory Console, choose Desktop>Export Item. 
The Save As dialog appears.

Fig. 321 Save As Dialog

3 Enter a file name for the export file. The file’s name must end in 
the *.EXP extension.

4 Select the location to save the export file.

5 Click OK. The NETinventory Console saves the export file.

To import report items

1 In the NETinventory Console, choose Desktop>Import Item. 
The Open dialog appears. 

Fig. 322 Open Dialog

2 Select the exported file (*.EXP) to import. The name of the 
selected file appears in the File name field.
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Exporting and Importing Items
3 Click OK. The Enter Item Name dialog appears. 

Fig. 323 Enter Item Name Dialog

4 Type the name to assign to the item on the Desktop and click 
OK. An imported Grid, Graph, or Subfolder will be imported into 
the currently selected folder. An imported top-level Folder will 
create a new folder tab.

Exporting and 
Importing an Entire 
Desktop

The NETinventory Console allows you to import an entire Desktop 
that was exported from another NETinventory Console user’s 
Desktop. 

Note: You must be logged in to the NETinventory Console using the 
BV Admin user account to import a Desktop and its entire contents. 
When you import a Desktop, a new user account is created. Only 
the BV Admin account can create new accounts.

When you export the contents of an entire Desktop, the following 
items are saved in a *.DSK file:

• Console toolbar configuration
• Folders
• Subfolders
• Grids
• Graphs

Note: When exporting an entire user Desktop, Schedule Items are 
not included.

To export an entire desktop

1 In the NETinventory Console, choose Desktop>Export User 
Desktop. The Save As dialog appears.

Fig. 324 Save As Dialog
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Exporting and Importing Items
2 Enter a file name for the Desktop export file. The file’s name 
must end in the *.DSK extension.

3 Select the location to save the Desktop (*.DSK) file.

4 Click OK. The NETinventory Console saves the Desktop file and 
the Save As dialog disappears.

To import an entire Desktop 

Note: You must be logged into the NETinventory Console using the 
BV Admin account to import an entire desktop.

1 In the NETinventory Console, choose Desktop>Import User 
Desktop. The Open dialog appears. 

Fig. 325 Open Dialog

2 Select the exported Desktop file (*.DSK) to import. The name 
of the selected file appears in the File name field.

3 Click OK. The Enter User Account Information dialog appears. 

Fig. 326 Enter User Account Information Dialog

4 Enter a User Name and Password for the new account, then 
verify the password and click OK. The NETinventory Console 
Window reappears. The NETinventory Console is now logged in 
to the new user’s account using the imported Desktop.
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14 Printing an Item

In This Chapter Customizing a Grid Report ........................................ 316
Customizing a Graph Item ........................................ 323
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Customizing a Grid Report
Customizing a 
Grid Report

A report is the printed output of a Grid. To customize a report, use 
the Page Setup options to change the appearance of reports.

Fig. 327 Page Setup Dialog - Printer/Page Settings Tab

The Printer/Page Settings tab settings are the most important 
for report construction and overall appearance.

To open the Page Setup dialog

Open a Grid. Choose Page Setup from the file menu. 

or

Right-click any Grid item and choose Modify Definition. Click 
Page Setup. 

or

Select any Grid item and choose Edit>Modify Definition. 
Click Page Setup.

The Page Setup dialog appears. 

Using the Printer/
Page Settings Tab

The Printer/Page Settings Tab allows you to make changes to the 
basic appearance of the report, including fonts, margins, and so on. 
You can also select the printer the report will print to. 
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Using the Spreadsheet Style Options Tab
Table 12, “Page Setup - Printer/Page Settings Tab”  explains the 
Printer/Page Settings options.

Using the Spreadsheet 
Style Options Tab

The Spreadsheet Style Options tab lets you control the appearance 
of Spreadsheet style reports.

Fig. 328 Page Setup Dialog - Spreadsheet Style Options Tab

If Spreadsheet Style is selected on the Printer/Page Settings tab, 
the options on the Spreadsheet Style Options tab are available to 
customize the report.

Use the Spreadsheet Style Options tab to define the style of column 
titles and record data, specify calculations and/or statistics for 

Table 12  Page Setup - Printer/Page Settings Tab
 

Setting Behavior

Spreadsheet Style or Form 
Style.

Determines the output style of a 
report

Base Font Determines the font used on a 
Spreadsheet style report 

Form Font Determines the font used on a of a 
form style report 

Report Margins Sets the left, right, top, and bottom 
margins on the printed report. 

Printer Setup Opens the Print Setup dialog, 
allowing you to control the printer for 
the report. 
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Using the Spreadsheet Style Options Tab
selected fields, and further define general layout Options for the 
spreadsheet. 

Table 13, “Page Setup - Spreadsheet Style Options Tab”  explains 
the Spreadsheet Style Options settings. 

Table 13  Page Setup - Spreadsheet Style Options Tab 

Setting Behavior

Column Titles:Style Sets the style options for report 
Column Titles

Record Data:Style Sets the style options for record 
data in a report table

Calculations/Statistics Allows you to add one of the four 
statistic types to the currently-
selected field. Select a statistic type 
to add it to the report. Each field 
can have statistics added 
independently. 

Column titles justify with data? Aligns titles of columns with data in 
the tables

Suppress spreadsheet data? Suppresses record data and shows 
only statistics 

Show record counts? Displays the number of records 
generated by a query at the bottom 
of the report.

Group data on field? Groups data on the named field

Force page-break on group data 
change?

Forces a page break when group 
data changes. Only available when 
Group Data on field is selected. 
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Using the Form Style Options Tab
Using the Form Style 
Options Tab

The Form Style Options tab allows you to make changes to 
reports printed as forms.

Fig. 329 Page Setup Dialog - Form Style Options Tab

The Form Style Options tab allows you to hide empty Form or List 
Fields, insert page breaks between Form/List Fields, and align titles 
of single line fields to the left or right side of the page. 

Table 14, “Page Setup - Form Style Options Tab”  explains the Form 
Style Options settings.

Table 14  Page Setup - Form Style Options Tab 

Setting Behavior

Insert page break between 
records?

Inserts a page break after every 
record. 

Title Justification for single 
line fields

Right- or left- justifies titles for single 
line fields 
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Using the Report Header Tab
Using the Report 
Header Tab

Use the Report Header Options tab to define report title and subtitle 
style options, fonts, and text justification. Also use it to include or 
exclude author, sorting and filtering information in the report. 

Fig. 330 Page Setup Dialog - Report Header Options Tab

Table 15  Page Setup - Report Header Tab 

Setting Behavior

Use item name as title text Adds the query name as a title for the 
report. 

Report Title field Type a title to use for the report. Use 
item name as title text must be 
unchecked. 

Use item name as subtitle 
text

Adds the query name as a subtitle for the 
report. 

Report Subtitle field Type a subtitle to use for the report. Use 
item name as subtitle text must be 
unchecked. 

Field Layout Adds information about the report to the 
report. Choose a report information 
format from the drop-down list. 

Include “Sorted By” Adds sort criteria to the report 
information area of a report. 

Include “Filtered On” Adds filter criteria to the report 
information area of the report.
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Using the Report Header Tab
Alignment buttons 
Changes the alignment of the title or 
subtitle. You can select Left- or Right-
justified or centered. 

Font Changes the title or subtitle font.

Style Change a title or subtitle style.

Single Page button 

Double Page button

When the Single Page button is selected, 
that header type will appear only on the 
first page of a report. When the Double 
Page button is selected, the header 
information will appear on every page. 

Table 15  Page Setup - Report Header Tab  (Continued)

Setting Behavior
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Using the Report Footer Tab
Using the Report 
Footer Tab

Use the Report Footer tab to define the contents of report footers. 
You may specify the style and font for three separate footer lines. 
In addition, you may choose whether or not to number the pages, 
as well as designate page number alignment. 

Fig. 331 Page Setup Dialog - Report Footer Tab

Table 16, “Page Setup - Report Footer Tab” explains the Report 
Footer options. 

Table 16  Page Setup - Report Footer Tab 

Setting Behavior

Footer Line 1/Footer Line 2 Enter footer text in the Footer Line 1 
or the Footer Line 2 fields. 

Style Changes the footer style.

Font Change a footer font.

Add page numbers to a report ....the Report Footer tab and select 
Show page number option. The 
page number will print on Footer Line 
3. 

Alignment buttons 
Changes the alignment of the footer. 
You can select Left- or Right-justified 
or centered. 

Show company logo? Displays the BindView logo in the 
footer of the report. 

Logo Justification Aligns the logo to the left, center, or 
right of the footer. 
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Customizing a Graph Item
Customizing a 
Graph Item

Graph Setup allows you to make changes to the appearance of a 
graph when creating or modifying a Graph Item and from an open 
Graph. The Graph Setup dialog contains three tab pages: Type, 
Layout, and Data Point. These tab pages control the layout of the 
Graph. 

To access Graph Setup 

1 Right-click a Graph Item and select Modify Definition from 
the menu or select a Graph Item and select Modify Definition 
from the Edit menu. 

or

Open a graph and Select Modify Graph from the Graph menu.

The Modify Graph Definition dialog appears. 

Fig. 332 Modify Graph Definition Dialog

Show page number? Displays the page number of the 
report in footer line 3. 

Page Number Justification? Aligns the page number to the left, 
center, or right of the footer. 

Table 16  Page Setup - Report Footer Tab  (Continued)

Setting Behavior
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Using the Type Tab
2 Click Graph Setup. The Graph Setup dialog appears. 

Fig. 333 Graph Setup Dialog - Type Tab

Using the Type Tab Use the options on the Type tab to select the type of Graph to 
produce and whether to graph data as a histogram or a series. If 
324 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Using the Type Tab
you graph as a series you can select which fields to graph along the 
Y Axis.

Fig. 334 Graph Setup Dialog - Type Tab

Table 17  Graph Setup - Type Tab 

Setting Behavior

Graph type Determines the graphs’ basic 
appearance. Select 2D or 3D and 
then click the icon for the type of 
graph to display. 

X Axis Field The field selected for this option is 
the X axis of the Graph.

Y Axis Field Select one or more Y Axis Field(s). 
The Y axis fields are available when 
creating a series and can contain all 
of the numeric fields selected for the 
query

Histogram/Series Toggle between histogram and 
series chart. The histogram 
calculates and displays individual 
and cumulative frequencies for a 
range of data. Series Graphs display 
multiple field values for a given 
record. 
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Using the Layout Tab
Using the Layout Tab The Layout tab allows you to add titles and a legend for the Graph. 
You can also modify the appearance of the Graph using the Sort, 
Series and Calculation options.

Fig. 335 Graph Setup Dialog - Layout Tab

Table 18  Graph Setup - Layout Tab 

If you want to... Go to... 

Graph Title The main heading for the graph. 

X Axis Label/Y Axis Label The label for the selected axis. You can 
add, change, or delete axis labels.

Insert Legend Adds a legend to the graph.

No Sort/Descending/
Ascending

Changes the sort order of the Graph. 
The sort option determines the order of 
each data point in the Graph. The sort 
option is used in conjunction with a 
Histogram Graph.

Series: In Rows/In Columns Plots series Graphs using Rows or 
Columns.

Combine Like Values Allows you to combine similar values 
into one value. The combination of 
values can be a Sum, Average, 
Minimum, or Maximum. Available only 
when the for Series type graphs. 
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Using the Data Point Tab from Graph Setup
Using the Data Point 
Tab from Graph Setup

The Data Point tab determines which Data Point labels to use and 
where to position them on a Graph. When Data Point Location 
and Data Point Labels are selected, the labels are applied to all 
data points in a series. You can make changes to the individual 
labels using the full Graph view. If you have applied changes while 
using full Graph view, and wish to have the Data Point tab options 
applied, click the Reset to Defaults.

Fig. 336 Graph Setup Dialog - Data Point Tab

There are three Data Point Labels which may be added individually or in 
combination to a Graph. The labels are Value, Percent, and Series. The 
labels can be positioned in different locations on the Graph. The options for 
data point placement vary by Graph type. The positions include: None, 
Above Point, Below Point, Center, Base, Inside, Outside, Left, and Right. 

Table 19  Graph Setup - Data Point Tab 

Setting Behavior

Data Point Location Determines where data points are 
displayed on the graph. Only 
appropriate options for the graph 
type selected on the Type tab are 
available. 

Data Point Labels Selects the type of information 
displayed for each data point. You 
can add the Value, Percent, or 
Series Name.

Reset to Series Defaults Resets series options to the 
settings in the Data Point tab.
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Print a Graph
Print a Graph Once you have set up your graph’s options, you can print the graph 
to any printer you have defined. 

To print a Graph

1 Click the Print Graph icon on the toolbar.

2 Configure your printer and then click Print. 

3 Close the Graph when finished.

Advanced Graph 
Options

In addition to the graphing options in Graph Setup, there is an 
additional set of advanced graphing options. These options are 
available from an open Graph by right-clicking the Graph or by 
selecting Graph from the main menu and then clicking Advanced 
Options. 

Filtering Out “Special 
Values” in Graphs

When making Graphs of numerical fields (such as “Maximum 
Connections” or “Account Balance”), it is necessary to filter out any 
non-numerical replies that might occur. For instance, the value of 
“Maximum Connections” could be “N/A” if Concurrent Connections 
are not limited for that user. When these non-numeric answers 
show up in a Graph, it distorts the values of the answers. 

Making sure these values don't occur is as simple as setting a filter 
not to include records whose values are equal to one of these 
“special values”. For example a filter of “Maximum Connections Not 
Equal to N/A” would remove these items from the Graph in this 
case. This is easy to do because the intelligent filter picker in the 
NETinventory Console will prompt you with these values as options. 

Rotating, Copying, 
and Pasting Graphs

When a Graph is displayed on screen in 3-D mode, you can press 
the CTRL key and use the mouse to rotate the Graph to view it from 
different angles and perspectives. Additionally, Graphs may be cut 
and pasted into other applications that support graphics by clicking 
on the Graph so that its box is highlighted and performing a 
standard Windows COPY operation (CTRL-C or Edit>Copy).

Hints for Making 
Better Graphs

When creating Graphs it is important to remove extra information 
or “noise” from the Graph and present only the information that is 
essential. The suggestions below will assist you in accomplishing 
this.

Eliminate Non-essential 
Text

By eliminating non-essential text, the actual Graph data is displayed 
at its largest possible size. Graph labels should be sized as small as 
possible while still displaying the necessary information. Making the 
labels smaller occupies less viewing area. 

Reduce the Number of 
Plotted Values

You can reduce the number of plotted values through the use of 
Scope and Filtering specifications. Both of these features are 
available in the Query Builder.
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15 Exporting Grid Data
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Exporting Grid Data
Exporting Grid 
Data

You can export information collected by Grid items for use in a 
document created by another program. The NETinventory Console 
ships with many of the most common formats already defined.

• You can export to a delimited text file.
• You can export to a fixed-field text file. 
• You can export to a dBASE file. 
• You can export data to spreadsheet and word processing 

programs including:
- Lotus® 1-2-3
- Excel
- Microsoft® Word
- WordPerfect®
- Quattro Pro®

Note: When you export to Microsoft Excel or Microsoft Word file 
formats, be sure to use the correct export device for the version of 
the Microsoft application file format you wish to export. To export to 
the most recent versions of Microsoft file formats, you must have 
the Microsoft application you are exporting to installed on the same 
machine as the NETinventory Console. 

Several export file types are pre-defined in the NETinventory 
Console and appear in the Export Data dialog (Fig. 338 on page 
333). To export to a file type not shown in the Export Data dialog, 
add it as an export device type. See “Managing Export Devices” on 
page 333.

Table 20 on page 330 lists the Export Device Types supported by 
the NETinventory Console and describes:

• Whether they appear by default in the Export Data dialog or if 
they must be defined before they can be used. 

• Whether the export device type can append data to a file.
• The limit on the number of records that device type can export.

Table 21 on page 331 lists the Export Device Types supported by 
the NETinventory Console and lists export device type 
considerations. 

Table 20  Grid Data Export Properties 

Export Device 
Type

Pre-defined in 
Console?

Can Append to 
Data File?

Record 
Limit?

ASCII Delimited Text 
File

Yes Yes Drive Space

ASCII Fixed Field 
Text File

Yes Yes Drive Space

bv-Web Export Yes Yes Drive Space

dBASE IV Yes Yes Drive Space
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Exporting Grid Data
Lotus 1-2-3 v.5.x Yes Yes 32,000

Microsoft Excel 5.0, 
95, 97

Yes Yes 32,000

Microsoft Excel OLE 
Table

Yes Yes 65,000

Microsoft Word 2.x 
Table

No No 32,000

Microsoft Word OLE 
Table (6.0, 95, 97) 

Yes No 32,000

Quattro Pro Yes Yes 32,000

Table 21  Grid Data Export Considerations 

Export Device Type Considerations

ASCII Delimited Text File [FORM] fields are indicated but not exported.

ASCII Fixed Field Text File [FORM] fields are indicated but not exported.

dBASE IV The fastest export device type. Fully supports 
[FORM] fields. When a Grid including [FORM] 
fields is exported with this device type, two 
files are created (*.dbf and *.dbt) The *.dbt 
file contains the information found in the 
[FORM] fields. When the *.dbf file is opened, it 
automatically opens the *.dbt file. Both files 
must reside in the same directory for the 
[FORM] fields to be displayed. MAPI compliant 
e-mail programs attach both files to a single 
e-mail message.

Lotus 1-2-3 v.5.x [FORM] fields are exported, but may be 
truncated.

Microsoft Excel 5.0 Opening Excel 5.0 (non-OLE) exported files 
using Excel 95 or 97 causes an invalid page 
fault. The file will open correctly using Excel 
from Office 4.3. [FORM] fields are exported, 
but may be truncated.

Table 20  Grid Data Export Properties  (Continued)

Export Device 
Type

Pre-defined in 
Console?

Can Append to 
Data File?

Record 
Limit?
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Exporting Grid Data
To export grid data

1 Double-click a Grid item to run the query.

2 Choose Export Data from the File menu, or click the Export 
Data icon on the toolbar.

Fig. 337 NETinventory Console File Menu

3 In the Export Data dialog, click the Basic tab. 

4 Select the desired Export Device. Click Browse to select the 
directory. 

Microsoft Excel OLE Table Used for exporting to Excel 6.0, 95, 97. 2000, 
and XP. OLE exports can take a long time to 
complete, even on fast PCs. To perform OLE 
exports, the appropriate Microsoft application 
must be installed. If you get an error message 
that says “Unable to read target file” or “Excel 
6, 95, or 97 must be installed”, you may need 
to install the Data Access Add-on pack version 
8.0.4031. It should be located on the Office 97 
CD-ROM in the \VALUPACK\DATAACC directory. 
[FORM] fields are exported, but may be 
truncated.

Microsoft Word OLE Table Used for exporting to Word 6.0, 95, 97, 2000, 
and XP. OLE exports can take a long time to 
complete, even on fast PCs. To perform OLE 
exports, the appropriate Microsoft application 
must be installed. If you get an error message 
that says “Unable to read target file” or “Excel 
6, 95, or 97 must be installed”, you may need 
to install the Data Access Add-on pack version 
8.0.4031. It should be located on the Office 97 
CD-ROM in the \VALUPACK\DATAACC directory. 
[FORM] fields are exported, but may be 
truncated.

Quattro Pro [FORM] fields are exported, but may be 
truncated.

Table 21  Grid Data Export Considerations  (Continued)

Export Device Type Considerations
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Managing Export Devices
5 Enter the File Name for the exported data. Some export devices 
allow data to be appended to the end of the file. Select the 
Append data if file exists check box to append the export 
data to the end of an existing file.

Fig. 338 Export Data Dialog - Basic Tab

6 Select the Advanced tab in the Export Data dialog.

7 Edit the Advanced settings for the chosen Export Device if 
required. To run programs before or after the data is exported, 
click Browse and choose the program to run.

Fig. 339 Export Data Dialog - Advanced Tab

8 Click OK to complete the export.

Managing Export 
Devices

You can configure defaults for all export devices. You can also 
define new export devices using pre-defined file formats. 
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Managing Export Devices
To set export device Defaults

1 Choose Manage Export Devices from the Options menu. 

Fig. 340 NETinventory Console - Options Menu

2 Select an Export Device type and enter a default file name, 
directory, and extension for the export destination. 

Fig. 341 Manage Export Devices - Basic Tab

3 Select the Advanced tab. 

Fig. 342 Manage Export Devices - Advanced Tab
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Managing Export Devices
4 Select Export Field Names to include the export field name(s) 
and change field separators or delimiters and programs to run 
before or after export if needed.

5 Click OK to save the changes to the export device defaults. 

To create a new export device

1 Open the Manage Export Devices dialog.

Fig. 343 Manage Export Devices - Basic Tab

2 Click Add. The Add a New Export Device dialog appears. 

Fig. 344 Add a New Export Device Dialog

3 Enter a name for the new export device and select the file 
format the device should use from the Device Type drop-down 
list. 

4 Click OK to create the device. 

5 Set the device options using the Manage Export Devices 
dialog. 

6 Click OK to save the new export device. 
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User Desktop
User Desktop When you log into the NETinventory Console, a personal workspace, 
called the “desktop,” appears. Every user of a single copy of the 
NETinventory Console has a unique Desktop. User Desktops can be 
configured to meet individual needs by including pre-defined 
reports and queries. Users can create individual views of system 
management information and organize them as they wish.

When you install the NETinventory Console, a single account—the 
BV Admin account—exists by default. Any other accounts must be 
created while logged in using the BV Admin account. 

BV Admin Account The BV Admin user account is the administration account for the 
NETinventory Console. The BV Admin user account is used to add 
new user accounts, modify existing accounts, and edit other users’ 
desktops. The BV Admin user account cannot be deleted or 
modified. You should generally only use the BV Admin account to 
modify users. You should export and import query items or use 
references to set user desktops up with query items. 

Modifying Desktops of 
Other Users

The BV Admin user is the only user account that can add and delete 
items on other users’ desktops. This allows the BV Admin user to 
set up a user account that has rights to run items but cannot create 
new items or modify existing ones. The BV Admin user can then add 
the items for the user to run.

To add a new user account

1 Select User Account Administration from the Desktop menu. 
The User Account Administration dialog appears. 

Fig. 345 User Account Administration Dialog
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BV Admin Account
2 Click Add User. The Enter User Account Information dialog 
appears. 

Fig. 346 Enter User Account Information Dialog

3 Enter a User Name and Password, re-enter the Password in the 
Verify Password field and select the account options to set. 

4 Click OK to add the user account to the NETinventory Console.

To modify an existing user account

1 Select User Account Administration from the Desktop menu. 
The User Account Administration dialog appears.

Fig. 347 User Account Administration Dialog
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Changing Account Passwords
2 Select the user account to be changed and click Modify User. 
The Enter User Account Information dialog appears. 

Fig. 348 Enter User Account Information Dialog

3 Make any changes to the account options. 

4 Click OK to close the dialog and save the changes. 

To delete an existing user account

1 Select User Account Administration from the Desktop menu. 
The User Account Administrations dialog appears. 

Fig. 349 User Account Administration Dialog

2 Select the user account to delete.

3 Click Delete User.

4 Click Yes to confirm that you want to delete the account. 

Changing Account 
Passwords

User accounts (including the BV Admin account) have passwords 
attached that prevent other users from accessing the personal 
desktop. The BV Admin account can change any user’s password 
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Console Default Configuration Settings
using the User Account Administration dialog; other users use 
the Change Password dialog to change their own password. 

To change the account password 

1 From the Desktop Menu, select Change Password. The Enter 
New Password dialog appears. 

Fig. 350 Enter New Password Dialog

2 Enter the old password, then the new password, and re-enter 
the new password to verify. 

3 Click OK to save the new password. 

Console Default 
Configuration 
Settings

When a user account is created, many aspects of the NETinventory 
Console are automatically configured using default settings. These 
defaults are listed in the Console Defaults tab dialog.

Default Data Formats: When a query is processed, the results are 
displayed using the user’s default data format settings. These 
settings include data and time and number formats and whether 
“yes” and “no” or “true” and “false” are used for the logical field.

Default Toolbar Settings: The NETinventory Console uses 
customizable toolbars. Each toolbar can be customized to include 
the features and commands most frequently accessed. 

Default Page Setup Settings: When creating a new Grid report 
item, the reporting engine uses the default settings from Page 
Setup. These settings control the appearance of the report, 
including the style, headers and footers, margins, and fonts. 

Default Display Font for a Grid: You can specify a default font to 
be used when displaying Grid data. This font can be customized for 
individual reports. 

Default E-Mail Settings: You can specify default e-mail settings 
that should be used when exporting via e-mail. 

Default Grid Settings The Default Grid Settings include the default font for new Grid 
reports and the default Page Setup for new printed Grid reports. 
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Default Grid Settings
Default Display Font The “display font” is the type, style, and size of the font used to 
display data in a Grid. It is also the default font used for printed 
reports. 

To set a default display font

1 Select Console Defaults from the Options menu. 

The Console Defaults dialog appears.

2 Click the Default Grid Settings tab.

Fig. 351 Console Defaults Dialog - Default Grid Settings Tab

3 Click Display Font. The Font dialog appears. 

4 Select the type, style and size of the Grid font to be used. 

5 Click OK to close the Font dialog. 

Default Page Setup You can configure the Default Page Setup options for all Grid items, 
or you can configure individual Page Setup options for each Grid 
item. Page Setup options are saved with each Grid item, so changes 
to the defaults do not affect existing Grid items. 
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To set page setup defaults

1 Select Console Defaults from the Options menu. The 
Console Defaults dialog appears. If it is not selected, select 
the Default Grid Settings tab.

Fig. 352 Console Defaults Dialog - Default Grid Settings Tab

2 Click Page Setup. The Page Setup Defaults dialog appears. 
The Page Setup Defaults options are identical to the Page 
Setup options. For complete information on Page Setup 
options, see “Customizing a Grid Report” on page 316.

3 When you have configured the Page Setup Defaults, click OK to 
save the changes and close the Page Setup Defaults dialog. 

Default Data Format 
Settings 

The Default Data Format Settings tab allows you to define the 
format for displayed Grid data. You can set the appearance of the 
date, time, numbers, and logical format (yes/no or true/false).

To set data format defaults

1 Select Console Defaults from the Options menu. 

Fig. 353 NETinventory Console Options Menu - Console 
Defaults
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Default Toolbar Settings
2 Select the Default Data Format Settings tab.   

Fig. 354 Console Defaults

3 Click OK when you have set the Data Format Defaults. 

Default Toolbar 
Settings 

The NETinventory Console uses customizable toolbars. Each toolbar 
can be customized to include the features and commands most 
frequently accessed.

To configure default toolbar settings

1 Select Console Defaults from the Options menu. 

Fig. 355 NETinventory Console Options Menu - Console 
Defaults

Default format 
for time

Default format 
for data that 
includes both 
date and times

Default format 
for numbers

Default format 
for dates

Default 
format for 
display of 
logical data
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Default E-mail Settings
2 Select the Default Toolbar Settings tab.

Fig. 356 Console Defaults Dialog - Default Toolbar Settings 
Tab

3 The main toolbar screen has settings that apply to all toolbars. 
Select the position, size, and visibility settings for all toolbars.

4 Use the buttons along the lower part of the screen to configure 
individual toolbars. You can select the actions available in the 
toolbar.

Default E-mail 
Settings

The NETinventory Console supports both VIM-based and MAPI-
based e-mail. If you select VIM e-mail support, you must enter a 
P.O. (Post Office) Directory. If you select MAPI e-mail support, you 
must enter a MAPI Profile Name.

User Name: The default e-mail user name for the sender.

Password: The default e-mail password for the sender.

Mail Program: The type of e-mail program to use. You may choose 
either Vendor Independent Messaging (VIM) or Messaging 
Application Programmer Interface (MAPI) e-mail.

P.O. Directory: If you select VIM e-mail as a default, you must 
specify the directory of the VIM mail post office. Use the entire 
path.

Profile Name: If you select MAPI e-mail as a default, you must 
specify the sender’s MAPI profile name.
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Managing Licenses
To configure default e-mail settings

1 Select Console Defaults from the Options menu. 

Fig. 357 NETinventory Console Options Menu- Console 
Defaults

The Console Defaults dialog appears, as shown in Fig. 358.

2 Select the Default E-mail Settings tab. 

Fig. 358 Console Defaults Dialog

3 Enter in the user name and password, and the P.O. directory or 
MAPI Profile Name of the user who will send E-mail reports.

4 Click OK to close the Console Defaults dialog and save the 
changes. 

Managing 
Licenses

The NETinventory Console, NETinventory, and NETrc all require 
licenses. The NETinventory Console stores license information in a 
file named LICENSE.DAT in the same folder as the NETinventory 
Console installation. The BINDVIEW.INI file points to the location of 
the LICENSE.DAT file. You can view NETinventory Console licenses 
using the BindView License Manager, which can be accessed from 
within the BindView Console.

There are several options available within the License Manager:

• License File – Shows the location of the LICENSE.DAT file as 
defined in the BINDVIEW.INI file.

• Installed Licenses – Lists the licenses currently installed.
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Managing Licenses
• Add – Displays the NETinventory Console License Installation 
screen, allowing you to add a new license key code shipped with a 
package or module.

• Remove – Displays the NETinventory Console License Removal 
dialog, allowing you to remove a license.

• Details – Displays the NETinventory Console License Information 
screen. This screen displays the License Type, Version Number, 
Serial Number, Duration, Expiration Date, and a Unit Count for 
specific licenses.

• Print – Allows you to print a detailed report about the BindView 
licenses installed on your network.

To manage licenses

1 Select Manage Licenses from the Options menu. 

Fig. 359 NETinventory Console Options Menu - Manage 
Licenses

2 Click the desired Manage License function from the 
NETinventory Console License Manager. 

Fig. 360 NETinventory Console License Manager
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location of the 
LICENSE.DAT file as 
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BINDVIEW.INI file

Installed Licenses: List 
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Console License 
Installation 
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you to add a new 
license key code

Remove: 
Allows you to 
remove the 
selected 
license

Details: 
Displays the 
NETinventory 
Console License 
Information 
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Print: Allows 
you to print a 
detailed report 
about the 
NETinventory 
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Have Disk: 
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install licenses 
from a 
diskette
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Section 4: NETrc
Setting up and Using the NETrc Module
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What is NETrc?
What is NETrc? NETrc® is a Snap-in Module for the NETinventory Console. It works 
in conjunction with and requires the NETinventory Console and the 
NETinventory Snap-in Module. Together they allow you to remotely 
view and control workstations on your enterprise network. Before 
using NETrc, you must use the BindView Setup program to install 
the NETinventory Console and NETinventory along with the NETrc 
Snap-in Module. 

NETinventory 
Console and NETrc

Since NETrc is a Snap-in Module for the NETinventory Console, it 
cannot stand alone; it requires essential services provided by the 
NETinventory Console. To use NETrc to control a workstation on 
your enterprise network, you first use the NETinventory Console to 
configure both NETrc and NETinventory to install the NETrc Host 
software on the workstation during an audit. Once the audit is 
complete and the NETrc Host software is installed and running, you 
use the NETinventory Console to generate a list of audited nodes. 
Using this list, you select a node with NETrc installed and take 
control. 

NETrc and 
NETinventory

Just as it relies on the NETinventory Console to provide a user 
interface and other essential services, NETrc relies on NETinventory 
for other services. In particular, the NETinventory Audit Agent is 
used to automatically install the NETrc Host on machines you 
designate. The Audit Agent also updates preference files stored with 
the Host software, and removes the Host when needed. In addition, 
the NETinventory Master Server and Audit Servers house the NETrc 
License database. 

NETrc 
Architecture

NETrc consists of three parts: the first two reside on the machine 
that hosts the NETinventory Console; the third is installed on 
machines you select during an audit by the NETinventory Audit 
Agent. The NETrc Console components and the NETrc Master are 
installed automatically with the NETinventory Console, while the 
NETrc Host software is installed on every machine you designate. 

NETrc Console 
Components

NETrc extends the capabilities of the NETinventory Console. The 
NETrc Console components are used to enable and disable NETrc, to 
configure Master and Host settings, to set a default profile for nodes 
on your network, and to configure profiles. Finally, the NETrc 
Console components are used to administer NETrc Licenses, and to 
distribute them among NETinventory Audit Servers. 

The NETinventory Console components add an ActiveAdmin control 
to NETinventory result sets in the NETinventory Console. The 
ActiveAdmin control allows you to take control of a node. Finally, 
the NETinventory Node Manager is used to assign a NETrc Profile to 
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NETrc Master
a particular node or to take control of a node that has the NETrc 
Host installed. 

NETrc Master When you view or take control of a node with the NETinventory 
Console, the NETrc Master launches automatically. The Master 
connects to the node using parameters passed to it by the 
NETinventory Console. It then displays the screen of the controlled 
node in a window on your desktop. 

NETrc Host The NETrc Host software runs on the workstations on your 
enterprise network and allows a computer (called the remote host) 
to accept connections from a master so that its display is visible to 
that master and its user interface can be controlled by it. The Host 
and the Master both have integral security features, so that only a 
NETrc Master can view a NETrc Host’s transmissions. You can also 
prevent viewing or control of the screen while the remote control is 
active unless the user of the workstation allows it, or you can 
require a password to control the remote computer. 

NETrc Profiles Every node audited by the NETinventory Audit Agent has a NETrc 
Profile assigned. A Profile is a collection of NETrc preferences for 
installation, network protocol, and security. In addition, the profile 
settings control how the user is or is not made aware that NETrc is 
being used to view the screen. Newly audited nodes have a default 
profile assigned, and you can assign a specific profile to a node 
using the NETinventory Node Manager. 

You can create and name up to nineteen individual profiles with 
unique settings. IN addition, there is a default profile, called None, 
that removes NETrc if it is installed.

Connections The Master connects to the Host, and the Master controls the Host. 
This is a peer-to-peer connection.

Any Master and Host can connect to each other, as long as they 
each use the same protocol (IP or IPX) over the connection. The 
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Installing NETrc
operating system platforms for Master and Host do not need to be 
the same. 

Fig. 361 A peer-to-peer connection

NETrc Host 4.10 and later, however, can only receive connections 
from a NETrc Master of version 4.01 or later. A NETrc Master of 
version 4.10, on the other hand, can connect to and control all 
NETrc Hosts of version 2.0 and later. 

Installing NETrc The NETrc Console components and viewer are installed by the 
NETinventory Console installation program. For information on 
installing the NETinventory Console, please consult the Getting 
Started Guide, which has complete information on installing the 
NETinventory Console. To use NETrc, you must also install and 
configure the NETinventory Snap-in Module.

Setting Up NETrc Setting up NETrc is simple: all you need do is install NETrc licenses, 
then configure one or more profiles and choose which profile should 
be the default profile installed when the NETinventory Audit Agent 
audits a machine for the first time. Before the NETinventory Audit 
Agent can install the NETrc Host, you will need to install and 
configure NETinventory Master, Audit, and Login Servers. You will 
also need to have NETinventory begin auditing the machines on 
your enterprise network. For complete information on configuring 
NETinventory, please see the NETinventory User Guide. 

NETrc System 
Requirements

This topic describes the system requirements on the machines 
running NETrc. 

NETrc Host 
Requirements

NETrc Host 4.10 may be installed on the same computer as NETrc 
Master. It will run on any computer that meets the minimum 
system requirements of the operating system. The following 
operating systems are supported: 

iMac iMac

iMac iMac

Master

Host
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Network Requirements
• Windows® 98
• Windows® 98 Second Edition (SE)
• Windows® 98 Millennium Edition (Me)
• Windows NT® (with Service Pack 4.0 or later)
• Windows® 2000
• Windows XP®

• Windows Server™ 2003

Network 
Requirements

NETrc may be used over any type of network that supports the IP or 
IPX standard protocols, including dial-up, Ethernet, token ring, and 
FDDI. The following conditions apply:

• IP is a general purpose protocol supported on a wide variety of 
networks and servers. 

• IPX is usually run on networks using Novell® NetWare®. To 
enable communication using IPX, it is not necessary for any PC to 
be logged into a NetWare server, nor is it necessary to run a 
NetWare client, although the NetWare Client for the platform 
should be installed. 

Display Requirements NETrc Master can correctly display the screens of Host PCs running 
the following Windows display drivers: 

• 16-color
• 256-color
• 15/16-bit color
• 24/32-bit color

Color NETrc Master’s ability to render colors accurately depends on the 
capabilities of the Windows display driver. The most accurate color 
reproduction occurs when the Master’s color capability matches or 
exceeds that of the Host PC. For example, a Master running in a 
Windows session with a 16-color display driver is able to render a 
Host PC running Windows with a 16-color display driver perfectly. 
However, if the Host PC’s display driver is 256-color, the Master 
must approximate some of the colors.

Resolution The NETrc Master can display host PC screens of any size by using 
scroll bars. It is most convenient to use a high-resolution display for 
the PC running the Master (1024 x 768 or higher) so that most Host 
PC displays can be displayed in their entirety without scroll bars.

The NETrc Master can render virtually any graphic resolution. If the 
Host PC enters a display mode that the Master cannot render, the 
Master window will be blank until the Host PC enters a display mode 
that the Master can display.
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NETrc Setup
NETrc Setup To use NETrc to control a node, the node must have the NETrc Host 
installed and must have a NETrc Profile assigned. Use the NETrc 
Setup dialog to enable NETrc, to configure a default profile that will 
be assigned to new nodes, and to manage NETrc licenses. 

Before you can configure NETrc, you must install and configure a 
NETinventory Enterprise Installation, including a Master Server and 
at least one Audit Sever and one Login Server. 

Setting the Default 
NETrc Profile

In order to use NETrc to remotely control audited nodes on your 
network, you must assign a profile which installs the NETrc Host on 
the node. For information on configuring profiles, see “Configuring 
NETrc Host Profiles” on page 364. 

The default NETrc profile is set for all nodes which have no other 
NETrc profile assigned, including new nodes. 

To choose the default NETrc Profile

Open the NETrc Setup dialog and select the General Setup panel. 
The NETrc Setup dialog appears. 

Fig. 362 NETrc Setup Dialog - General Setup Panel

1 Select Enable Remote Control for NETinventory Nodes? 
and choose the default NETrc profile for new nodes from the list 
of available profiles. 

If you choose the profile named None (Uninstall), the NETrc 
Host software will not be installed on the host PC, and remote 
control of the node will not be possible.
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Configuring the NETrc Master Settings
The profile you select determines the Host settings used for the 
node. For information on configuring profiles, please see 
“Configuring NETrc Host Profiles” on page 364. 

2 Click OK to close the dialog and save the changes you have 
made, or click Apply to save the changes without closing the 
dialog. 

To configure the profile update interval

You can also configure how often the NETinventory Audit Agent will 
update the NETrc profile settings on nodes. 

1 Open the NETrc Setup dialog and select the General Setup 
panel. 

2 Select the number and type of units the Audit Agent should 
wait between updates of the profile. 

Updating the profile ensures that the profile is installed and that 
the settings in the Host’s preference file match those set in the 
NETrc Setup dialog. 

3 Click OK to close the dialog and save the changes, or click 
Apply to save the changes without closing the dialog. 

Configuring the 
NETrc Master 
Settings 

You can control the settings the NETrc Master software uses when it 
runs by making changes to the Viewer Setup panel. You can also 
make changes to these settings from within the NETrc Master. 
Changes made from within the NETrc Master will be lost when you 
quit. 
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Configuring the NETrc Master Settings
To configure NETrc Master Settings

1 Open the NETrc Setup dialog and choose the Viewer Setup 
panel. The Viewer Setup Panel appears. 

Fig. 363 NETrc Setup Dialog - Viewer Setup Panel

2 The items on the panel allow you to set the NETrc Master 
preferences. Table 22, “Master Settings,”  describes each item.

3 Click OK to close the dialog and save the changes you have 
made, or click Apply to save the changes without closing the 
dialog. 

Table 22  Master Settings 

Item Name Effect

Viewer Settings

View Only When selected, the viewer can only view the 
remote machine’s screen, and cannot control 
the remote machine. In addition, some of the 
selections which determine how the Master 
controls a remote machine are unavailable. 

Resize Viewer Window 
to Host

When selected, the viewer’s windows 
automatically resize to display the host’s entire 
screen if possible. 

Local Keys

Certain key combinations are useful to control 
the local workstation. When each of the 
following is selected, the keystroke will never 
be transmitted to the NETrc Host.

ALT+TAB When selected, the ALT+TAB key combination 
will not be transmitted to the NETrc Host. 
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Configuring the NETrc Master Settings
ALT+SPACE When selected, the ALT+SPACE key combination 
will not be transmitted to the NETrc Host. 

ALT+ESC When selected, the ALT+ESC key combination 
will not be transmitted to the NETrc Host. 

CTRL+ESC When selected, the CONTROL+ESC key 
combination will not be transmitted to the 
NETrc Host. 

Auto-Scroll

If the screen of the machine being controlled is 
larger than the window the viewer is using to 
display it, you can choose to automatically 
scroll the window when your cursor or mouse 
pointer reaches the edge of the window.

Cursor When checked, the NETrc Master window 
automatically scrolls when the cursor nears the 
edge of the window.

Mouse When checked, the NETrc Master window will 
automatically scroll when the mouse pointer 
nears the edge of the window.

Host Settings
These settings control how the NETrc Host 
behaves on the machine under control. 

Suppress keyboard and 
mouse

When checked, the keyboard and mouse of the 
Host will not work while the NETrc Master is 
being used to control the computer if 
suppression of the keyboard and mouse is 
allowed by the profile. Please see “Configuring 
NETrc Host Profiles” on page 364 for more 
information on profile settings.

Blank host screen When checked, the screen on the node you are 
connecting to will be “blanked” while you are 
viewing or controlling it if blanking is allowed 
by the profile. Please see “Configuring NETrc 
Host Profiles” on page 364 for more 
information. 

Note: Some older video drivers cannot 
blank the screen. If the host’s screen 
doesn’t blank, upgrade to the latest 
version of the host’s video drivers.

Mouse Transmission
These settings control how mouse clicks and 
motion are passed from the NETrc Master to 
the Host. 

Left button clicks When selected, “left” mouse button clicks will 
be passed to the Host.

Table 22  Master Settings  (Continued)

Item Name Effect
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Clicking the Advanced... button in the Master Setup panel 
displays the Advanced Master Settings dialog, as shown in Fig. 
364. 

Fig. 364 Advanced Master Settings Dialog 

Right button clicks When selected, “right” mouse button clicks 
(clicks that would normally display the context 
menu) will be passed to the Host.

No motion When selected, mouse motion will not be 
passed to the controlled node.

Absolute motion When selected, the NETrc Master will transmit 
mouse motion as absolute mouse position.

Relative motion When selected, the NETrc Master will transmit 
mouse motion as the difference between 
successive mouse positions.

Preferred Master 
Protocol Order

These settings control the way the NETrc 
Master communicates with the NETrc Host on 
the selected node. 

IPX then IP The NETrc Master will try to connect using 
NetWare IPX packets, and will try IP packets if 
the first method fails. 

IP then IPX The NETrc Master will try to connect using IP 
packets, and will try NetWare IPX packets if 
the first method fails. 

IPX Only The NETrc Master will try to connect using 
NetWare IPX packets, and will fail if it is unable 
to complete a connection. 

IP Only The NETrc Master will try to connect using IP 
packets, and will fail if it is unable to complete 
a connection. 

Advanced
This button displays the Advanced Master 
Settings dialog, which allows you to configure 
additional parameters for the Master. 

Table 22  Master Settings  (Continued)

Item Name Effect
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Configuring Advanced 
Master Settings

The Advanced Master Settings dialog allows you to control how 
the NETrc Master handles full-screen DOS Sessions on hosts. 

The Font field controls the typeface and type size that NETrc uses 
to display the host PC’s screen when it is in text mode.

By varying the font, you can increase or decrease the size of the 
host PC’s screen as displayed in the NETrc window. With a smaller 
font, you’ll be able to see more of the host PC in a smaller window. 
With a larger font, you’ll improve readability at the expense of 
requiring a larger window.

To select a DOS Text Session font

1 Click the Font field for a pull-down list of fonts.

2 Click one of the fonts in the list to select it. 

The fonts in the list are shown previewed as they will actually 
appear. The names of the fonts are composed of a typeface name 
and a size. Thus, the font Terminal 8 x 12 is typeface Terminal, 
whose character dimensions are 8 horizontal pixels by 12 vertical 
pixels.

The DOS text refresh rate settings allow you to control how 
frequently the host PC sends screen updates to the NETrc Master. 
There are two refresh rates to set.

The Foreground rate applies whenever the NETrc Master window is 
active.

The Background rate applies whenever the NETrc Master window 
is not active.

The foreground refresh rate is the more important of the two, since 
it determines the speed of response of the window that you are 
actually operating. If you set a slower background rate, the window 
will update more slowly whenever it is not the foreground window, 
but will resume speed as soon as you bring it to the foreground.

When you set the refresh rate, you can select from a list of refresh 
rates ranging from Fast (the maximum) to 10 seconds.

The faster the refresh rate, the faster changes on the Host PC will 
be reflected in the NETrc window, and the “snappier” your session 
will feel. But with a faster refresh rate, the host PC will be spending 
more CPU time scanning its screen and transmitting changes, and 
NETrc will be spending more CPU time displaying those changes.

In general, if both the NETrc Master PC and the host PCs are fast 
(386 or higher), you can usually leave both refresh rates set to Fast 
without much worry.

You should consider slower refresh rates if:

• You are running a computationally intensive DOS graphics 
program on the host PC and you notice that it slows down when 
connected.

• You are running multiple NETrc windows, all of which are 
simultaneously updating the display.
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• Your network is heavily loaded with communications traffic.

Configuring NETrc 
Host Profiles

The settings in the previous section control how the NETrc Master 
and Host interrelate from the Master’s end. A separate group of 
settings control how they interrelate from the Host’s end. Unlike the 
Master settings, each Host can have assigned a different group of 
settings which are collectively known as a profile. 

Once NETrc is installed, every node audited by NETinventory has a 
Profile assigned to it. If the NETrc Host software is not to be 
installed on the node, use the None (Uninstall) profile. NETrc 
comes with a number of predefined profiles, and you may configure 
up to 19 profiles.

To configure NETrc host profiles

1 Open the NETrc Setup dialog and choose the Remote Host 
Setup panel. The Remote Host Setup Panel appears. 

Fig. 365 NETrc Setup Dialog - Remote Host Setup Panel

2 In order to make changes to a profile, click its name to select it. 
The profile will be highlighted, and the profile’s settings will 
appear on the right of the panel. 

The items on the panel allow you to set the NETrc Master 
preferences. Table 23, “Host Settings,”  describes each item. 
364 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Configuring NETrc Host Profiles
3 Click OK to close the dialog and save your changes, or click 
Apply to save your changes without closing the dialog. 

Table 23  Host Settings 

Item Name Effect

Profile Name
The name of the profile whose settings you are 
editing. To edit the name of the profile itself, 
click in the field.

Install Settings
These settings control where and how the 
NETrc Host software is installed on nodes. 

Install Path The path to the directory on nodes where the 
NETrc Host software is installed. If the 
directory specified does not exist, the Audit 
Agent will create it when installing. 

Reboot after install? In order for the NETrc Host software to load 
properly, newly installed nodes must usually 
be rebooted. This controls how that reboot 
happens. If you choose Prompt User, the 
user will be prompted to complete the 
installation by rebooting. If you choose 
Always, the node will be rebooted 
automatically without notifying the user. Since 
this reboot takes place at the end of the 
NETinventory Audit, there is no need to worry 
about saving files. If you choose Never, the 
host software will silently wait until the next 
time the user boots the machine and will 
complete the install at that time. 

Add NETrc icons to 
Start Menu/Program 
Manager?

When checked, a NETrc group will be added to 
the Start menu.

Allow users to 
uninstall NETrc 
manually?

When checked, the user can use the Windows 
Add/Remove Programs... control panel to 
remove the NETrc Host software manually. If 
you chose to add the NETrc icons to the Start 
Menu, the user can also use the “Remove 
NETrc” icon in the group to remove the host 
software. 

Connection Settings
These settings control how the NETrc Host 
software behaves while the NETrc Master is 
connected to it. 

Beep when viewer 
connects?

When checked, the NETrc Host software will 
beep when a NETrc Master connects to the 
node. 

Beep every... seconds. When checked, the NETrc Host software will 
beep at an interval you specify while a NETrc 
Master is connected to the node. These two 
settings are useful for letting users know that 
their machines are under remote control, 
especially in conjunction with the Blank on 
Connect option in the Master Setup panel. 
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Configuring Host 
Protocol Settings

Clicking the Host Protocol Settings button displays the Host 
Protocol Settings dialog. 

Fig. 366 Host Protocol Settings Dialog

This dialog allows you to configure which networking protocols the 
host software will use to communicate with the NETrc Master 
software. 

Check Use IP? to allow the Host to use TCP/IP-based 
communications with the Master. Click Use IPX? to allow the Host 
to use NetWare IPX-based communications with the Master. Click 
Done to save your changes and close the dialog. 

Configuring Host 
Access Settings

The Host Access settings allow you to configure how and when the 
host will allow the viewer software to connect. If you have more 
than one node with the NETinventory Console and NETinventory 
and NETrc Snap-in Modules installed, then unauthorized users could 
potentially access confidential information. These settings allow you 
to control who can access nodes with the NETrc Host installed and 

Reboot on disconnect? When checked, nodes you connect to with the 
NETrc Master will automatically be rebooted 
when the Master disconnects. 

When not connected, 
host is...

This setting controls the appearance of the 
NETrc Host software while the NETrc Master is 
not connected. If you choose Hidden, the host 
software will not appear. If you choose Icon, 
the host software will appear as a minimized 
program. 

When connected, host 
is...

This setting controls the appearance of the 
host software while the Master is connected to 
a node. Again, you can choose to have the 
host software Hidden or as an Icon. 

Protocol Settings...
When clicked, displays the Host Protocol 
Settings dialog. 

Access Settings...
When clicked, displays the Host Access 
Settings dialog. 

Security Settings...
When clicked, displays the Host Security 
Settings dialog. 

Table 23  Host Settings  (Continued)

Item Name Effect
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when the access can take place. To view or change the Host Access 
Settings, click Access Settings.... The Host Access Settings 
dialog appears. 

Fig. 367 Host Access Settings Dialog 

To control access based on time

The Access Settings controls allow you to restrict access based on 
time. 

1 Select the Never restrict access to host computer option if 
the NETrc Master should be able to attempt a connection 
twenty-four hours a day, seven days a week. 

Select Always restrict access (no connections allowed) if 
the Host software should be installed but should always refuse 
connections. 

If you want to permit connections at some times, but prohibit 
them at others, choose Lock out/Permit connections for 
times: and then click the Time Settings... button to configure 
which times are allowed. 
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2 When you click the Time Settings... button, the Lock out/ 
Permit connections dialog appears. 

Fig. 368 Lock out/Permit connections Dialog

3 Check the boxes next to the days you wish to allow connections 
to nodes with this profile assigned and then select the time 
range when connections should be allowed on that day. 

Note: 12:00 AM is midnight, and 12:00 PM is noon. 

Clicking Permit Connections for all turns access on for all 
days and all times; clicking Clear Connections for all turns all 
days and times off. 

4 Click OK to close the dialog and save the changes you have 
made or click Cancel to close the dialog without saving the 
changes. 

To allow the node’s user to control access

The Access Permission group of controls allows you to specify 
what permission from the user of the node is required. 

1 Choose No permission required for remote access and the 
user of a node will not be consulted before the Master connects. 

2 Choose Permission only requested from host user for 
access and the user of the node will be asked for permission to 
connect. If the user refuses, the connection will not be made. If 
the user does not respond within the period you specify in the 
Access automatically granted after field, the connection will 
be made anyway. 

3 Choose Permission must be granted by host user for 
access and the user must grant access within the period you 
specify in the Host user must grant access within field or 
the connection will not be allowed. 

4 Click OK to close the dialog and save the changes you have 
made or click Cancel to close the dialog without saving the 
changes. 
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To require a password to connect

You can choose to require users of the NETrc Master to enter a 
password before they can connect to the Host. 

1 Open the Host Access Settings dialog. 

2 Enter a password in the Access Password field. The user of 
the NETrc viewer will need to enter the password before being 
able to connect with the Host.

Note that this password will be required in addition to any 
permission that the user of the node itself must grant. You may 
wish to use these two settings in combination for nodes which 
have sensitive information on them to ensure that only 
authorized users can view the node’s contents. 

3 Click Done to close the dialog and save the changes you have 
made, or click Cancel to close the dialog without saving 
changes. 

Configuring Host 
Security Settings

If you are using NETrc to provide support to users of your 
enterprise network, you may at times make changes to users’ 
machines that they should not see (your passwords, for example). 
The Host Security Settings dialog allows you to control what 
interaction users can have with the node while the NETrc Master is 
connected to it. 

With the Remote Host Setup panel displayed, click the Security 
Settings button. The Host Security Settings dialog appears. 

Fig. 369 Host Security Settings Dialog

To suppress the keyboard and mouse

The controls in the Suppress Host Keyboard/Mouse group allow 
you to affect what control the user has over the node while the 
NETrc Master is connected. Suppressing the keyboard and mouse 
on the host prevents the user from conflicting with the user of the 
NETrc Master over control of the keyboard and mouse. On the other 
hand, when you allow the user to control the keyboard and mouse, 
you can watch as they reproduce a problem, then step in when 
needed to correct it. This approach is especially powerful if you can 
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speak with a user by phone while observing their computer use with 
NETrc. 

1 Choose Always suppress keyboard/mouse to prevent all 
keyboard and mouse input from being accepted on the Host 
while the Master is controlling the node. 

2 Choose Allow keyboard/mouse to be suppressed to allow 
suppression of the keyboard and mouse to be controlled by the 
settings in the Master Setup panel or by the settings in the 
NETrc viewer itself. 

3 Choose Never allow suppression of keyboard/mouse, and 
the user will always be able to control the node, even when the 
NETrc viewer is also in control. 

4 To close the dialog and save the changes you have made, click 
Done. To close the dialog without saving the changes, click 
Cancel. 

To blank the host display

There are times when you may not want users of Hosts to see what 
is being done to their machines. When this is the case, you can 
choose to have the node’s screen blank while the node is under 
control.

1 Choose Always blank host display and the host’s screen will 
always be blanked when the NETrc Master connects to it. 

2 Choose Allow host display to be blanked and display 
blanking will be controlled by the settings in the Master Setup 
panel or by the settings in the NETrc viewer itself. 

3 Choose Never allow blanking of host display and the 
display will never blank. 

4 To close the dialog and save the changes you have made, click 
Done. To close the dialog without saving the changes, click 
Cancel. 

Note: Some video drivers do not support screen blanking. If you 
encounter difficulty with screen blanking on a particular node, try 
updating the video driver to the latest version for your card. That 
may correct the problem. If it does not, the card’s driver may not 
allow blanking. 

Configuring NETrc 
Licenses

NETrc licensing is unlike the licensing of the other NETinventory 
Console Snap-in Modules. For NETrc, licenses are for individual, 
installed copies of the NETrc Host software. You must have a license 
installed for every node with the Host software installed. In 
addition, licenses must be manually assigned from a central pool of 
available licenses to individual NETinventory Audit Servers before 
they can be used for nodes. If one Audit Server has a surplus of 
licenses, and another is out of licenses, you can manually move 
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them from one to another, but they will not be moved 
automatically. 

When the default profile is set to an active profile that is something 
other than None (Uninstall), no licenses are actually used until an 
audit successfully installs the NETrc Host software on the actual 
node. When you run a grid before the installation is complete, the 
desired profile will appear in the Node Manager and the status will 
be “Installation Pending.” In this case no license has yet been used. 
After the installation has completed, a license will be in use. 

The other case is when you assign a specific profile to a node. If you 
assign a specific profile to a node which does not have the NETrc 
Host software running, a license will immediately be allotted to the 
node, even though the Host software has not necessarily been 
installed yet. 

In short, assigning a specific profile to a node allows you to allocate 
a license to a specific node; relying on the default profile to assign 
profiles to a node causes licenses to be doled out to nodes on a first 
come, first served basis. 

Uninstall works much the same way. If you uninstall by setting the 
default profile to None (Uninstall), the NETinventory Audit Agent 
will uninstall the host software from nodes using the default profile 
and return their license to the pool of available licenses on that 
Audit Server once the uninstall is complete. Nodes which have a 
specific profile assigned will not be uninstalled, and their licenses 
will not be returned to the pool. 

To uninstall from nodes where you have assigned a specific profile 
and to return their license to the pool, assign the profile None 
(Uninstall) to the nodes or reassign them to use the default 
profile.
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To assign licenses, choose the NETrc License Page icon in the 
NETrc setup dialog. The NETrc Enterprise License Allocation 
panel appears. 

Fig. 370 NETrc Setup Dialog - Enterprise License Allocation 
Panel

This page allows you to see how the NETrc licenses you have 
installed on your enterprise are used and to reassign licenses as 
needed. 

The Total Installed field lists the total number of NETrc licenses 
installed on your enterprise network. The Available Pool field lists 
the number of licenses of the total installed which have not yet been 
assigned to NETinventory Audit Servers. You cannot edit these 
numbers directly. To add more NETrc licenses to the total installed, 
use the NETinventory Console license manager. For more 
information on using the license manager, please see the 
NETinventory Console User Guide. 

Below these two fields, all the Audit Servers on your enterprise 
network are listed by name. Alongside each server’s name are two 
fields, Avail Licenses and Assigned. The Assigned field lists how 
many licenses have been assigned to the Audit Server from the 
Total Installed on your network. The Avail Licenses field 
provides the number of licenses assigned to the Audit Server minus 
the number of copies of the NETrc Host software which have been 
installed on nodes audited by that Audit Server. 

To change the number of licenses on the Audit Server, click in the 
field and type the new number of licenses that should be assigned 
to the Audit Server. In order to lower the number, there must be 
available licenses on the Audit Server. Every license you delete 
from the Assigned field will be removed from the Avail Licenses 
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field for that server and returned to the Available Pool field for the 
entire enterprise network.

In order to raise the number of licenses assigned to a particular 
Audit Server, there must be licenses in the Available Pool. The 
sum of the number of licenses in the Available Pool and those 
Assigned to all the Audit Servers adds up to the Total Installed. 

When a profile which allows remote control is no longer assigned to 
a node, that node’s license is returned to the pool of available 
licenses on the node’s Audit Server. 

Removing the 
NETrc Host

There are three ways to remove the host software from a node. The 
first two are automatic and rely on the NETinventory Audit Agent to 
work. The second is manual and depends on the user of the node. 

Removing Host 
Components 
Automatically

The simplest ways to remove the NETrc Host software let the 
NETinventory Audit Agent do so. If you assign the None 
(Uninstall) profile to a node using the NETinventory Node 
Manager, the Audit Agent will automatically remove the Host 
software the next time the node is audited. In addition, if you 
uncheck Enable Remote Control for NETinventory Nodes? in 
the General Setup Panel of the NETrc Setup dialog, NETrc will be 
removed from all nodes the next time they are audited. 

To use the Node Manager, double-click the name of the node in any 
NETinventory Grid report. The NETinventory Node Manager 
window will appear, as shown in Fig. 371

Fig. 371 NETinventory Node Manager - Overview Panel
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Scroll through the list of available panels on the left side of the 
window and click the NETrc icon. The NETrc Information panel 
will appear, as shown in Fig. 372. 

Fig. 372 NETinventory Node Manager - NETrc Information 
Panel

To assign a specific profile to a node

The NETrc panel shows the current NETrc status of the selected 
node, including the profile the node is currently using, the last date 
the profile was checked by the NETinventory Audit Agent, and the 
current status of the profile on the node. 

1 To assign a specific profile to the node, click Use Node 
Specific Profile. 

2 Choose the None (Uninstall) profile from the list of available 
profiles. The NETrc Host software will automatically be removed 
by the NETinventory Audit Agent the next time the node is 
audited after the update interval expires.

3 Click OK to close the window and save the changes you have 
made, or click Cancel to close the window without saving the 
changes. 

Removing Host 
Components Manually

When setting up a profile, you can allow users to manually uninstall 
their host software, so that they can use the NETrc uninstaller 
themselves.

The simplest way to uninstall manually is to use the Add/Remove 
Programs control panel. 

To use the Add/Remove Programs control panel

1 Open the Control Panel from the Start menu or by double-
clicking the My Computer icon and then the Control Panel 
icon. 
374 NETinventory User Guide

© 2004 BindView Corporation. All Rights Reserved



Removing Host Components Manually
2 Double-click the Add/Remove Programs icon, as shown in 
Fig. 373. 

Fig. 373 Add/Remove Programs Dialog

3 Select the NETrc Remote Control - Host item, and then click 
Add/Remove.... You will be prompted to confirm that you 
really want to delete the Host software. If you click Yes, the 
software will be automatically removed. You may be prompted 
to restart your machine after the removal is complete. If so, 
you should go ahead and restart. 
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Taking Control with NETrc
Taking Control 
with NETrc

To take control of a node with the NETrc Host software installed, 
you use the NETinventory Node Manager. This means that to take 
control of a specific node, you must first run a NETinventory Grid 
report which contains the node. For more information on creating 
Grid Queries, please see Section 3, “NETinventory Console,” on 
page 279. For more information on NETinventory, please see 
Section 1, “NETinventory,” on page 19. 

If you are using the NETinventory Console and are logged in using 
the preconfigured “BV Admin” account, you can use the “Node List” 
report that is at the top level of the Getting Started folder or the 
“Node List - NETrc Installation Status” report in the NETrc folder to 
get a convenient list of all available nodes. 

To take control with ActiveAdmin

You can take control of any node with NETrc installed using the 
ActiveAdmin® feature. To use ActiveAdmin to take control of a 
node, run any NETinventory grid, like the one shown in Fig. 374. 

Fig. 374 NETinventory Grid

1 Click the node’s row number in the grid (at the extreme left of 
the grid) to select the node, as shown in Fig. 375. 

Fig. 375 Grid with Row Selected
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2 Move the cursor over any field in the selected row and right-
click to display the context-sensitive menu, as shown in Fig. 
376. 

Fig. 376 NETinventory Context-Sensitive Menu

3 Select Take Control of this Node to take control of the 
selected node. The NETrc Master will run.

4 If the user of the node must be prompted for permission, or if 
the person taking control must enter a password to control the 
node, a password prompt appears. 

5 The screen of the node under control will appear. 

6 When you are finished controlling the node, click the NETrc 
Master’s close box or double-click the System menu to close 
the NETrc Master and disconnect from the node. 
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To take control with the Node Manager

To use the Node Manager, double-click the name of the node in any 
NETinventory Grid report. The NETinventory Node Manager window 
will appear, as shown in Fig. 377. 

Fig. 377 NETinventory Node Manager - Overview Panel

Scroll through the list of available panels on the left side of the 
window and click the NETrc icon. The NETrc Information panel 
appears (Fig. 378). 

Fig. 378 NETinventory Node Manager - NETrc Information 
Panel

1 Click the Take Control button. The NETrc Master will run.
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2 If the user of the node must be prompted for permission, or if 
the person taking control must enter a password to control the 
node, a password prompt appears. 

3 The screen of the node under control will appear. 

4 When you are finished controlling the node, click the NETrc 
Master’s close box or double-click the System menu to close 
the NETrc Master and disconnect from the node. 

Assigning a Profile 
to a Node

In addition to letting you take control of a node, this panel shows 
the current NETrc status of the selected node, including the profile 
the node is currently using, the last date the profile was checked by 
the NETinventory Audit Agent, and the current status of the profile 
on the node. 

1 To assign a specific profile to the node, select Use Node 
Specific Profile. 

2 Choose a profile to assign from the list of available profiles. 

3 Click OK to close the window and save your changes, or click 
Cancel to close the window without saving the changes. 

The NETinventory Audit Agent will update the profile on the node 
the next time the node is audited. 

Removing the NETrc 
Host Software from a 
Node

You can use profiles to remove the NETrc Host software from a node 
you select. When you select the profile named None (Uninstall), 
the NETinventory Audit Agent will remove the NETrc Host software 
and preferences from nodes on the enterprise network. 

1 In the NETrc panel of the NETinventory Node Manager, click 
Use Node Specific Profile. 

2 Choose the profile named None (Uninstall). 

3 Click OK to close the window and save the changes you have 
made, or click Cancel to close the window without saving the 
changes. 

The NETinventory Audit Agent will uninstall the NETrc Host software 
from the node the next time the node is audited. 

Using NETrc 
Master

A NETrc Master Connection Window is your view into the activity of 
the NETrc Host. Once you have established a connection with a 
Host, you can remotely control the host, transfer files or print 
remotely.

You can perform the activity of your choice by selecting the 
associated tab at the bottom of the Connection Window or by 
selecting one of the first three icons on the Toolbar.
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Menu and Toolbar 
Commands

Although some of the commands that appear on the menu and 
Toolbar change according to which page of the Connection Window 
is active, many of them remain constant. Some of these correspond 
directly to equivalent commands on the NETrc Control Panel. 

The following are menu commands which are always available on all 
pages of the Connection Window.

The Connection Menu If you select the Exit command, you will be disconnected from the 

Host and the Connection Window will close. The  icon on the 
Toolbar performs the same function if you are viewing the Remote 
Control tab. Otherwise, it just disconnects the File Transfer or 
Remote Printing connection and closes the tab, returning you to the 
Remote Control tab.

When you choose the Properties command, the Connection 
Properties dialog appears with information about the remote 
connection. 

Fig. 379 Connection Properties Dialog

The Disconnect command immediately disconnects you from the 
remote host. You must choose which of the three possible sorts of 
connections you want discontinued: Remote Control, File Transfer, 
or Remote Printing. Only the options corresponding to the kinds of 
connections you have established already will appear on this menu. 
If you choose Remote Control, the Connection Window will close. 

If you select Add to Favorites, the current remote Host will be 
added to the list of Favorite Hosts.

You may occasionally need to reboot a Host computer that is under 
your control. The Reboot Host command allows you to reboot Host 
computers. After it has done so, you can reconnect to it again. 
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To reboot remote hosts running later versions of Windows, you can 
select the Start > Shut Down command on the remote Host. 

The Edit Menu The Edit menu relates to interaction with the user interface of the 
remote host. 

If you select the Send Keystroke command, you will be able to 
send one of a number of special key combinations to the Host, as 
though it were entered on the keyboard of the remote Host.

There are times when it is useful to make a copy of some selection 
of text or graphics from the Connection Window and place the 
selection in the Master’s clipboard. The following features will allow 
you to copy and paste material from the remote Host into a 
document on the local computer.

Copying from the Host 
Display

The Copy Text command, equivalent to the  icon on the 
Toolbar, allows you to copy text from the Connection Window 
(displaying the view of the remote Host computer) into the system 
clipboard of the Master computer if the Host screen is in Text Mode. 

1 After you select this command, the mouse cursor will change 
shape to an “I-beam” text selection cursor.

2 Move to the beginning position of the selection you wish to copy 
and click and drag with the left mouse button to select the text 
you wish to copy. 

3 Release the mouse button and the Copy Text mode will be 
completed and the text will be copied to your clipboard.

The Copy Graphics command, equivalent to the  icon on the 
Toolbar, allows you to copy a rectangle from the Connection 
Window (which displays the view of the remote Host) into the 
system clipboard of the Master computer.

1 After you select this command, the mouse will become a top-

corner angle icon  to indicate that you will be placing the 
first anchor of the selection.

2 Move to the top-left corner of the rectangle you wish to copy 
and click and drag with the left mouse button to select the text 
you wish to copy. 

3 Release the mouse button and the Copy Graphics mode will be 
completed and the graphics will be copied to your clipboard.

The View Menu The View menu allows you to specify what elements of the Control 
Panel are to be visible or hidden and how to organize the Host icons 
in each display. The menu is organized into three different sets of 
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options: connection window elements, connection window tabs, and 
graphic rendering options. 

Fig. 380 NETrc View Menu 

Connection Window 
Elements

The first four commands on the View menu hide or show the Menu 
Bar, Toolbar, Status Bar, or Tab Bar on the Control Panel.

Connection Window 
Tabs

The middle three selections on the View menu form a list of the 
different tabs that can appear in the NETrc Control Panel.

Each of these items can be selected or unselected from this menu. 
If the item is selected, the corresponding tab will appear in the Tab 
Bar and the corresponding page will appear when the tab is 
selected. If the item is unselected, neither the tab nor the page will 
be available.

Graphic Rendering 
Options

The last three commands on the View menu—Fit to Window, 
Fit 1-to-1, and Full Screen—allow you to change the way that the 
display of the remote host is rendered in the Connection Window.

These three options appear as menu commands and are also 
available using three icons on the Toolbar: 

Fig. 381 NETrc Graphic Rendering Options Toolbar Buttons

• You can fit the display of the Host into a Connection Window or 
allow the entire Master screen to display the Host. The first icon 
toggles between these two display modes. The Full screen 
command (which is only available when the remote Host screen is 
displayed in a window) causes your entire Master computer 
screen to be taken over by the display of the screen of the Host.
If you choose for your entire screen to display the Host screen, a 
floating window with these three icons appears. The buttons in 
the window allow you to make changes to the current display 
option. The buttons allow you to toggle the display back into a 
Connection Window, displaying any other windows.

• The second icon in this set corresponds to the Fit 1-to-1 
command, and specifies that one pixel of the Host will correspond 
to exactly one pixel on the display of the Master computer. That is 
to say, no scaling of the image will be done.
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If this display mode is chosen and the pixel dimensions of the 
Host differ from that of the Master computer, the resulting display 
will make this discrepancy obvious. If the pixel dimensions of the 
Host’s display are larger than the Connection Window in which 
the Host is displayed, or larger than the screen of the Master 
computer if Full screen mode is operative, scroll bars will appear 
to allow you to access the rest of the Host’s screen.

• The third icon in this set corresponds to the Fit to Window 
command, and scales the image of the Host’s display to fit the 
display of the Master computer.
If you are not in Full screen mode but are viewing the screen of 
the Host through a Connection Window, the entire screen of the 
Host is scaled to fit in the Connection Window. 

If you hold down the [CTRL] key while you resize a Connection 
Window—regardless of which of these three display options you 
have chosen—the aspect ratio of the host’s display will be retained. 

The Options Menu The Options menu allows you to control NETrc Master settings. The 
settings you control include how keystrokes on the Master are 
mapped to the Host, Connection Window settings, and whether the 
Master and Host can control the machine or just view its operation. 

Keyboard Mapping 
Dialog

If you select the Keyboard Mapping command, the Keyboard 
Mapping dialog will appear. It allows you to define the key 
combinations entered into the Master computer, to be translated 
into special key combinations on the Host.

There are a number of key combinations that perform special 
functions on a computer. Examples include Control-Alt Delete, Alt-
Tab. The special key combinations have meaning on the Master 
computer, but they also need to be sent to the Host. 

The computer on which NETrc runs can use the Keyboard Mapping 
dialog to define new key combinations for these keystrokes. This 
allows the usual special key combinations for local control with new 
combinations for the remote host. 

Fig. 382 Keyboard Mapping Dialog
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To map a keystroke on the Master to a special keystroke 
on the Host

1 Key combinations have been divided into two sets, called 
Modules, one dealing with the keys used specifically to control 
the connection on the Host end (Connection Control), while 
the other set contains key combinations that are used and 
recognized by application software in general (Global 
Commands). Select the module you wish to change keys for 
from the Module drop-down list. 

2 Select the special keystroke from the Command list.

3 When you press the keystroke shown in the Accelerator field 
on the Master, the special keystroke you selected will be sent to 
the remote Host. 

4 To change the keystroke, click the browse (...) button 
associated with the key it triggers on the remote Host (shown 
in the Commands field), and click the browse (...) button. The 
Special Hot Key dialog will appear. 

Fig. 383 Special Hot Key Dialog

5 Choose the keystroke to use from the drop-down list and select 
the check boxes to add modifier keys. If you choose None, no 
keystroke will send that special key to the remote Host. Click 
OK to close the dialog and save your changes. Clicking the 
Remove button in the Keyboard Mapping dialog also deletes 
the key combination. 

6 To set the key combination to the default value, click the 
Restore Default button in the Keyboard Mapping dialog. 

To restore all key combinations to their default value, click Restore 
All in the Keyboard Mapping dialog. 
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Connection Window 
Settings 

If you choose Connection Window Settings from the Options 

menu, or click the  icon on the Toolbar the Connection 
Window Settings dialog appears. 

Fig. 384 Connection Window Settings Dialog 

Viewer Settings These controls allow you to specify how the remote computer is 
displayed by default when you connect to it.

• If Full Screen is selected, then the screen of the remote 
computer will fill the entire screen of the master computer.

• If View only is selected, then the Master will not take control of 
the remote Host but only view the display.

• If the Fit to window button is selected, then the display of the 
remote computer is scaled to fit into the available space of the 
display of the master.

• If the Fit 1 to 1 button is selected, then one pixel on the remote 
display always corresponds to one pixel on the master computer, 
regardless of any discrepancies of display sizes on the two 
differing display areas.

Host Settings The Host Settings group allows you to specify what should happen 
from the perspective of the user at the remote Host when the 
Master establishes a connection. 

• If Blank Host screen is selected, then the display on the remote 
Host will be blanked out as soon as the Master connects to it. 

Note: Screen blanking is only supported on Hosts running Windows 
98, 98 SE, and 98 ME. It is additionally possible for the user at the 
remote Host to override the request to blank the screen, and it is 
not possible for the user at the Master to know whether the remote 
screen is actually blank or not. 
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• If Suppress keyboard and mouse is selected, then the remote 
Host will be asked to disable the mouse and keyboard. If this 
request is granted, the user at the remote Host will be shut out 
from operating the computer while the Master is connected to it 
and maintains exclusive control. 

Note: It is possible for the user at the remote Host to override the 
request to suppress the keyboard and mouse, and it is not possible 
for the user at the Master to know whether the input devices are 
disabled. 

Auto-scroll The Auto-scroll group specifies whether or not you want the 
window to scroll when the cursor (for text-only screens) or mouse 
(on graphical user interfaces) reaches a boundary.

• If Cursor (text-mode only) is selected, then the text display 
will automatically scroll as soon as the cursor comes to an edge. 

• If Mouse (text & graphics mode) is selected, then the 
graphical user interface will automatically scroll as soon as the 
mouse comes to an edge. 

Text Mode Display The Text-mode Display group deals specifically with displaying 
Hosts with textual rather than graphical screens. 

• The Font drop-down list allows you to select the typeface and 
type size that is used to display the remote Host’s screen.
By varying the font, you can increase or decrease the size of the 
Host computer’s screen as displayed in the Connection Window.

The fonts in the list are shown previewed as they will appear. The 
names of the fonts are composed of a typeface name and a size. 
The text fonts called ‘NETrc’ are fonts that came with this 
software package. Fonts with other typeface names are other 
Windows fonts that are also suitable for text display.

The Text refresh rate settings allow you to specify the rate at 
which changes in the text display are updated on your screen. This 
allows you to find a suitable compromise between “refresh rate” and 
the amount of computation time and network resources spent in 
updating the text display. 

• The Foreground setting applies whenever the Master window is 
active.

• The Background setting applies whenever the Master window is 
not active.

The refresh rate of the foreground is the more important of the two, 
since it determines the speed of response of the window that you 
are actually using. If you set a slower background rate, the window 
will update more slowly whenever you switch out of it, but will 
resume speed as soon as you re-activate it.

When setting a refresh rate, you can select from a list of refresh 
rates ranging from Fast to 10 seconds (the slowest setting). 

You should consider slower refresh rates if:
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• You are running multiple NETrc Master windows, all of which are 
updating their displays at the same time. 

• Your network is loaded heavily with communications traffic.

Text-mode Mouse The Text-mode Mouse group controls how information from the 
mouse on the Master computer is transmitted to a remote Host in 
Text Mode. 

If you select Left button clicks or Right button clicks, clicks of 
that mouse button will be transmitted to the Host. 

There are three different ways in which the motion of the mouse on 
the Master can be interpreted and sent to the remote Host:

• If you select No motion, no mouse motion will be transmitted.
• If you select Absolute motion, an absolute mouse position will 

be transmitted (i.e., the coordinates of a precise location on the 
screen).

• If you select Relative motion, the differential motion of the 
mouse (number of pixels up, down, left, or right from current 
position) will be transmitted.

The Goto Menu There are three commands on the Goto menu which allow you to 
choose between the three different functions—and associated 
displays—of the Connection Window: Remote Control page, File 
Transfer page, and Remote Printing page. 

Remote Control The Remote Control page of the Connection Window allows you to 
view and operate the remote Host just as though you were the local 
user. You can choose to take control of the mouse and keyboard, or 
you can watch without interrupting the local user. 

Fig. 385 NETrc Master - Remote Control Tab 
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Controlling the 
Remote Host

When you select a Connection Window (so that it is the active 
window and has the focus on your desktop) your input devices—
keyboard and mouse—can be used to control the remote Host just 
as if they were connected directly to that computer. 

Operating the Mouse Remote mouse operation can be confusing at first. Keep in mind 
that the mouse at your Master computer now does double-duty: it 
allows you to operate your local Windows session, and it also allows 
you to operate the remote Host computer. The division of duties is 
as follows:

• While the mouse is inside a Connection Window, the mouse is 
entirely “remote” and all movements and clicks are transmitted to 
the Host.

• While the mouse is anywhere else (e.g. in the floating window 
that appears if you are in Full Screen rendering mode), the mouse 
is entirely “local” and any mouse operation affects only your local 
Windows session or the Connection Window itself.

Operating the Keyboard As a rule, while the cursor is positioned in the Connection Window, 
NETrc transmits normal keystrokes to the remote Host. Special key 
combinations, however, are interpreted according to the values that 
you specified in the Keyboard Mapping dialog. See “Keyboard 
Mapping Dialog” on page 385.

The rule as to which keystrokes are kept and which are sent while 
the cursor is within a Connection Window is as follows: 

1 If the keystroke is listed as the Accelerator for a key mapping, 
the equivalent remote keystroke is passed onto the Host.

2 If the keystroke is a special key combination but not listed as 
the Accelerator for any defined key, it remains at the Master 
computer.

3 All other keystrokes are passed onto the Host.

Note: If you want a special key combination to be passed onto the 
Host as is, it will have to appear as its own Accelerator on the 
Keyboard Mapping dialog.

File Transfer The File Transfer page of the Connection Window allows you to 
transfer files between the Master computer and the remote Host, 
and to perform other file maintenance tasks on the Host. 

When you select the File Transfer page a number of extra 
commands appear in the menus and a number of additional icons 
appear in the Toolbar.
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The display is split into four adjustable panes: 

Fig. 386 NETrc Master - File Transfer Tab 

• By default, the local (Master) computer is on the left and the 
remote (Host) computer is on the right.

• The top panels display the folder hierarchies in the computer 
associated with that side.

• The bottom panels show the files in any folder that you have 
opened by double-clicking it in the corresponding top panel.

• A text field at the top of the page, one for the left side and 
another for the right, indicates the full pathname of the currently 
open or selected folder.

You can easily change the layout of this display and what files are 
shown in them:

• Adjust the amount of screen space given to each side of a panel 
pair by clicking and dragging the boundary lines between them.

• The default pane configuration corresponds to the View > View 
Local <--> Remote command. This allows you to see the files 
on the local (Master) computer on the left side of the display and 
the files on the remote (Host) computer on the right side of the 
display. 

• You can specify that both left and right sides show different 
folders of the remote Host by selecting the View Remote <--> 
Remote command from the View menu. This allows you to split 
the display between two file areas of the remote (Host) computer, 
which could be useful for moving or manipulating files on the 
host.
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Displaying File 
Information

Commands are added to the View menu to allow you to configure 
the display of file lists in the window. These commands determine 
the way in which both file lists are configured.

• If a check mark appears next to the View File Attributes 
command, an extra column in the file display appears that 
provides the file attributes. Selecting this command toggles the 
state of this option and the check mark.

• If a check mark appears next to the View Hidden & System 
Files command, all of the hidden and system files in the 
directories are displayed in the file lists. Selecting this command 
toggles the state of this option and the check mark.

• If you select the Sort files by command, you will be able to 
choose whether the files in both of the file lists are sorted by 
name, size, date, or attribute. You can sort the files by selecting 
one of the column titles (Name, Size, Modified, or Attributes).
If you select one of the column titles, all of the files on that side of 
the display will be sorted according to their values for that 
column.

For example, if you select the Name column on the left side, all 
of the files on the left side will be arranged in alphabetical order 
according to their name, regardless of how the right side is 
displayed.

• If you select the Refresh command, the current directory will be 
reread from the remote Host and redisplayed.

Selecting Files and 
Folders

The top panels display the folder hierarchy, but only reveal the 
contents of the nodes of the tree that you explicitly open. No files 
appear in the top panels, nor do any folders appear in any bottom 
panels.

You must select a drive, folder, or one or more files before you can 
perform most File Transfer operations.

When you initially open a computer, drive or folder by double-
clicking its icon (or by selecting it and then choosing the List 
Directory command from the pop-up menu), you will see a list of 
all of the folders (or devices) that it contains. 

Fig. 387 Folder Tree

If you double-click one of these folders, you hide the other folders 
in the hierarchy tree, effectively creating a path through this 
particular folder. Any folders within this folder will appear in the top 
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panel, revealing a further level of nesting of the file directory. Any 
files in the folder will appear in the bottom panel. 

Fig. 388 Folder Tree - Expanded

The folder will then appear with a small box next to it at a joint 
which connects it to the hierarchy tree. The minus sign (-) appears, 
indicating that the folder is open. If you select the joint-box, the 
internal folders will be hidden and the plus sign (+) appears. 

Fig. 389 Folder Tree - Collapsed 

You can display the files within any folder by selecting the folder in 
the top panel and choosing the List Directory command from the 
pop-up menu.

You can also control the current selection with the keyboard. The up 
and down arrows move the current selection within the current 
pane, while the ENTER key opens the current directory if its 
contents are hidden (i.e., if its joint-box is marked with a ‘+’). The 
Tab key moves the current selection to the next panel. The 
Backspace key moves the current selection to the parent folder in 
the hierarchy tree.

If you begin spelling the name of any of the files or folders 
(depending on which pane contains the current selection), that item 
will become the current selection.

Select a file in one of the lower panels by selecting its name. This 
may enable or disable menu commands and Toolbar icons. You may 
select multiple files by using Ctrl+Click to select a series of non-
contiguous files. Or you may select one anchor point and select the 
other end of the contiguous selection with Shift+Click.

Manipulating Files and 
Folders

The icons on the Toolbar allow you to manipulate files in various 
ways, whether copying or moving files from one computer to the 
other, deleting files, renaming files, or creating new directories. 
Each of these has an equivalent command on the popup menu that 
appears when you right-click.

When you select a file from one of the file lists, the following icons 
will be enabled and allow you to perform the following actions:

• If you select one of the blue arrows, the currently selected file will 
be copied into the directory on the opposite side. 
When a file in the left half is selected, for example, the right-

pointing blue arrow  will become enabled, signalling that the 
file can be copied into the directory on the right side. (This can 
correspond to either Get or Put commands on the popup menu, 
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depending on whether it is going to or from the Master 
computer.)

• If you select the delete icon  (corresponding to the Delete 
command on the popup menu), the currently selected file will be 
deleted. 

• If you select the create directory icon  (corresponding to the 
Create Directory command on the popup menu), a new folder in 
the currently selected directory will be created. 

• If you select the move icon  (corresponding to the Move 
command on the popup menu), the currently selected file will be 
moved from its current location to another location on the same 
computer. You will be prompted by a dialog for the new location. 

• If you select the rename icon  (corresponding to the Rename 
command on the popup menu), you will be able to give the 
currently selected file or folder a different name.

Remote Printing The Remote Printing page of the Connection Window is part of the 
underlying program which allows NETrc communication. Remote 
Printing is not supported in NETrc. 
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Overview
Overview If you choose to remove NETinventory Console from a workstation, 
you must use the tools provided. This chapter guides you through 
removing the NETinventory Console.

Uninstalling the 
Servers

This chapter describes the process of removing the NETinventory 
software from the servers on your Enterprise Network.

Removing the 
NETinventory SQL 
Database

There are two ways to delete the NETinventory SQL Database. You 
can use the NETinventory SQL Configuration Wizard to delete the 
database, or you can use the administration tools that accompany 
your SQL database to delete the NETinventory database. The steps 
to delete the database using the built-in tools depend on the SQL 
server you are using. The SQL database created is named 
NI_<MASTER_SERVER_NAME>. 

To use the NETinventory SQL Configuration Wizard to 
delete the SQL database

1 Start the NETinventory Console and open the Master Server 
Settings panel. 

2 Click SQL Settings.The NETinventory SQL Database 
Configuration Wizard Welcome page appears.

Fig. 390NETinventory SQL Database Configuration Wizard
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3 Click Next. The Select Operation panel appears. 

Fig. 391 Select Operation Panel

4 Choose Delete the SQL Database for the Master Server. 
Click Next. The Summary panel appears. 

5 Click Next. The Completing NETinventory SQL Database 
Configuration Wizard panel appears. Click Finish to disable 
SQL database rollup and delete the existing database. 

6 Exit the NETinventory Console. 

Uninstalling Login 
Servers

The NETinventory Server Setup section helps you to automatically 
remove Login Servers. 

To remove Login Servers

1 Choose NETinventory Setup.

2 Click Server Setup. 

3 Select the Login Server Settings panel. 

4 Select all of your Login Servers.

5 Click Remove and follow the prompts. 

For more complete information about removing Login Servers, see 
the NETinventory User Guide. 

Uninstalling Audit 
Servers

The NETinventory Server Setup section helps you to automatically 
remove Audit Servers. 

To remove Audit Servers

1 Choose NETinventory Setup.

2 Click Server Setup. 
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3 Select the Audit Server Settings panel. 

4 Select all of your Audit Servers.

5 Click Remove and follow the prompts. 

For more complete information about removing Audit Servers, 
please see the NETinventory User Guide. On each Audit Server, you 
should also manually delete the NETinventory Service Manager 
Control Panel file. For information on deleting it, please see 
“Removing the NETinventory Service Manager Control Panel” on 
page 398. 

Uninstalling the 
Master Server

Unlike the other two server types, there is no automatic utility to 
remove the Master Server. 

To remove the Master Server

1 Open the NETinventory Service Manager Control Panel.

2 Click the Stop Service button on both the Master Server and 
Database Engine panels. Once the services have been stopped, 
close the Service Manager. 

3 Open a Command Prompt dialog and navigate to the 
bvems\services\ directory in the share where you installed the 
NETinventory files. Normally, this is directly in the c:\winnt 
directory, but you may have chosen another location. If you are 
having trouble locating the file, try finding the BVMASTER.EXE 
file. 

4 Once you have located the proper directory, type 
install remove
at the Command Prompt and press Enter. The install script will 
undo the changes it makes when installing and then exit. 

5 Delete the entire BVEMS directory and all of the files it 
contains. 

You should also manually delete the NETinventory Service Manager 
Control Panel file. For information on deleting the Control Panel, 
please see “Removing the NETinventory Service Manager Control 
Panel.” 

Removing the 
NETinventory Service 
Manager Control 
Panel

Once you have deleted your Master and Audit Server software from 
a machine, you can manually delete the NETinventory Service 
Manager Control Panel. To delete the Control Panel, use the 
Windows Explorer, the Command Prompt, or any other method to 
delete these files:

\winnt\system32\ni.cpl

\winnt\system32\nismhelp.cnt

\winnt\system32\nismhelp.hlp
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Uninstalling 
NETinventory-RMS

The NETinventory snap-in for the BindView RMS Console is removed 
using the Windows Add/Remove Programs control panel. It is 
removed separately from the BindView RMS Console and 
Information Server. See the BindView RMS Console and Information 
Server User Guide for information on removing the BindView RMS 
Console. 

To remove NETinventory-RMS 

1 Open the Add/Remove Programs control panel. 

2 Select BindView NETinventory RMS Snapin.

3 Click Change/Remove. 

4 You will be prompted to confirm that you want to remove the 
snap-in and all of its components. Click Yes. NETinventory-RMS 
will be removed. 

5 A status dialog appears while the Uninstall wizard removes 
NETinventory-RMS. Once the uninstall process is complete, a 
message appears underneath the progress bar. Click OK to exit 
the Uninstall wizard.

Uninstalling the 
NETinventory 
Console

Use the Add/Remove Programs icon in the Windows Control 
Panel to remove the NETinventory Console

1 Open the Add/Remove Programs control panel. 

2 Select NETinventory Console v8.00 and click Change/
Remove. The Confirm File Deletion dialog appears. 

Fig. 392 Confirm File Deletion Dialog

3 A status dialog appears while the Uninstall wizard removes the 
NETinventory Console. Once the uninstall process is complete, 
a message appears at the bottom of the dialog. Click OK to exit 
the Uninstall wizard.
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fields included in, 246
selecting for

query definition, 245
data storage

named scope, 252
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Database Synchronization, 122
dataset

defined, 254
deleting, 257
retrieval time of, 250
saving to

query items, 257
viewing, 257

default
dynamic index settings, 252
post process commands, 268

Default Scope, 29, 52
and Enterprise Configuration, 52
Selecting All Audit Servers, 56
Setting, 56

defaults
Data Format, 343
desktop, 341 – 347
Page Setup, 342

Deleting Nodes, 192
delta dataset, 258 – 259
desktop, 338

modifying, 338
sharing information, 306

Device Driver
Alert Defaults, 88
Setting Alerts, 82

Dispatch Server
Defined, 145

Display Font
default overview, 341
viewing data on screen, 301

Display of Host, 387
DLL files, 166
Download File Options

Download Even If Target File Has Been 
Modified?, 208

Downloading File, 207, 208
Downloading Files, 206, 207, 208

Backup File, 207
Destination File, 206

duplicate key options, 297
dynamic indexing, 252

E
Effective Data Source, 48, 49
emailing export files, 263
Enterprise Configuration, 29, 48

Setting, 48
Environment Variable

Alert Defaults, 88
Exchange export destination, 263 – 264
Exchange server, 263
export file

appending files, 263
emailing, 263
Exchange mailbox destination, 263 – 264
format types, 261
text-based file type, 261

export settings
accessing, 264, 266
appending export files, 263
applying saved settings, 266
default, 265
email, 264
global default, 264, 265
hierarchy for default settings, 264
Information Server default, 264, 265
query binder default, 264 – 265
settings item, 266
sharing, 264
storage location, 264
user default, 264, 265

exporting
export formats, 333
grid data, 332, 333
managing, 333
options, 330
overview, 260
prerequisites, 261
to a disk file, 262

expression list, 249
External Programs, 90

F
Field Specification, 287, 295

category, 295
fields, 246

adding, 246
appearing in

chart, 276
available fields list, 246
list of, 246

File Auditing
Advanced Settings, 78
Alert Defaults, 88
Alerts, 74
Creating a New File Audit, 73, 80
Editing Audited Files, 205
Limiting, 78
Retrieving a String Value, 77
Saving Files, 205
Setting Up, 72
String Searches, 74
Viewing Audited Files, 205

File Download History, 209
File Management

Accessing, 204
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Editing a File, 205
filter

adding to a query, 296
filter and sort criteria

adding to reports, 320
Filter Specification, 287
filter specification, 244
filter term, 247

adding, 248 – 249
grouping, 249
modifying, 249
removing, 249

Fit 1-to-1 command, 384
Fit to Window command, 385
Form Style Report Options, 319
formats for export files, 261
Full screen command, 384

G
global default

export settings, 264, 265
Graph, 289

adding a legend, 326
adding axis labels, 326
Advanced Options, 328
changing title, 326
creating, 294
customizing, 323
defined, 289
dimensions, 325
histogram vs. series, 326
Item Properties, 286
making better graphs, 328
options, 325 – 327
printing, 328
Setup, 284

accessing from a graph item, 289, 323
accessing from an open graph, 290, 

323
adding data labels, 327
changing the X and Y axis fields, 325
combining like values, 326
Data Point tab, 327
histogram vs. series, 325
Layout tab, 326
plotting series graphs, 326
positioning data points, 327
resetting series options, 327
Type Tab, 324

titles, 326
type, 325

Grid, 288
change font, 317
change report margins, 317

creating, 294
data source, 294
definition, 288
display font, 301
exporting data from, 332
launching, 298
modifying, 300
reports, 316

grid, 254
grid toolbar, 256
grouping filter terms, 249

H
Hardware, 160

Detecting Configuration, 63
Product Information Panel, 181
Products Information, 160
User Interaction Prompts, 85

Hardware Assets
Default Records, 65
Deleting an Item, 201
Editing, 198
Viewing, 198

hierarchy for default settings
export, 264

histogram
chart, 276
versus series graphs, 326

historical dataset, 257
baselined dataset, 257, 258
compared dataset, 257, 258
delta dataset, 257

Host, 352
Allowing User to Control Access, 368
Configuring Profiles, 364 – 370
Controlling Access by Time, 367
Defined, 353
Removing, 373 – 375
Requiring a Password, 369
Security Settings, 369

Host Settings
Access Settings, 366
Blanking the Display, 370
Connection, 365
Install, 365
Keyboard and Mouse, 369
Profile Name, 365
Protocol Settings, 366
Security, 369

I
icons

dynamic index folder, 252
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query binder, 245
Information Server

configuring with
export settings, 265

exporting from, 260
global default

export settings, 264, 265
minimum system requirements, 228
named scopes stored on, 252
post process command execution, 269
system requirements, 228

Installing NETinventory, 28, 32
Inventory Database, 159

BIOS Identification, 160
Category Information, 160
Custom Software, 160
Maintenance Type, 160
Manufacturer Information, 160
Master Software, 160
Setting Up, 160
Unknown Software, 160
Vendor Information, 160
Year 2000 Identification, 160

IP Protocol, 355
IPX Protocol, 355

K
Key combinations, 383

L
label

series chart, 277
LAN, 149
Layout tab, 326
legend, 277, 278
legend for a graph, 326
Licenses, 352, 370
licenses, 346
linking

datasets to query binders, 257
Log Size

Master Server, 124
Login Name

Server Account Configuration, 157
Login Scripts

NetWare, 139, 147
Windows NT, 43, 147

Login Server
Changing Settings, 140
Defined, 25
Login Scripts, 147
NetWare Login Scripts, 139
on Windows NT, 43

Removing, 148
Requirements, 25
Setting Up, 139, 141 – 146
Settings, 139
Site Definition, 149
Windows NT, 147

M
Maintenance Type, 160
Maintenance Types Panel, 184
managing licenses, 346
Managing User Configuration Files

Download File History, 209
Downloading a File to a Node, 206
File Contents, 205

Manufacturer Information, 160
Manufacturer Information Panel, 179
Master Server

Data Rollup, 102
Database Synchronization, 103, 122
Defined, 24, 32
Installing, 32 – 43
Maximum Log Size, 124
Moving, 112
Performance Tuning Options, 124
Preferences, 104
Requirements, 24
Rollup, 124
Scatter Login Server Synchronization, 124
Setting Up, 33, 102, 104
Settings, 102
Synchronization, 122
Synchronization Settings, 123
Upgrading, 112

Master Software, 160, 163
Microsoft SQL Server

export file, 261
modifying

desktops with BV Admin, 338
existing schedule, 306
existing user account, 339
export devices, 333
graph dimensions, 325
graph type, 325
graph’s title, 326
licenses, 346
password, 340
the desktop

receiving a reference, 308
scanning for new references, 310
sending a reference, 308

the X and Y axis fields, 325
Moving Nodes, 192
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N
named scope

adding to query definition, 252, 253
defined, 252
linking to query definition, 252
removing, 253

NETinventory
and NETrc, 352
Architecture, 22
Audit Agent Defined, 26
Audit Agents, 43, 147
Audit Example, 28
Audit Server, 25
Console, 282
Console Components, 23
Console Setup, 46
Installing, 28
Login Server, 25
Master Server, 24
Master Server Defined, 32
Multi Server Illustration, 27
New Enterprise Installation, 32 – 43
Nodes per Audit Server, 25
Post-Installation Setup, 32
Scoping, 29
Setting Up, 28

Audit Server, 126 – 134
Master Server, 33
NT Login Server, 141 – 146

Single Server Illustration, 27
Using ActiveAdmin, 378 – 379
Using Node Manager, 380 – 381
Windows NT Login Server Login 

Scripts, 43, 147
See also Login Server
See also Master Server
NETinventory-RMS

Configuring, 231 – 242
NETrc

overview, 284
Using Node Manager, 215

NetWare
Auditing Servers, 95

New Enterprise Installation, 32
New Task List button, 267
Node Manager, 380 – 381

Alerts, 201
Alerts Defined, 66
Assigning a Profile, 215, 374, 381
Customizing Node Audits, 210
Hardware Assets Information, 197 – 201
Managing User Configuration Files, 204
Moving or Deleting Nodes, 192
NETrc, 215

Node Comments, 193
Opening, 190
Setting New Node Names, 62
Setting Node Name Variables, 87
Software Inventory Information, 195 – 197
Using to Remove the NETrc Host, 373

Nodes
Moving or Deleting, 192

P
Page Setup

defaults, 343
page setup, 283, 288

accessing, 316
defaults, 342

Panels
Server Setup, 102

password
changing, 340

Peer-to-peer connection, 353
Performance Tuning, 124
Personal folder, 253, 256
plotting series graphs, 326
positioning data points, 327
post process commands

default, 268
defined, 269
query task defaults, 268

printing a graph, 328
Profile, 353

Assigning to a Node, 215, 374, 381
Setting Default, 358
Setting Update Interval, 359

Prompts, Configuring, 85
Properties command, 382

Q
Query, 283, 286

adding a filter, 296
data source, 294
defined, 286, 287
defining Scope, 298
field specification, 287, 295
saving example, 298
Scope, 29, 288
sort specification, 288, 297
what is a query?, 286

query
accessing the feature, 245
components, 244
grid toolbar, 256
reducing the processing time of, 250
results, 255
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running, 254
Query Binder

accessing, 253
default export settings, 265
linking datasets to, 257
saving, 253

Query Builder
filter specification, 287

query definition
adding

filter, 247
scope, 250

data source included in, 245
resource objects selected in, 245, 250
scope, 250

query items, sharing, 264
Query Options dialog

running queries, 255
saving query binders, 254

query task
halting, 257
reduce processing time, 250
stop processing, 257

R
record

displayed on
histogram chart, 276
series chart, 276

references
receiving, 308
scanning for new references, 310
sending, 308
Why use references, 307

Refresh rate, 388
Remote host, 353
Remotely Controlling a Node, 378 – 381
Removing NETrc, 373 – 375
report, 255

author and date information, 320
calculations to a report, 318
change font, 317
change margins, 317
choose output style, 317
customizing, 316
filter and sort information, 320
fonts, 321, 322
footer, 322
Form Style options, 319
header, 320
page numbers, 322
spreadsheet style options, 318
title, 320

Reporting Account, 156

Rerun Query button, 256
resetting series options, 327
resource object

querying, 245, 250
reducing the number queried, 250

Risk Assessment and Control folder, 253, 256
Rollup

Master Server
Data Rollup, 49

Master Server Settings, 124
Routing Table, 103
Run Files, 90

Creating a New Run File, 91
running tasks

query, 254
scheduling for unattended processing, 270

S
Sample Data

Accessing, 48
saving

datasets, 257
query definition, 253

scanning for new references, 310
schedule

adding an item, 306
components, 291
creating, 301
defined, 290

scheduling
task lists, 270

Scope, 149, 288
and NETinventory, 29
Default Scope, 52
defining query scope, 298

scope
defined, 250
dynamic indexing, 252
item, 250
named, 252
reducing display time of items, 252
removing, 253
specification feature, 244

selecting
data source, 245

sending a reference, 308
series chart, 276
series graph, 326
series options, 327
Server

Accounts, 156
Server Setup, 102

Account Configuration, 156
Audit Server Assignment Rules, 151
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Audit Server Settings, 125
Login Server Settings, 139
Master Server Settings, 102
Site Configuration, 149

Setting Up
Audit Server, 125
Enterprise Configuration, 48
Inventory Database, 159, 160
Login Server, 139
NETinventory, 28
Reporting Data Source, 51
Year 2000 BIOS Limitations, 161

Setting Up NETinventory, 28
Settings, 352

Assigning Licenses, 370
Default Profile, 358
Host Profiles, 364 – 370
Profile Update Interval, 359
Viewer, 359 – 364

setup
graph, 323

sharing information, 307
sharing information between desktops, 306
Site

Configuring, 149
Contact, 150
Creating a New Site Definition, 150
Defined, 149
Modifying Site Configuration 

Information, 149
Removing a Site Definition, 151

Software, 160
Adding a New Software Category, 176
Changing an Entry, 176
Manufacturer Information, 181
Tracking Off-The-Shelf Products On Your 

Network, 163
Vendor Information, 179

Software Detection
Alerts, 70
Configuring Files, 70

Software Inventory Information, 195 – 197
User Defined Fields, 197, 200
Viewing, 195
Viewing Maintenance Information, 196

Software User Interaction Prompts, 85
sort fields

adding, 249
modifying, 250
removing, 250

Sort Specification, 288, 297
Spreadsheet Style Report Options, 318
Standalone Auditing

Creating Disk, 92

Uploading Data, 97
Using Agent, 94, 95

storage of data
named scope, 252

String Search
Advanced Parameters, 77
Alert Defaults, 88
Alerts, 77
Ignoring Comment Lines, 77
Setting Up, 74
Special Characters, 76

Suppressing Host keyboard and mouse, 388
Synchronization

Database (Routing Table), 103

T
task lists

creating, 266, 267, 269
default settings, 268
post process commands, 269
processing, 270
running, 270
scheduling, 270

Task Scheduler, 270
task status

dialog, 257
TCP/IP

Audit Server Assignment Rules, 153
Subnet Masks, 153

Text Mode, 383
text-based export files, 261
Text-Mode, 389
Toggle Sort button, 250
toggling between histogram and series 

graphs, 325
Toolbar

defaults, 341
Tracking

Custom Software Packages, 166
Software Vendor Information, 179
Unknown Software, 171

Tracking Hardware, 181
BIOS Identification, 186
BIOS Identification String, 188
Maintenance for a Hardware Item, 186
Maintenance Types, 184
Modifying Product Hardware 

Information, 183
New Hardware Product Information, 183
New Maintenance Type, 186
New Model, 184

Tracking Software
Ancillary Files, 166
Manufacturer Information, 179
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Unknown Software as Custom 
Software, 173

Using Software Categories, 175
Vendor Information, 177

Type Tab, 324

U
Uninstall

Audit Server, 134
Login Server, 148

Unknown Software, 160
Unknown Software Panel, 171
User

adding an account, 338
deleting an account, 340
modifying an existing user account, 339

User Configuration Files, 204
user default

export settings, 264
User Defined Fields, 83, 87
User Interaction

Configuring, 83
General Settings, 87
Prompts, 85

user properties
dynamic index settings, 252
export, 265

V
Vendor Information, 160
Vendor Information Panel, 177
Version compatibility, 354
view types

report, 255
Viewer, 352, 353
Viewer Settings, 359 – 364

Auto-Scroll, 361
Communications Protocols, 362
DOS Session Font, 363
DOS Session Refresh Rate, 363
Host Settings, 361
IP, 362
IPX, 362
Local Keys, 360
Mouse Transmission, 361

viewing data, 48, 300
Virus Scanning, 90

W
WAN, 149

X
X axis field, 325

Y
Y axis field, 325
Year 2000

BIOS Limitations Database, 161
Software Product Status, 165
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